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Welcome to DB Optimizer

IDERA DB Optimizer simplifies SQL optimization and development for application developers with many features
forimproving productivity and reducing errors. A rich SQL IDE with statement tuning, data source profiling, code
completion, real-time error checking, code formatting and sophisticated object validation tools helps streamline
coding tasks. DB Optimizer’s user interface helps improve overall productivity with integrated development,
monitoring, and tuning components.

DB Optimizer has four components that when used together can optimize your database performance.

« SQL Editor. A developer can write Java in Eclipse that calls to the database with SQL. The SQL that calls to
the database can be written in the SQL Editor with type ahead, code assist and quick fixes to show the users
syntax and correct mistakes. For more information, see Creating and editing SQL files (SQL Editor).

+ Load Tester. The SQL code can be run in the Load Tester to test execution by multiple concurrent users.
User load testing is so often done by one single user and then problems don’t appear until production with
multiple concurrent users. Concurrent user testing is a breeze in DB Optimizer. For more information,
see Using SQL Load Editor/Tester.

« Profiler. You can run the Profiler while the Load Tester is executing to show clearly the impact on the
database. The profiler can also be used by QA on load simulation. Finally, the Profiler can be run on any
production database to clearly show load, bottlenecks, and sources of bottlenecks or resource
consumption. For more information, see Using profiling.

+ Tuner. Finally, if a problem SQL is found on the system the Tuner will show if it’s correctly optimized by the
database or not, and if not it will show the best plan and what hints or optimizer directives can be included
in the SQL to force the database to use the optimal plan. For more information, see Using tuning.
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Installation and Configuration

This section contains information about installing and configuring DB Optimizer. It includes information on setting
up the system directory for project files, as well as licensing information. Additionally, this section contains
information on setting preferences within the application for the customization of various features and
functionality.

+ Installing DB Optimizer

« Initial setup

+ Customizing DB Optimizer (Preferences)
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Installing DB Optimizer

To install DB Optimizer, run the installer and follow the prompts provided by the Installation Wizard. When the
installation is complete, check the Readme file to see if it contains any known issues or advisory notes that will
affect your installation of the product.

+ Installation Issues
« Installing DB Optimizer on Linux

Installation Issues

Install DB Optimizer in a different directory than previous versions of DB Optimizer. If DB Optimizer is installed in
the same directory, the following error appears at application startup: "Unable to read workbench state.
Workbench Ul layout will be reset."

If a previous version is already installed on your machine, either change the default Workspace or delete all files
from the Workspace directory. The Workspace directory location appears whenever you start DB Optimizer, and can
be redefined from this dialog box. If the same Workspace is indicated for the new version as was indicated
previously, the following error appears: "Cannot restore workbench layout."

If DB Optimizer is already running, you can also modify the Workspace directory by choosing File > Switch
Workspace > Other from the Main Menu.

Installing DB Optimizer on Linux
To install DB Optimizer in a Linux environment

1. Download the DB Optimizer installer and set the execution permissions as follows:
chmod 755 dbo_<version>.bin

2. Launch theinstaller in GUI mode from the console.

./dbo_<version>.bin
The DB Optimizer splash screen appears for a short time and afterwards the installer dialog appears.

3. OnthelIntroduction dialog, click Next.

4. On the License Agreement dialog, read the License Agreement, select | accept the terms of the License
Agreement, and then click Next.

5. On the Choose Install Set dialog, choose one of the following options, and then click Next.

« Install as Standalone Application. This option installs DB Optimizer as a Standalone Application,
without any prerequisites.

+ Install as Eclipse Plug-in. This option requires Eclipse 3.6 or higher or an Eclipse-based RCP
application.

6. On the Choose Instal Folder dialog, depending on the previously selected option, you can select a
destination folder where to install the Standalone version or you are required to browse to the folder that
contains Eclipse 3.6 (or higher) or an RCP application based on Eclipse 3.6.

7. After selecting the desired folder, click Next.

8. On the Choose Link Folder dialog, you can change the location where the Application/ Uninstall links are
created. Choose one of the options, and then click Next.

9. On the Pre-Installation Summary, review the installation details, and then click Install.

The Installing dialog shows the progress of the installation; it is closed when the installation is complete.
10. When the Install Complete dialog appears, you can select Start IDERA DB Optimizer, and then click Done in
order to start the application for a first time use.
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Initial setup
The following topics provide general help for configuring DB Optimizer:

+ Specify a workspace
« Licensing DB Optimizer

Additionally, the following preferences are available to help you customize and tune functions within the
application:

«+ Specify Data Sources preferences

» Specify SQL Development preferences

+ Specify SQL Editor preferences

+ Specify SQL Execution preferences

+ Specify SQL Filters preferences

« Specify Profile Alerts preferences

+ Specify Profile Repositories preferences

» Specify Tuning Job Editor preferences

+ Specify VST Diagrams Tuning preferences
+ Specify File Encoding preferences
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Specify a workspace

When you install DB Optimizer, you are prompted to create a workspace. Then, when you launch DB Optimizer, you
have an opportunity to choose your workspace. At any time while running DB Optimizer, you can change your

workspace.

To switch your workspace

1.

In DB Optimizer, select File > Switch Workspace. The Workspace Launcher appears.

=S

Waorkspace Launcher

Select a workspace

IDERA DB Optimizer stores your praojects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: CA\Users\npollardiAppData\Roaming\IDERA\dboptimizeriw «

~ Copy Settings
[ Workbench Layout
[] Working Sets

(?:' [ OK ] l Cancel ]

IDERA DB Optimizer 18.1.x

Browse for the appropriate workspace or create a copy of an existing workspace using the available Copy

Settings.

Click OK after making your selection. DB Optimizer opens or creates the appropriate workspace.
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Licensing DB Optimizer

The first time you launch DB Optimizer, you are prompted to activate the product. Choose to activate by Internet,
and then follow the prompts. During the activation process you will receive an email with an activation key; after
you enter that key into the License Setup dialog, you will receive a free 14-day evaluation license.

If due to firewall or other restrictions you cannot use Internet activation, select the email alternative.
To continue using DB Optimizer after the evaluation period

1. Select Help > IDERA Licensing > License Registration.
2. Follow the prompts.
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Customizing DB Optimizer (Preferences)

To customize various aspects of DB Optimizer, select the aspect you want to customize from the Preferences
menu.

This section is comprised of the following topics:

« Specify Data Sources preferences

» Specify SQL Development preferences

+ Specify SQL Editor preferences

+ Specify SQL Execution preferences

» Specify SQL Filters preferences

« Specify Profile Alerts preferences

+ Specify Profile Repositories preferences

» Specify Tuning Job Editor preferences

+ Specify VST Diagrams Tuning preferences
« Specify File Encoding preferences
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Specify Data Sources preferences

When you add a data source to your list of Managed Data Sources in the Data Source Explorer, DB Optimizer stores
the definition and metadata for the data source in the location you specify here. For information on adding data

sources, see Register data sources.

To specify Data Sources preferences

1. From the Preferences menu, select Data Sources. The DataSources pane appears.

Preferences (Filtered)

type filter text

Data Sources

Data Sources - v

Specify the location for data source definitions and their metadata:

Data Sources: Ch\Users\npollard\AppData\Roaming\IDERA\Dal -

Metadata: pData\Roaming\IDERA\Data Sources\metadata

Data Source Categories

Category Name Short Name Color Add...
Development DEV cdit.
Production PROD ]
Test TEST Remove
QA QA

Connectivity

Enable Oracle OCI driver

Note: This preference will enable use of the Oracle OCI driver installed on the
local machine. Additionally, this will cause the Oracle Thin JDBC driver to use
the installed Oracle client libraries. Please ensure your Oracle client installation
is compatible with your Oracle data sources before enabling this preference.
You may need to restart the application for this change to take effect.

lRestore Defaultsl [ Apply ]

@

[ OK ] [ Cancel ]

2. Specify the location for data source definitions and their metadata.
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3. Click Apply.

@ Forinformation on adding custom categories, see Customizing data source categories.
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Specify SQL Development preferences

The SQL Development Preferences specified on the first page of the SQL Development Preferences determines DB
Optimizer's behavior when connecting to and extracting DDL from a data source. For information on preferences
accessible by expanding SQL Development, see Customizing DB Optimizer (Preferences).

1. From the Preferences menu, select SQL Development.

Preferences (Filtered) u@&]

type filter text SQL Development T
» SQL Development

-

Connection timeout (seconds): E =

DDL Extraction

[ Extract dependent objects also

[ Add initial USE statement if the platform supports it
Extract storage information

[ |Include DROP statement

Oracle Data Dictionary View Usage
(@) Automatic "Role Based” Selection
Manually Force DBA_* View Usage
Manually Force ALL_* View Usage

DBA Check
DAIways check if the user has SELECT_CATALOG_ROLE role, when connecting to a database (Oracle only)

lRestore Defaul‘[s] l Apply ]

\2) [ OK l l Cancel ]

2. Choose your preferences, and then click Apply.
The following describes the SQL Development preferences:

« Connection timeout (seconds). Specify the connection timeout before the connection to the database fails.

« Extract dependent objects also. If selected, when extracting DDL dependent objects such as indexes are
also extracted.

- Add initial USE statement if the platform supports it. If selected, a USE statement is added to the DDL
extracted. Adding the USE statement ensures that when you run the DDL, you are using the correct database
context.

« Extract storage information. If selected, when extracting DDL object storage information is also extracted.

+ Include DROP statement. If selected, the DROP statement will be added to the DDL so you can easily
execute the statement.
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Specify SQL Editor preferences
To specify SQL Editor preferences
1. Select Preferences > SQL Editor.

Preferences (Filtered) [ | (=] |ﬁ‘
type filter text SQL Editor " i
4 50L Development
. SQL Editor Enable the SQL parser for files smaller than 700 5 KB
Severity level for semantic validation problems:
Hyperlinks can be configured on the Text Editors preference
page.
lRestDre Defaultsl [ Apply ]
(?:' [ OK l [ Cancel ]

2. Change the settings as appropriate in each section and then click Apply. the following options are available:
« Enable the SQL parser. For performance reasons, you may want to enable the SQL parser only if a
SQL file is smaller than the size you specify here.
+ Severity level for semantic validation problems. Choose a security level from this list. This option
determines how semantic code errors are flagged in the editor and the Problems view.
+ The link to specify hyperlinks takes you to the Text Editors preference page.

() Clearing Enable SQL Parser disables many of the "smart" SQL editor features, including

code formatting, auto completion, semantic validation, and hyperlinks. For better
performance, you may disable the parser for files above a specified size.
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See the following topics to configure other SQL Editor preferences.

« Specify Code Assist preferences

« Specify Code Formatter preferences

« Specify Code Quality preferences

« Specify Results Viewer preferences
« Specify SQL Templates preferences
« Specify Syntax Coloring preferences

Specify Code Assist preferences

IDERA DB Optimizer 18.1.x

The Code Assist panel is used to specify configuration parameters that determine how code completion features in
SQL Editor behave.

To specify Code Assist preferences

1. Select Preferences > SQL Editor.

-

L

Preferences (Filtered)

type filter text

4 50L Development
a S0 Editor

|Code Assist |
Code Formatter
Code Quality
Results Viewer
SQL Templates
Syntax Coloring

4| 1 P

Code Assist

Enable auto-activation

Auto-activation delay (ms): 1000

Auto activation triggers for SQL:

"] Fully qualify completions automatically

Code assist color options:

Completion proposal background
Completion proposal foreground

Color: @

-

[ Restore Defaults l [

Apply ]

@

oK

| [ Cancel ]

2. Inthe Preferences dialog, expand SQL Editor, and then click Code Assist.
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The following options are available on the Code Assist Preferences page:

IDERA DB Optimizer 18.1.x

Enable auto-activation. When selected enables code assist functionality with the Ctrl + Space command. If
this option is selected, the code assist window automatically appears when you stop typing.
Auto-activation delay (ms). Specify the amount of time in milliseconds that the window automatically

appears.

Auto activation triggers for SQL. Enter a trigger character or trigger characters. When you enter an
activation trigger in the SQL Editor, you will see the code assist options available.
Fully qualify completions automatically. When selected, specifies if code completion results are returned
specific (fully qualified), rather than the minimum required to identify the object.
Code assist color options. Specifies the color formatting of code completion proposals.

Select background or foreground options from the menu and modify them as appropriate.

Specify Code Formatter preferences

The Code Formatter pane provides configuration options for code formatting functionality in SQL Editor.

To specify Code Formatter preferences

1. Select Preferences > SQL Editor.

2.

-

Preferences

type filter text

» General &
Data Sources
» Help
» Run/Debug
4 5L Development
Code Completir
» Profile Alerts
Profile Repositc
4 5QL Editor =
Code Assist
Code Formai
Code Quality
Results View
SQL Templal
Syntax Color
SQL Execution
SQL Filters
» Tuning Job Edit -
<« P

N
|\"3/|

Code Formatter ol i
Select a profile;
[IDERA [built-in] v” Show... Rename Remoaove
Preview:
CREATE TABLE colTable -
(
coll INT,
col2 INT, S
col3 INT,
cold VARCHAR (3@)
s
INSERT
INTO colTable
WALUES
( -
4 ¥
lRestore Defaults] [ Apply l
OK l l Cancel ]

In the Preferences dialog, expand SQL Editor, and then click Code Formatter.
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The panel provides a drop-down list of formatting profiles and a preview window that displays how each profile
formats code.

®

Select a profile. From the list, choose the profile you want to view.

Click Show to view the details of the Profile. On the Show Profiles dialog that appears, you can edit the
profile and save the changes.

Click New to define additional code formatting profiles.

Click Edit to modify existing profiles. You can modify how code characters appear in the interface and how
SQL Editor determines line breaks.

Click Rename to change the name of an existing profile. The new name cannot be the same as another
existing profile.

If you create a new profile with a name that already exists in the system, a prompt will appear asking you
to change the name of the new code formatting template.

Create and edit code formatting profiles

You can create your own code formatting profiles that define how your SQL code is formatted.

To create a code formatting profile

1.
2.
3.

o

Select Preferences > SQL Editor.
In the Preferences dialog, expand SQL Editor, and then click Code Formatter.
On the Code Formatter pane, click Show or New and a dialog similar to the following appears.

Show Profile l =) X

Style Preview:

Keyword: |Uppercase - CREATE OR REPLACE PROCEDURE PreviewProcedure -

(
i vall IN NUMBER,
New lines val2 IN NUMBER,
val3 IN NUMBER

»

Maximum line width: 136 =

[“I1nsert a new line before keywords Is

Keep empty BEGIN.EMD block on a single line temp_val NUMBER;

BEGIN
SELECT col@
Conditions FROM table®
. . - - WHERE
Formatting policy: |Stack conditions, trailing operators v coll = vall AND
. Y col2 = val2 AND
Stacking threshold: 2 = col3 = val3;

[ Keep simple THEN statements on the same line DELETE CRAML LL O,

'f?:' This is a built in profile, you will ...a new name when you close the profile Apply OK l I Cancel

Make your changes, and then click Apply to preview your changes.

Click OK to create the new profile or to exit the Show Profile dialog.

Use the preview pane to preview the changes you make to your code formatting preferences. Changes are
not implemented until you click Apply or OK.
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Specify Code Quality preferences

The Code Quality preferences allow you to specify the severity level for several categories of problems that result in
inefficient or erroneous SQL.

To specify Code Quality preferences

1. Select Preferences > SQL Editor.
2. Inthe Preferences dialog, expand SQL Editor, then and click Code Quality.

Preferences (Filtered) u@lﬂ—hJ

type filter text Code Quality fro v
SQL Devel t
4 SQL Deve _opmen Select the severity level for the following categories of problems that result in
4 SQL Editor inefficient or erroneous SQL:
Code Assist
Code Formatter Missing valid JOIN criteria: Warning ~
Cod Ii
ode Quality Invalid or missing OUTER JOIN: Warning v
Results Viewer
SQL Templates Transitivity problem: Warning ~

Syntax Coloring Nested query in WHERE clause: Warning ~

Wrong place for conditions in HAVING clause: Warning ~
Index suppressed by a function or an arithmetic operator: |Warning ~
Mismatched or incompatible column types: Warning ~

MNULL column comparison: Warning ~

T lRestore Defaults] [ Apply l

@' l OK l l Cancel ]

3. Change the severity levels by clicking the list next to the category, and then choosing the level.
4. Click Apply to save your changes.

Specify Results Viewer preferences
The Results Viewer pane provides configuration options that specify how the Results view displays or saves results.
To specify Results Viewer preferences

1. Select Preferences > SQL Editor.
2. Inthe Preferences dialog, expand SQL Editor, and then click Results Viewer.
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Preferences (Filtered) l | (=] |ﬁ‘
type filter text Results Viewer e
SQL Devel t
“3Q eve_opmen Result sets options
a 50QL Editor

Code Assist Maximum number of result sets: 100 —

Code Formatter ] Suppress execution messages

Code Quality _ ] )
: @ Show results in editor
Results Viewer
5QL Templates Grid refresh interval {ms): 2000 =

Syntax Colorin =
y J Maximum result rows to sort: 2500(—

Results format:

Stripe the rows of the results table
| Display results in a separate tab in the SQL editor

() Save results to file

Prompt to save file

Browse...
Include SQL text
Comma delimited (*.csv) -
« | mn b [Restore Defaultsl l Apply ]
@' [ OK l l Cancel ]

3. Make your preference changes, and then save your changes by clicking Apply. The following options are
available:

« Maximum number of result sets: If selected and the executed SQL returns more results sets than the
maximum specified, result sets in excess of the maximum specified are not displayed.

« Suppress execution messages: If selected and the SQL you execute returns informational messages,
they are not displayed.

« Show results in editor: Execution results can be either shown in the editor or sent to a file.

« Grid refresh interval: Indicates the speed (in milliseconds) that the Results view refreshes.

« Maximum result rows to sort: If the number of rows and results exceed this number, the column
sorting in the result set is disabled.

 Results format: These are the different formats that can be used to display the results in the editor.

+ Stripe the rows of the results table: Adds intermittent highlighted bars in the Results view.
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« Display results in separate tab in SQL Editor: Opens the Results view in a separate window on the
Workbench.
« Save results to file: Provides options that let you save the contents of the result sets to afile. You can
also specify the file type, delimiter and text qualifier.

Specify SQL Templates preferences

The SQL Templates panel provides customization options for creating and modifying SQL code templates.

To specify SQL Templates preferences

1. Select Preferences > SQL Editor.
In the Preferences dialog, expand SQL Editor, and then click SQL Templates. The SQL Templates panel

displays a list of all SQL code templates currently available. Additionally, when you select a template from
the list, the Preview section displays the code block as it will appear when the template is selected in SQL

2.

-

Editor.
Preferences (Filtered) | =] m]
type filter text Templates =T g v -
SQL Devel t
4 5QL Deve _opmen Create, edit or remove templates:
4 5QL Editor .
Code Assist Name Context Description Auto [ns; [ MNew...
Code Formatter ALL. DB2(. allocates a curs.. on El Cdit
Code Quality ALTE.. DB2 (.. alters a table on -
Results Viewer ALTE.. DB2 (.. alters a tablesp... an Remove
SQL Templates ALTE.. DB2(.. altersa view on
; Restore Removed
Syntax Coloring ALTE.. DB2 (.. alters a function on -
ALTE.. DB2 (.. altersa method on Revert to Default
ALTE.. DB2 (.. altersa proced.. on
Import...
ALTE.. DB2 (.. altersaseguence on
'?‘ Al NE2 ¢ r[ﬁllc 2 nrncadl ire Tl - Export...
Preview:
4 )
[] Use code formatter
< | = > ’Restore Defaults] l Apply l
@' [ OK J [ Cancel ]
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3. Click the check box beside each template to specify whether it is included in the code assist check within

SQL Editor. Use the buttons on the right-hand side of the panel to create, edit, or delete SQL templates, as

needed.
When you create or edit a template, the Edit SQL Template dialog appears.

Edit SQL Template EETx

Name: ALLOCATE_CURSOR Edit context V] Automatically insert
Description: allocates a cursor for the result set
Pattern: ALLOCATE ${cursorName} CURSOR FOR RESULT SET ${variable}; -
( | -
'f?)' OK ] l Cancel

. Enter a Name, Description, and Pattern in the fields provided, and then click OK. If the template name
doesn't match an existing SQL code template, your new template is added to the list, and will automatically
be considered when the code assist function is executed in SQL Editor.

. Select the Use Code Formatter check box to apply code formatting preferences to the specified template.
For more information about setting code formatter preferences, see Specify Code Formatter Preferences.

Specify Syntax Coloring preferences

The Syntax Coloring panel provides configuration options that change the look and feel of code syntax in SQL

Editor.
To specify Syntax Coloring preferences

1. Select Preferences > SQL Editor.
2. Inthe Preferences dialog, expand SQL Editor, and then click Syntax Coloring.
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L

Preferences (Filtered) L@g
type filter text Syntax Coloring Pvovy
4 5QL Development
4 SQL Editor 2l
Code Assist 4 SQL Enable
Code Formatter Keyword Color: E
Code Quality MNon-executable command line [ Bold
Results Viewer Number ] talic
SQL Templates Other
Syntax Coloring String
> Comment
Preview:
-- Table : Accounts -
CREATE TABLE ACCOUNTS E
( i
T™Th THKIT
4 b
< 0 [Restc:re Defaults] [ Apply ]
® [ oK ] l Cancel l

3. Usethe tree view provided in the Element window to select the comment type or code element you want to
modify. Select the options to the right-hand side of the window to modify it. The Preview window shows a
piece of sample code that updates according to the changes you made.
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Specify SQL Execution preferences
The SQL Execution preferences you set determine how SQL is executed.
To specify SQL Execution preferences

1. Select Preferences > SQL Execution.

Preferences (Filtered) l | =] Lﬂh‘
type filter text SQL Execution B BT
SOL Devel t
4 5QL Deve opmen Enable auto-commit for the following platforms:
SQL Execution
[¥]IBM DB2 for LUW
Microsoft SQL Server
Oracle
Sybase ASE
Enable DBMS output (Oracle only)
| Restore Default5| | Apply |
@' [ oK l | Cancel |

2. Select from the following options, and then click OK.
+ Enable auto-commit for the following platforms: When disabled, the SQL is executed within
transactions that must be manually committed.
« Enable DBMS output (Oracle only): When disabled, this omits the output statements that Oracle
would otherwise display.
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() Ifyou disable auto-commit for a platform, you must use SQL Editor's transaction features to execute code
on that platform.
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Specify SQL Filters preferences

These are the set of controls that determine what objects are shown in the Data Source Explorer.

To specify SQL Filters preferences

Select Preferences > SQL Filters.

IDERA DB Optimizer 18.1.x

ﬂ.e Preferences (Filtered)

type filter text

4 5QL Development
SQL Filters

SQL Filters

The selected filters will be applied in an AND manner.

[BM DBZ for LUW | Microsoft SQL Sewerl Oracle | Sybase ASE‘

Ignore system objects

|

Mew...

Edit...

Remaove

Import...

Export...

Select A

Deselect All

lRestore Defaultsl [

Apply

x|

Cancel
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Specify Profile Alerts preferences

For information about specifying the Profile Alert preferences, see Configuring profiling.
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Specify Profile Repositories preferences

For information about specifying the Profile Repositories preferences, see Configuring profiling.
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Specify Tuning Job Editor preferences

For information about specifying the Tuning Job Editor preferences, see Configuring tuning.
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Specify VST Diagrams Tuning preferences

For information about specifying the VST Diagrams Tuning preferences, see Configuring tuning.
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Specify File Encoding preferences

The Workspace panel provides options for Unicode support in SQL files.

To specify File Encoding preferences

1. Select Preferences > General.\
2. Expand General, and then click Workspace in the tree.

IDERA DB Optimizer 18.1.x

Preferences (Filtered)

Workspace BoEw <

UI Responsiveness

Web Browser ["] Show workspace path in window title

type filter text
4 General . :
See 'Startup and Shutdown' for workspace startup and shutdown preferences.
> Appearance
Compare/Patch ) )
Content Types Build automatically
. Editors ["] Refresh using native hooks or polling
Globalization ["| Refresh on access
Keys [|save automatically before build
» Network Connectic | [_| Always close unrelated projects without prompt
Perspectives
Search Workspace save interval (in minutes): 5
» Security o ]
. Startup and Shutdc Workspace name (shown in window title):
Tracing

Workspace path: C\Users\npollard\AppData\Roaming\ldera\dboptimizer\workspace

»| Workspace
Open referenced projects when a project is opened
Always ) Never @ Prompt
Command for launching system explorer: explorer /E/select=%{selected_resource_loc}
Text file encoding New text file line delimiter
(@) Default (UTF-8) @) Default (Windows)
@) Other: | UTF-8 - @) Other: |Windows ~
7 e N [Restore Defaults] l Apply ]
(?:' [ 0K l l Cancel l

The default encoding for text files on Windows platforms is Cp1252. You can change Unicode support in from file to

file using the Text File Encoding options available on the Workspace panel.

To change text file encoding in the development environment

1. Select Preferences > General > Workspace, and then click the Other option under Text File Encoding.
2. Use the drop-down menu to select an encoding mode from the list provided.

3. Click Apply to save your changes.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

33


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

To change text file encoding on a specific, folder, or project

1. Right-click on the file, folder, or project that you want to modify, and then choose Properties.
2. Modify the Text file encoding selection on the Resource properties page that appears.

' o
Properties for Untitled Tuning Job 2.tun l =] ﬂ

Resource v A
R
£Soutce _ Path: /SQLProject/Untitled Tuning Job 2.tun

Run/Debug Settings .
Type: File
Location: C\Users\npollard\AppData\Roaming\ldera\dboptimizer\workspace\SQLProject\Untitled Tuning

Job 2.tun

Size: 2,000 bytes
Last modified: March 1, 2018 at 8:52:38 AM
Attributes:
[ Read-only
Archive
[ Derived

Text file encoding
(@) Default (inherited from container: UTF-8)

©) Other: | UTF-8 -

lRestore Defaults] l Apply ]

® [ OK ] l Cancel ]
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Introduction to database tuning

This discussion will help you understand the methodology behind DB Optimizer's tuning functionality and how you
can use it to optimize database performance. This discussion is comprised of the following topics:

« Introduction to DB Optimizer tuner

« SQL tuning methodology

o SQL tuner overview

« What's happening on the databases?
+ Tuning example

« Finding and tuning problem SQL
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Introduction to DB Optimizer tuner

DB Optimizer's methodology grew out of the impossible predicament presented by the defacto method of database
tuning. The standard method was trying to collect 100% of the statistics 100% of the time. Trying to collect all the
statistics as fast as possible ends up putting load on the monitored database and creating problems. Stories of
problems created by database monitoring products abound in the industry. In order to avoid putting load on the
target database, performance monitoring tools have to collect less often as a compromise. Oracle compromised in
10g with AWR (their automated performance data collector), only running it once an hour because of the
performance impact. Not only is the impact on the monitored target high, but the amount of data collected is
staggering, but the worst problem of all though, is the impossibility of correlating statistics with the sessions and
SQL that created the problems or suffered the consequences.

The solution to collecting performance data required letting go of the old problematic paradigm of trying to collect
as many performance counters possible as often as we could and instead freeing ourselves with the simple
approach of sampling session state. Session state includes what the session is, what its state is (active, waiting, and
if waiting, what it is waiting on) and what SQL it is running. The session state method was officially packaged by
Oracle in 10g when they introduced Active Session History (ASH). ASH is an automated collection of session state
sampling. The rich robust data from ASH in its raw form is difficult to read and interpret. The solution for this was
Average Active Sessions (AAS). AAS is a single powerful metric which measures the load on the database based on
the ASH data. AAS data provided the perfect road map for what data to drill into. The main drill downs are "top
SQL," "top session," "top event," and "top objects."

Other aggregations are possible based on the different dimensions in the ASH data.
Tuning example

Here is an example screen shot of the same batch job being run four times. Between each run performance
modifications are made based on what was seen in the in the profiling load chart:
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Run examples:

1. Inrun 1, the "log file sync" event is the primary bottleneck. To correct this, we moved the log files to a faster
device. (You can see the checkpoint activity just after run 1 where we moved the log files.)

2. Inrun 2, the "buffer busy wait" event is the primary bottleneck. To correct this, we moved the table from a
normal tablespace to an Automatic Segment Space Managed tablespace.

3. Inrun 3the "log file switch" (checkpoint incomplete) event is the primary bottleneck. To correct this, we
increased the size of the log files. (You can see the 10 time spent creating the new redo logs just after run 3.)

4. The run time of run4 is the shortest and all the time is spent on the CPU which was our goal, take advantage
of all the processors and run the batch job as quickly as possible.

() Toview an explanation of the event, hover over the even name in the Event section.

Conclusion:

With the load chart we can quickly and easily identify the bottlenecks in the database, take corrective actions, and
see the results. In the first run, almost all the time is spent waiting, in the second run we eliminated a bottleneck but
we actually spent more time as the bottleneck was worse. Sometime this happens as eliminating one bottleneck
causes great contention on the next bottleneck. You can see that the width of the run or the time it ran is wider in
run 2. By the third run, we are using more CPU and the run time is faster and finally by the 4th run all the time spent
is on CPU, no waiting, and the run is the fastest by far.
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SQL tuning methodology

A common SQL tuning methodology is to:

1. Verify that the execution path is the optimal for the query. If not, either use the tuning directives (such as
hints on Oracle) or identify why the native optimizer failed to pick the optimal path.

2. Ifthe query is still slow, then look at adding indexes.

3. Ifthe query is still slow, then you know you are going to have to look at the architecture.

Ask yourself:

« What information is the query trying to get?
« Isthis information necessary?
+ Are there alternative ways to get this information?

DB Optimizer's SQL Tuner can help with steps 1 and 2. Step 3 must be done by a developer or DBA, but knowing that
steps 1 and 2 are already validated can indicate to management that step 3 is necessary and therefore allocate
sufficient resources for step 3.

How do we know if the native database optimizer chose the optimal path? How long would it take to check this by
hand?

DB Optimizer's SQL Tuner is a solid fast sanity test to verify the plan chosen by the native database SQL optimizer.
Tuner quickly generates as many alternative paths as possible and allows the user to execute them to see if there
are more efficient execution paths. DB Optimizer's SQL Tuner is successful at tuning queries that have a sub-
optimal execution path.

A query has a sub-optimal execution path when the database optimizer has miscalculated the cost of the various
possible access paths and mistakenly chosen a bad path. The access path calculations are sometimes
miscalculated because of the following reasons:

« The table/index statistics are missing or wrong. For example, the number or rows is missing or way off.

« The data is skewed, for example, the number of orders with an open status is usually low compared to
all the orders that have a closed status because the work is complete. For example, orders get filled
every day, but only a few are open and needing to be processed. Looking for open orders should probably
use an index and return fewer rows than looking for closed orders which should probably just do a full table
scan.

« The predicates used are correlated. The optimizer treats two predicate filters on a table as more selective
than just one, but this is not always the case such is the case in the query, how many Swedes speak Swedish
which basically returns the same number of results as just asking for the number of Swedes alone. Another
example is how many Swedes speak Swahili, which is probably more selective than the optimizer would
guess.

+ Thereis a bugin the optimizer.

DB Optimizer's SQL tuner takes a query and tries to produce as many execution paths as possible. These alternative
execution paths can then be run to see if there is a faster or less resource expensive execution path. The execution
of each alternative case is timed and if the execution exceeds 1.5 X the original case then its execution is stopped
and we move on to the next case. This avoids wasting time and resources on execution plans that are clearly sub-
optimal.
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SQL tuner overview

Tuning provides an easy and optimal way to discover efficient paths for queries that may not be performing as
quickly or as efficiently as they could be.

The application enables the optimization of poorly-performing SQL code through the detection and modification of
execution paths used in data retrieval. This process is performed through the following functions:

« HintInjection

+ Index Analysis

« Statistic Analysis (Oracle only)

+ Query re-writes such as suggesting joins to eliminate Cartesian joins, adding transitivity predicates, and
unnesting subqueries in the WHERE clause.

Tuning analyzes an SQL statement and supplies execution path directives to the application that encourage the
database to use different paths.

For example, if tuning is selecting from two tables (A and B), it will enable the joining of A to B, or B to A as well as
the join form. Additionally, different joining methods such as nested loops or hash joins can be used and will be
tested, as appropriate.

Tuning selects alternate paths and enables you to change the original path to one of the alternates. Execution paths
slower than the original are eliminated, which enables you to select the quickest of the returned selections and
improve query times, overall.

This enables the DBA to correctly optimize queries in the cases where the native optimizer failed.
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What's happening on the databases?

Is the database idle, working, or bottlenecked?

IDERA DB Optimizer 18.1.x

When a bottleneck happens how can you know which of these problems are causing the problem? A bottleneck

could be caused by:

« An application problem

+ Anundersized machine

+ SQL requiring optimization
» A misconfigured database

All of these can be easily identified from DB Optimizer's performance profiling screen. Let's look at the components

of the performance profiling screen.
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The screen has the following important areas.

1. Databases. For more information, see Databases.

2. Average Active Sessions (AAS) Load of selected database. For more information, see Average Active

Sessions (AAS) Load of selected database.

S

Databases

First, on top left, is a list of our databases we have registered.

Average Active Sessions (AAS) Load of selected database

Maximum CPU line. For more information, see Maximum CPU line.

Top SQL. For more information, see Top SQL, Top Bottlenecks, and Top Sessions.

Top Bottlenecks. For more information, see Top SQL, Top Bottlenecks, and Top Sessions.
Top Sessions. For more information, see Top SQL, Top Bottlenecks, and Top Sessions.

The most important part of the screen is the Average Active Sessions (AAS) graph. AAS shows the performance of
the database measured in the single powerful unified metric AAS. AAS easily and quickly shows any performance
bottlenecks on the database when compared to the Maximum CPU line. The Max CPU line is a yardstick for
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performance on the database. When AAS is larger than the Max CPU line there is a bottleneck on the database.
Bottleneck identification is that easy.

AAS or the average number or sessions active, shows how many sessions are active on average (over a 5 second
range in DB Optimizer) and what the breakdown of their activity was. If all the users were running on CPU then the
AAS bar is all green. If some users were running on CPU and some were doing IO, represented by blue, then the AAS
bar will be partly green and partly blue.

Maximum CPU line

The line "Max CPU" represents the number of CPU processors on the machine. If we have one CPU then only one
user can be running on the CPU at a time. If we have two CPUs then only 2 users can be on CPU at any instant in
time. Of course users can go on and off the CPU extremely rapidly. When we talk about sessions on the CPU we are
talking about the average number of sessions on CPU. A load of one session on the CPU thus would be an average
which could represent one user who is consistently on the CPU or many users who are on the CPU for short time
periods. When a CPU becomes a resource bottleneck on the database we will see the average active sessions in CPU
state go over the Max CPU line. The number of sessions above the max CPU line is the average number of sessions
waiting for CPU.

The Max CPU is a yardstick for performance on the database.

From looking at the previous chart the problem is a machine resource problem.

Top SQL, Top Bottlenecks, and Top Sessions

In order to know what the problem is, we have to find out where that demand is coming from. To find out where the
demand is coming from we can look at Top SQL and Top Session tables below the load chart. In our case shown
here the load is well distributed over all SQL in Top SQL and all sessions in Top Session. There is no outlier or
resource hog. In this case it's the machine that's underpowered. What does a case look like where we should tune
the application? The following screenshot depicts such a problem.
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In this case, again the CPU demand is more than the machine can supply but if we look at "Top SQL" we can see
that the first SQL statement (with the large green bar) uses up much more CPU than any of the rest, actually 60%! If
we could get it down to 10% CPU then we'd save 50% of the CPU usage on the machine! Thus in this case it's worth
our while to spend a day or week or even a couple weeks trying to tune that one SQL statement instead of buying a
bigger machine.
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Finally, how do we know when the database configuration is a problem? We know it's a configuration problem
when we are seeing something other than CPU as the bottleneck in Top Bottleneck section. Here's an example
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In this case we can see the load is higher than the Max CPU line but the load is coming from brown colored bars and
the green CPU colored bars. If we look at Top SQL we see that there is only one SQL taking up almost all the load,
but it's not because of CPU which would be a green bar, but some other color. What does this other color represent?
We can look at the Top Bottleneck section and see that it is "log file switch (incomplete)" which basically means the
log files are too small, the database is not correctly configured. This bottleneck can be resolved simply by

increasing the log size.
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Tuning example
This example is comprised of the following parts:

» The database is hanging or the application has problems
» The database caused the problem
« The machine caused the problem
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The database is hanging or the application has problems

I wonder if you can imagine, or have had the experience of the application people calling with anger and panicin
their voices saying, "The database is so slow, you've got to speed it up."

What's your first reaction? What tools do you use? How long does it take to figure out what's going on?

Let's take a look at how it would work with DB Optimizer.
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We can clearly see that the database is not bottlenecked and there must be a problem on the application.

Why do we think it's the application and not the database? The database is showing plenty of free CPU in the load
chart, the largest chart, on the top in the image above. In the load chart, there is a horizontal red line. The red line
represents the number of CPUs on the system, which in this case is two CPUs. The CPU line is rarely crossed by bars
which represent the load on the database, measured in average number of sessions. The session activity is
averaged over five samples over five seconds, thus bars are five seconds wide. The bars above fall mostly about one
average active session and the bars are rarely green. Green represents CPU load. Any other color bar indicates a
sessions waiting. The main wait in this case is orange, which is log file sync, waits for commits. Why is the database
more or less idle and why are most of the waits we do see for "commit"? When we look at the code coming to the
database we see something like this:

insert into foo values ('a'); commit;
insert into foo values ('a'); commit;
insert into foo values ('a'); commit;
insert into foo values ('a'); commit;
insert into foo values ('a'); commit;
insert into foo values ('a'); commit;
insert into foo values ('a'); commit;

Doing single row inserts and committing after each is very inefficient. There is a lot of time wasted on network
communication which is why the database is mainly idle. When the application thinks it's running full speed ahead,
itis actually waiting mainly on network communication and commits. If we commit less and batch the work we
send to the database, reducing network communications, we will run much more efficiently. Change the code to:

begin
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for i in 1..1000 loop insert into foo values

("a');
-commit;
end loop;
end;

/

commit;

This change improves the communication delay and now we get a fully loaded database but we run into database
configuration issues.
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The database caused the problem
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In the above DB Optimizer screen, the same workload ran four times. We can see that the time (width of the load)
reduced, and the percent of activity on CPU increased.

Runs:

1. InRun 1, the orange "log file sync" area is the largest, which means uses are waiting on commits even
though we are committing less in the code. In this case we moved the log files to a faster device. You can see
the checkpoint activity just after run 1 where we moved the log files.

2. InRun 2, the dark red "buffer busy wait" area is the largest. We drilled down on the buffer busy wait event in
the Top Event section and the details tell us to move the table from a normal tablespace to an Automatic
Segment Space Managed tablespace.

3. InRun 3, the dark brown "log file switch (checkpoint incomplete)" are is the largest, so we increased the size
of the log files. You can see the 10 time spent creating the new redo logs just after Run 3. The run time is the
shortest and all the time is spent on the CPU which was our goal, to take advantage of all the processors and
run the batch job as quickly as possible.

4. The run time is the shortest and all the time is spent on the CPU, which was our goal to take advantage of all
the processors and run the batch job as quickly as possible.
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The machine caused the problem

Now that the application is tuned and the database is tuned, let's run a bigger load:
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We can see that the CPU load is constantly over the max CPU line. How can we have a bigger CPU load than there
are actually CPUs on the machine? Because the demand for CPU is higher than the CPU available on the machine.

In the image above, there are two CPUs on the machine but an average of three users think they are on the CPU,
which means that on average one user is not really on the CPU but ready to run on the CPU and waiting for the CPU.

At this point we have two options. In this case we are only running one kind of load, the insert. For inserts we can
actually go even further tuning this insert and use Oracle's bulk load commands:

declare

TYPE IDX IS TABLE OF Integer INDEX BY BINARY_INTEGER;
MY_IDX IDX;

begin
for i in 1..8000 loop
MY_IDX(1i):=1;

end loop;

FORALL indx IN MY_IDX.FIRST .. MY_IDX.LAST
INSERT INTO foo ( dummy )

VALUES ( MY_IDX(indx) );

COMMIT;

end;

/

But if this was an application that had a lot of different SQL and the SQL load was well distributed across the system
then we'd have a case for adding more hardware to the system. Making the decision to add more hardware can be a
difficult decision because in general the information to make the decision is unknown, unclear or just plain
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confusing, but DB Optimizer makes it easy and clear, which can save weeks and months of wasteful meetings and

debates. For example:
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If we look in the bottom left, there is no SQL that takes up a significant amount of load, there is no outlier SQL that
we could tune and gain back a lot of wasted CPU. We'd have to tune many SQL and make improvements on most of
them to gain back enough CPU to get our load down below the max CPU line. In this case, adding CPUs to the

machine might be the easiest and most cost effective solution.

Conclusion:

« With the load chart we can quickly and easily identify the bottlenecks in the database, take corrective
actions, and see the results. In Part 1, we had an application problem, in Part 2 we had three database
configuration issues, and in Part 3 we had a hardware sizing issue. In all three instances DB Optimizer
provides a clear and easy presentation of the data and issues making solutions clear.
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Finding and tuning problem SQL
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DB Optimizer is targeted at finding problem SQL in a running load with the profiler and then tuning that (or those)
specific queries with the tuner.

It's not efficient just to dump a bunch of procedure code into the tuner and then try and see if any of the SQL in the
package or procedure is tunable. Most queries should, by default, run optimally on a database, so the goal of DBO is
to tune those queries that for one reason or another are not optimally tuned by the database by default. The easiest
way to find those queries is to identify them on a running system. They can be identified on a running system
because they take up a lot of resources. If we find a resource intensive query, then it's worth the time to generate
cases and analyze it for missing indexes to see if there is a way to tune it.
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Using DB Optimizer

This section describes how to use the features of DB Optimizer to optimize your database operations. This section
contains an overview of DB Optimizer functionality and also contains detailed instructions for:

« Working with data sources

« Working with SQL projects

 Creating and editing SQL files (SQL Editor)
« Executing SQL files

+ Troubleshooting
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Working with data sources

The Data Source Explorer provides a tree view of all registered data sources and associated database objects. When
you first start DB Optimizer, a prompt appears and offers to populate Data Source Explorer from multiple sources
on the system. This includes previously-registered data sources on other IDERA products, and third-party DBMS
clients such as TOAD. If DB Optimizer cannot detect a data source, you can register it manually.

Additionally, you can initiate this feature by clicking the Auto-Discovery button on the Toolbar or via the File >
Import > IDERA > Data Sources > Previously Registered IDERA Data Sources (Registry) command from the Main
Menu.

95 Data Source Expl.. 2 &= SQL Project Expl.. ~— O
FRiedy B~ ud| 28 ~
type filter text
4 |7 Managed Data Sources (1)
4 s DBPSSQLSerl6 (SQL Server 13.00.1601)
4 [3 Database Objects
: =# Backup Devices ()
. 'ty Databases (20)
. g4 Linked Servers

s NN

The Profiling Repository entries in the Data Source Explorer are available only when configured in the Profile
Configuration Dialog for Oracle data sources only. These are saved profiling sessions that you can share with other
DB Optimizer users. For information on configuring the data source profiles, see Building profiling configurations.

« Register data sources

« Add a new data source

« Import and export data sources

« Categorize data sources

« Customizing data source categories
« Browse a data source

« View database object properties

« Search for database objects

« Filter database objects

« Drop a database object
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Register data sources

When DB Optimizer is started, it prompts you to discover data source catalogs that have been created by any
previously-installed IDERA products (DBArtisan, Rapid SQL, etc.), or other instances of DB Optimizer.

Additionally, the system scans your machine for the client software of all supported third-party DBMS platforms
(TOAD, Eclipse Data Tools Platform, etc.). These data sources are automatically added to the data source catalog.

To manually initiate the scan later

1. Click the Discover Data Sources icon &1 at the top of Data Source Explorer. The Discover Data Sources
dialog appears.

Discover Data Sources l | =] |i:h
Discover Data Sources f
Select the locations to search for data sources. _H
Previously registered IDERA data sources (Registry)
File system and network
Eclipse Data Tools Platform (DTP)
(@ Workspace
() File system: Browse...
"] Quest Software (TOAD)
(@) Workspace
File system: Browse...
@' < Back Mext = Finish Cancel

2. Choose the type of data sources for which you want to scan, and then click Next. The wizard automatically
returns all data sources it finds on your machine based on the criteria you specified.
3. Choose the data sources you want to add to the DB Optimizer environment, and then click Finish.

Data Source Explorer automatically populates with the new data source selections.
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() Toadd data sources manually, right-click Managed Data Sources in the Data Source Explorer tree, select
New > Data Source, and then enter the connectivity parameters as prompted.

For additional information on data source connection parameters, see DBMS connection parameters by platform.

Once registered, the data source appears in the Data Source Explorer view. If you have created more than one
workspace, they all share the same data source catalog.

Once a data source is registered, the connection parameters are stored locally. In some cases, a user ID and
password are required to connect to a registered data source. DB Optimizer can encrypt and save user IDs and
passwords to connect automatically.

() Insome cases, older versions of DB Optimizer and DB Artisan/Rapid SQL are not compatible with this
version of DB Optimizer, and the methods listed above will not import these older data source catalogs. If
you are experiencing difficulties, you can import the old data sources via the Windows registry by selecting
File > Import > IDERA > Data Sources > Previously Registered IDERA Data Sources (Windows Registry).
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Add a new data source
You can also add a new data source manually.
To manually add a new data source

1. Click File > New > Data Source.
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MNew Data Source: New data source

Register a new data source

Choose the server type and location for your new data source,

Generate an unigue name based on the alias or the host name

Data source name: | New data source

Select a server type: Select a data source group:

rthGeneric JDBC 21 Managed Data Sources
ctiIBM DB2 for LUW

i Microsoft SQL Server
£'thOracle

£t Sybase ASE

[ Create a new server type-specific subgroup

-

Select a category: | Default
Configure data source categories

® < Back Mext = Finish Cancel

2. If you want the system to assign a name to the data sources, select Generate a unique name based on the

alias or the host name.
If you want to enter the data source name, deselect Generate a unique name based on the alias or the

host name, and then in the Data source name field, enter the data source name.
3. Inthe Select a server type area, select the type you want to add.
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4. Inthe Select a data source group area, select the data source group where you want the new data source to
appear in the Data Source Explorer.

5. If you want to assign the new data source to a category (useful if you have a large number of data sources to
manage), click the Select a category list, and then choose one of the categories.

o, J‘\/‘\_F'_HHM\" ot M—M—NJ\\U—NME“N—N—HM
7 [ x\\p——-ﬁf‘\.\/’j\f” \"—TT-" -"—"_T\

| Create a new server type-specific subgroup
Select a category: | Default >
. Default -
Development ‘E
r"i“. 0 Production o
= Test -
Pl I h

Categorized data sources appear with the color for the designated category on the bottom left of the data
source icon in the bottom of such as =l for the Test category and i for the Production category.

() Forinformation on adding custom categories, see Customizing data source categories.

When you open a tuning job or SQL Editor window to create SQL for the categorized data source you will see
that the category color is applied to the top of the window, as follows.

[# Untitled Tuning Job 2.tun % | @ Untitled SQL Load & [5a) Untitl%
b ) Microsoft SQL Server » Ha DBPSLABSSQLSer16 (13.00.1601) » ma}

b P >
W&%catwource s not gaected. .~ /
b e —— h\\‘_‘"j—u-—m
6. Click Next.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

56


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

s B
MNew Data Source: New data source l =] ﬁ

Configure a new Oracle data source

Enter Oracle-specific connection and security credential information for the new data
SOUFCE,

Oracle
(T) Use a TNS name alias

Server alias:

(") Use connection descriptor

q

(@) Use a direct connection

*

Host
Port: 1521
Type: () Service name @ sID

Service/SID name:’

Instance name:

Security credentials

User name:

Password:

Connect as: [normal =

Auto-connect (Saves and encrypts password)
| Connect using Windows Authentication

[Test CDnnectionl

@ < Back Mext = Finish [ Cancel ]

7. Complete the data source configuration and then click Test Connection. This will ensure your configuration
is correct. If the connection test fails, make the necessary corrections, and then click Finish. The new data

source appears in the Data Source Explorer.
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Some IDERA products contain data source catalogs that are shared with DB Optimizer. In other words, instead of
manually adding data sources to the environment, you can import an existing data source catalog from other IDERA
products or third-party DBMS sources.

You can import Data Sources via the File > Import command in the Main Menu, expanding the IDERA folder in the
Data Source Selection tree, and then choosing Data Sources.

Import

l

5 e |

Select

Import data sources.

Select an import source:

pe filter text

*,

=1

» = General
: = CVS
4 = [DERA
Bl Data Sources
> = Install
: = Run/Debug
> = Team

@

Mext >

Finish

Cancel

« Eclipse Data Tools Platform (DTP)

The following types of sources can be imported to Data Source Explorer:

« Previously Registered IDERA Data Sources (File)

+ Previously Registered IDERA Data Sources (Registry)
+ Quest Software (TOAD)

Once a data source is registered, it automatically appears in Data Source Explorer. Connection parameters are

stored locally, and DB Optimizer can be set to connect automatically each time you select the data source from the

tree.
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Conversely, you can also Export your current data source catalog to a file, which can then be imported into other
instances of DB Optimizer via the Previously Registered IDERA Data Sources (File) option. This is performed using
the File > Export command in the Main Menu, and then selecting IDERA > Data Sources from the tree view in the
Export dialog.

To import data sources

1.
2.
3.

Select File > Import. The Import dialog appears.

Choose IDERA > Data Sources from the tree, and then click Next.

Choose a source from which you want to import the data sources. You can choose to import data sources
from the DTP, TOAD, or an existing IDERA data source catalog stored in the Windows registry or as a file
(created via the Export command).

Click Next.

Specify the location of the import source, and then click Finish. Data Source Explorer is automatically
populated with the new data sources.

To export data sources

Select File > Export. The Export dialog appears.

Choose IDERA > Data Sources from the export tree and click Next.

Use the check boxes beside each listed data source to indicate which data sources you want to export., and
then click Next.

Click Finish. The data sources are automatically exported in the form of an XML file. You can import this file
to other instances of DB Optimizer via the Import command.
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Categorize data sources

To make managing a large number of databases easier, you can assign a category to a data source. Categorized
data sources appear with the color for the designated category on the bottom left of the data source icon in the

bottom of such as 8l for the Test category and s for the Production category.

@ Forinformation on adding custom categories, see Customizing data source categories.

You can categorize a data source when you add a new data source (see Add a new data source) or by editing the
properties of an existing data source.
To edit properties for an existing data source
1. Inthe Data Source Explorer, locate and then right-click the data source you want to add to a category.
2. Choose Properties.

¥ Properties for DSQUERY #2 (SOL Server)

|=.v. e Fiter tet Data Source Canfiguration -
- Configuration P ]
- 50U Filters Conflowation | Advanced |
Data gource name: [DBQUERY_#Z

Cateqory: Mo categary

Microsoft SOL S2ra
(" Use @ network (i [ | Test
o

Server sias i Production

3. From the Category list, choose the category you want, and then click OK.

When you create a tuning job for the categorized data source you will see that the category color is applied to the
top of the tuning job data source details.

-
|| Untitled Tuning Job 4.tun &2

P Overview F" Analysis

£E Overview

Tuning Statements Genetrate cases [ ]Perform detai analysis
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Customizing data source categories

DB Optimizer lets you customize your data source category scheme. A data source category has the following
configurable components:

« Category name. The name displayed as a selection when selecting a category
« Short Name. An abbreviation shown in window components and icons
+ Color. The color used to denote a categorized data source in the Explorer tree icons and window tabs.

To customize your datasource categories

1. Select Preferences > Data Source, and then select the Datasource Group panel.
2. Take one of the following actions:

+ Create a new category by clicking Add and selecting or providing a Full name, Short name, and
Color combination.

« Edit an existing category by selecting the category, clicking Edit and modifying the name and color
combination.

() The short name for a category cannot be edited.

« Delete an existing category by selecting the category, clicking Delete and verifying the deletion at the
prompt.
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Browse a data source

You can drill down in the Data Source Explorer tree to view registered databases on a server, and view tables, and
other objects in a database. Additionally, you can view the structure of individual objects such as the columns and
indexes of a table. Right-click the object for a menu of available commands, such as Extract to Project, which
creates a new SQL file containing the object's DDL.

In most cases, whenever you browse a data source, DB Optimizer requires login information in order to connect
with the data source. Enter a valid user name and password in the fields provided. The Auto Connect option retains
your login credentials for future connections to the same data source.

You can turn off the Auto Connect feature by right-clicking on a specified data source and toggling the Connect on
Expand option. By default, when Connect on Expand is active, DB Optimizer automatically attempts to connect to
the server each time you browse a data source.
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All objects in Data Source Explorer contain properties as they relate to the DB Optimizer application.

3 Data Source Expl &3 . 5 SQLProjectExpl | — O
s R Heo | BE T

| =
]

| =R

= [=* Managed Data Sources [2]
&-l=F DE2 Servers
# =5 M5 S0 Servers
[+ % datoearl1 (5QL Server)
@ Sl datoedwina1 (SQL Server 7.0.1094.0)
(= ﬁ datotb 19 (SQL Server 8.0.818.0)
= £'f) Databases (41)

- 0
i %) Chedk Constraints

B Defauts

¥ Foreion Keys
fx Functions
- Indexes

':P Primary Keys
: H; Procedures
& Roleg

22 Rules

[+ Tables

d {J Triggers

= ".}9 Unique Keys
A} User Datatypes
& Users

&8 Views

.Ei i E|.

B

E:. Eink

e

DB Optimizer Object Properties are viewed via the Properties dialog. The dialog is accessed by right-clicking the

object in Data Source Explorer.
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& Properties for TORLABSCORCL (MOVIES) (Oracle 10.2.0.1)

|| . Data Source Configuration -

Configuration . F—
541 Fikers Configuration  Advanced

Data source name: | TORLAESCCRCL (MOVIES)
Category: W:_] Tesk w

Oracle
(T Use & THS name alias

(%] Use a direck connection

Hostflnstance: | TORLABSCCRCL
Part; [ 1521

Type: (' Service name {(=15ID

SerwiosSID name: | arcl

Sacurity oredentials
User name:  MOVIES |

Pasoword: | seeses |

Connect 25; normal v

futo-connect (Saves and endrypis passwond)
[ Al brusted connections

[T-a&t Cu'rla-:til:-n] l Apply J

@ [ ok || conca |

To view Data Source Explorer object properties

Right-click a data source in Data Source Explorer. The dialog displays properties with regards to Configuration and
SQL Filters.

The Configuration node provides information about the parameters used to initially define the data source during
the data source registration process. For more information on these values and how to modify them, see Register
data sources.

The SQL Filter node enables a developer to place filters on data source objects that appear in the Database
Explorer. For more information, see Filter database objects.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

64


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

Search for database objects

Database object searches rely on the Object Index when returning results. By default, caching is set to configure
only parts of a database. To configure the Index to expand object searches, see Specify Data Source Indexing

Preferences.

To search for database objects

1. Select Search > Database. By default, the search scope is all currently connected databases. Under Specify
the scope for the search, clear any databases or server check boxes you do not want to search.
2. Specify the search criteria:

Type the value to search for in the Search String field. Use the * character to indicate wildcard string
values and the ? character to indicate wildcard character values.

Select Case Sensitive to indicate to the search function that you want case sensitivity to be a factor
when searching for appropriate string matches.

Select Search Indexed Data to indicate that the search function should read the Index. This
increases the performance of the search function and will typically result in faster returns on any hits
the search might make.

Select Apply SQL Filters to apply any relevant database or vendor filters to the search.

Choose Declarations, References, or All Occurrences to specify what the search is restricted to in
terms of database objects.

A Declaration is an instance where an object is declared. For example, an object is declared in a
CREATE table.

A Reference is an instance where an object is used or referred to. For example, an object is referred
toin a procedure or as a foreign key in a table.

Choose All Occurrences to return both declarations and references in the search results.

Use the check boxes beside the database object panel to select and deselect the specific database
objects that you want to be included in the search process.

« Click Search.

The results of your search are generated in the Search view. When you open a matched file, references to the
keyword are flagged with yellow arrow icons that appear in the left-hand column of the editor.
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= DELETE FROM Shape Edge Display Ver
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WHERE mt.Name = 'Shape Edge Display' and
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1>)
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= FRON Diagram Object do,

Heta Table mt

o WHERE mt.Name = 'Shape Edge Display' and
do.Heta Table ID = mt.Meta Table ID and
do.Diagram ID = @DelDiagramID)

b

You can navigate between keywords within all returned files using the yellow "up" and "down" arrows that appear
at the top of the Search view.
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Filter database objects

You can place filters on data sources and corresponding data source objects to restrict their display in Data Source
Explorer. This feature is useful if you have data sources that contain large numbers of database objects. You can
apply filters to view only the schema objects you need for the development process.

The following types of data source filters are available:

+ Global filters that affect all registered data sources in the DB Optimizer development environment.

- Data Source specific filters affect only the specified data source for which they are defined.

« On Sybase and SQL Server platforms, you can apply database filters, which enables you to set different
filters on different databases within the same source.

In all of the above cases, data source object filters are defined via the Object Filter Manager, through the
development of filter templates. Once defined, filter templates can be activated and deactivated as you need them.

Several filter templates can be combined at a global level or applied to a specific data source.
See also:

» Define Data Source-Specific Object Filters
+ Define Global Database Object Filters

Define Data Source-Specific Object Filters
Data source-specific object filters affect only the specified data source.
To define data source-specific filters

1. In Data Source Explorer, right-click the data source and select Properties. The Properties dialog appears.

2. Select the SQL Filters node and select Enable data source-specific settings. The other controls on the
dialog become enabled.

3. Click New. The Filter Template dialog appears.

4. Specify the parameters of the filter.

« In the Name field, enter the name of the filter as you want it to appear in the selection window on the SQL
Filter node.

« The Database Type pane provides a list of data source objects. Deselect the data source objects that this
template filters so that they do not appear in Database Explorer when displaying data source objects for the
data source.

+ Click New to add filter parameters for data source object properties. The New SQL Filter Predicate dialog
appears.

« Use the Property and Operator fields to supply the filter criteria. Property specifies whether the value is a
Name or Schema, and Operator specifies the matching type of the filter syntax. (Equals, Not Equals, Like,
Not Like, In, Not In)

« Inthe Value field, enter the full or partial syntax of the property or properties you want to filter in Data
Source Explorer.

« Click OK. The filter property specification is added to the Filter Template.

« When you have finished defining the filter template, click OK. The template name is added to the Properties
dialog. It can be enabled and disabled by selecting or deselecting the check box beside its name,
respectively.
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Define Global Database Object Filters

Global filters affect all registered data sources in the DB Optimizer development environment. When you create and
apply a global filter to a platform vendor in DB Optimizer, all databases associated with that vendor are affected by
the filter, as defined.

Individual global filter templates are separated, by supported data source platform, on tabs in the SQL Filter
window. Select the appropriate tab to view existing filter templates or add new ones, as needed.

To define a global filter

1.

2
3.
4

Select Window > Preferences from the Main Menu. The Preferences dialog appears.

. Expand the SQL Development node and select the SQL Filter subnode. The SQL Filter pane appears.

Click New. The Filter Template dialog appears.

. Specify the parameters of the filter template:

In the Name field, enter the name of the filter as you want it to appear in the selection window on the SQL
Filter node.

The Database Type pane provides a list of data source objects. Deselect the data source objects that this
template filters so that they do not appear in Database Explorer when displaying data source objects for the
data source.

Click New to add filter parameters for data source objects properties. The New SQL Filter Predicate dialog
appears.

Use the Property and Operator fields to supply the filter criteria. Property specifies whether the value is a
Name or Schema, and Operator specifies the matching type of the filter syntax. (Equals, Not Equals, Like,
Not Like, In, Not In)

In the Value field, enter the full or partial syntax of the property or properties you want the template to filter
in data source Explorer.

Click OK. The filter property specification is added to the Filter Template.

When you have finished defining the filter template, click OK. The template name is added to the Properties
dialog. It can be enabled and disabled by selecting or de-selecting the check box beside its name,
respectively.

() Data Source object filters are added and removed from the development environment by selecting
and de-selecting the checkboxes associated with each filter template on both the global and data
source-specific dialogs.
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Drop a database object

To delete an object permanently from a database, right-click the object in Data Source Explorer and choose Drop
from the menu. The Drop Wizard prompts you to confirm removal of the object and provides a DDL preview of the

deletion code.
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Working with SQL projects

You create projects to organize and store SQL development files. The purpose of projects is to keep your work-in-
progress files organized, as well as maintain a common directory structure when developing code and executing
files on registered data sources. Once a file has been developed and is ready for deployment, that file can then be
executed on a registered data source.

SQL Project Explorer is used to view and access files. It uses a tree view to display the project as a series of folder
directories with a folder labeled with the project name as the parent directory, and with project categories, and
associated project files as its children.

B3 pata Source Explor | B 50U Project Explore 52 . — O

50

1 4 Connections

= E"-', Creation Scripts

=17 General S0L
= #3 Inseet

+35 schemabiame. tablenlams (LntHes
£ Unkithed S0L.5q)
* -’_';L SCLProject

L Untitled Tuning Job22.tun
[# untitled Tuning Jobw.tun

All files in an SQL Project project are organized under the following categories:

» Connections. List the connections of any given SQL file of a data source associated with the project.

« Creation Scripts. Provide DDL statements and statements that define database objects.

» General SQL. Provide a category for all other SQL files that are not used in database object creation. This
includes DML files, and so on.

« Large Scripts. Contain all files larger than the currently set SQL Editor preference. The file size limit can be
modified on the Preferences panel by selecting Window > Preferences in the Main Menu.

Physically, the projects and files you create as you work in DB Optimizer are stored under the Workspace directory
you specified at the prompt when DB Optimizer was started. The directory and files can be shared, and other tools
can be used to work on the files, outside the DB Optimizer development environment.

You can move existing files within a project by clicking and dragging the file you want to move in the Project
Explorer from one node to another, or via the File > Move command.

« Create a new SQL project
« Open an existing project
« Search a Project

« Add files to a project

+ Delete a Project
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Create a new SQL project

To create a new SQL project

1. Select File > New > SQL Project from the DB Optimizer Main Menu. The New Project Wizard appears.

2. Enterthe appropriate information in the fields provided:
« Name. Enter the name of the project as you want it to display in the Project Explorer view.

« DBMS Platform. Select the data source platform to which the new project will be associated.
This enables DB Optimizer to properly parse SQL development code for project files.

+ Location. When selected, the Use Default Location check box indicates the project is to be
created under the currently selected Workspace. Deselect the check box and specify a new
folder path if you do not want to create the project in the currently selected Workspace.

3. Click Finish. The new project icon appears in the Project Explorer view under the name that you specified. If
you did not select Use Default Location, the project will appear in the appropriate Workspace when you

openitin DB Optimizer.

() Alternatively, you can select New > SQL Project from the Main Menu or click the New Projecticon in the
Tool Bar to create a new project.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

71


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

Open an existing project

You can open projects by navigating to SQL Project Explorer and expanding the node of the project that contains
the files you want to access.

Below each project name are a series of nodes that categorize any existing SQL files by development type:

Connections. Lists the connections of any given SQL file of a data source associated with the project.
Creation Scripts. General data source object development scripts. This node contains DDL statements and
statements that define database objects.

General SQL. Provides a category for all other SQL files that are not used in database object creation. DML
files, etc.

Large Scripts. Contains all files larger than the currently set SQL Editor preference. The file size limit can be
modified on the Preferences panel. (Choose Window > Preferences in the Main Menu to access the panel.)

Physically, the projects and files you create as you work in DB Optimizer are stored under the project
directory that you specified at the prompt when the project was created. The directory and files can be
shared, and other tools may be used to work on the files, completely exempt from the DB Optimizer
development environment.
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Search a Project

To search an existing project

1. Select Search > File.
2. Specify the search criteria:

Type the value to search in the Containing Text field. Use the * character to indicate wildcard string
values, the ? character to indicate wildcard character values, and the \ character to indicate an
escape character for literals (* ? /).

Select Case Sensitive and indicate to the search function that it should take into account case when
searching for appropriate string matches.

Select Regular Expression to indicate to the search function that the string is a regular function.

In the File Name Pattern field, specify the extension name of the files to search for explicitly.

If the value in this field is a * character, the search function searches all files regardless of extension.
Manually type in the extensions to indicate file type (separate multiple file types with commas), or
click Choose and use the Select Types dialog to select the file extensions the process will search for
the string by.

Select Consider Derived Resources to include derived resources in the search.

Select Workspace or Working Set to choose the scope of the search. If you choose Working Set,
specify the name of the defined working set manually, or click Choose and navigate to the working
set you want to search for in the provided string.

3. Click Search. The results of your search are generated in the Search view on the Workbench.
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Add files to a project

Existing files that reside in directories outside of the workspace can be added to a project via the following
methods:

« Dragging and dropping the file set from a system directory to SQL Project Explorer.
« Copying and pasting the file set from a system directory to SQL Project Explorer.
« Executing the Import command.

To drag/drop or copy/paste files from a system directory to SQL Project Explorer

1.

2.

®

With the SQL Project Explorer view open, navigate to the directory where the files you want to add to the
project are located on the system.

Drag and drop the files you need from Windows Explorer into SQL Project Explorer. The files appear in the
tree view under the appropriate categories.

Alternatively, you can use the Copy command on the files you want to add in Windows Explorer and then
right-click the Project Explorer and select Paste from the menu. The files appear in the tree view under
the appropriate categories.

To use the Import command

Right-click anywhere on the Project Explorer and select Import. The Import dialog appears.
Expand the General node and double-click File System. A dialog containing the import specification
parameters appears.

In the From directory field, manually type the directory location of the files you want to import to Project
Explorer, or click Browse and navigate to the appropriate folder. The panels below the field populate with
the folder selection and a list of suitable files contained in that folder. Use the check boxes beside each
folder and file to specify what folders/files you want the import function to add in Project Explorer.

In the Into folder field, manually type the name of the folder within Project Explorer where you want to
import the files specified in the panels above, or click Browse and navigate to the appropriate folder.
Select the Overwrite existing resources without warning check box if you do not want to be prompted
when the import process overwrites Project Explorer files that contain the same name as the imported files.
Choose Create complete folder structure or Create selected folders only, depending on whether you
want the import process to build the folder structure of the imported directory automatically, or only create
those folders you selected in the panels above, respectively.

Click Finish. The import process moves all selected folders and files into Project Explorer and thus into the

DB Optimizer development environment.

() Inaddition to accessing the Import command via the shortcut menu, you can also access the
Import dialog by choosing File > Import from the Main Menu.
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Delete a Project
You can delete a project by right-clicking its folder in the SQL Project Explorer and selecting Delete.
When you delete a project, DB Optimizer will prompt you with a Confirm Project Delete dialog that asks you to
confirm the deletion of the project, and offers you the option of deleting the project from the DB Optimizer
interface, or deleting the project from the system.

« If you select Do not delete contents, the files and directory structure are removed from SQL Project

Explorer, but they still exist on your machine.
« If you select Also delete contents, the files and directory structure are removed from SQL Project Explorer

and deleted from your machine.
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Creating and editing SQL files (SQL Editor)

The SQL Editor is a Workbench interface component that enables the development, viewing, and formatting of SQL

code.

'E@—Eensnn.sql Y DsqILug.IDg

CREATE TABLE dbo.benson
|
job char(B) HCT NULL,
2al numeric{38,0) NOT NULL,
loc numeric(38,0) NOT NULL,
CONSTRAINT pjob
PRIMARY KEY CLUSTERED (job)
|
go
IF OBJECT ID('dbo.benson') I5 NOT HNULL
PRINT '<<< CREATED TABLE dbo.benson >>>'
ELSE
PRoNT '<<«< FAILED CREATING TABLE dbo.benson >>>'
gao

The Editor supports the following the functionality:

Code assist:
+ Code complete. Type Ahead and Name completion. For more information, see Understanding Code
Assist.
« Code templates. Templates for creation of tables, procedures, etc. For more information, see
Understanding SQL Templates.
« Hyperlinks. For more information, see Understanding Hyperlinks.
« Semantic validation. For more information, see Semantic Validation.
+ Object hovering. Hover over an error found and an explanation of the cause of the error appears.
Code formatter. For more information, see Understanding Code Formatting.
Code correction and transformations. For more information, see Examples of transformations and SQL
query rewrites.
Object indexing. For more information, see Specify Data Source Indexing Preferences.
SQL Project Explorer. For more information, see Working with SQL projects.

SQL Editor contains context-sensitive command menus that are tailored with pertinent functionality for the
specified file format.

If SQL Editor does not recognize a selected file format, DB Optimizer automatically launches the file externally in the
system default application. External editors are not embedded in the Workbench. For example, on most machines,
the default editor for HTML files is the system Web browser. SQL Editor does not, by default, recognize HTML files,
and opening an HTML file from the Workbench launches the file in an instance of the Web browser instead of the
Editor.
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Any number of instances of SQL Editor can be open on the Workbench at the same time. Multiple instances of SQL
Editor displaying different content may be open in the same Workbench. These instances will be stacked by default,
but can also be tiled side-by-side so the content of various files can be viewed simultaneously for comparison or
multi-tasking purposes. When an instance of SQL Editor is active, the Workbench Main Menu automatically contains
commands applicable to the file format. If a view is active, SQL Editor commands are disabled automatically, except
when commands are still valid between the selected view and the file displayed in the interface.

Semantic Validation

When working with code in SQL Editor, the window contains a number of features that provide an increase in the
efficiency and accuracy of code development. The following syntax highlighting changes are automatically applied
to code as a user adds lines in the interface.

Code Formatting
Comments Green font, italics SQL
Commands Dark blue font Coding
Errors Red underline

Strings Red font
Non-Executable Command Line Comma Aqua font

Single-line and multiple-line comments appear in different colors.

Furthermore, SQL Editor provides two column bars, one on either side of the code window. The purple change bar
in the left-hand column indicates that the line of code has been modified. Hover over the change bar to display the
original code text. The red square in the right-hand column indicates that there are errors in the code window.
Hover the mouse over the square to view the error count. Click the red bar in this column to navigate directly to the
line in which the SQL Editor detects the error. SQL Editor automatically highlights the appropriate code. Non-
executable command line commands are displayed in a different formatting style than SQL commands. Syntactic
and semantic errors are also highlighted.

SQL Editor also features dynamic error detection, object lookup and suggestion features, code folding, and auto-
formatting. SQL Editor is able to identify different areas in a statement, and enables users to retrieve subclauses,
resolve table aliases, and dynamically return lists of tables, views, and columns, as needed.

See also Working in SQL Editor.
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Create an SQL file
To create an SQL file

1. Create or open an SQL project.
2. Select File > New > SQL File. A blank instance of SQL Editor appears.

() Ifyouarenotina SQL project when you create a new SQL file, it does not open in SQL Editor.
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Open an existing SQL file
To open an existing SQL file

1. Open the SQL project containing the file, or that you want to contain the file.
2. If necessary, add the file to the project. See Add files to a project.
3. Inthe SQL Project Explorer, double-click the file to open it in SQL Editor.
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Working in SQL Editor

SQL Editor handles SQL code formats and contains context-sensitive command menus, tailored with pertinent
functionality for development purposes. Other files may be opened in DB Optimizer, as well, but these are handled
by other editors.

For example, if a text file is opened in the Workbench, DB Optimizer detects and opens the contents of that filein a
text editor viewer with pertinent commands for that file type.

Any number of instances of SQL Editor can be active on the Workbench at the same time. Multiple instances of SQL
Editor displaying different content may be active on the same Workbench. These instances will be stacked, by
default, but can also be tiled side-by-side, so the content of various files can be view simultaneously for comparison
or multi-tasking purposes. When an instance of SQL Editor is active, the Main Menu contains commands applicable
to the file format. If a view is active, SQL Editor commands are disabled automatically, except when commands are
still valid between the selected view and the file displayed in the interface.

E‘} *Benson.sgl &4

“EREATE TABLE dbo.benson
(

job

=al

%]
,. =)

r{8) NCOT NULL,
weric(38,0) NOT NULL,
loc numeric (38,0} NOT NULL,
CONSTRATINT pjob
PRIMARY KEY CLUSTERED (job)
!

oo
IF OBJECT ID{'dbo.benson') I5 NOT NULL
PRINT '<«<«< CREATED TABLE dbo.benson >>>'
ELSE
PRINT '<<«< FAILED CREATING TABLE dbo.benson >>>'
ga

Among the commands SQL Editor supports via the right-click menu:

+ Revert File. Automatically restores the working file to the original text as it appeared the last time the Save
command was issued.

« Shift Right/Shift Left. Indents the line of code in the working file to the right or left, respectively.

» Toggle Comments. Hides or displays comments in the code of the working file, depending on the current
hide/show state.

« Add Block Comment/Remove Block Comment. A block comment is used to insert a comment into SQL
code that spans multiple lines and begins with a forward slash and asterisk. While block comments are
typically used to insert a command that spans multiple lines, some developers find them more useful than
line comments, especially if a development team is using different text editors on an individual basis.
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Moving code from one text editor to another often breaks line comments in the middle of a line and causes
errors. Block comments can be broken without causing errors.

() Inaddition to editing commands, some commands such as extract, drop, and execute can be
accessed by right-clicking over statements in SQL code that are performed on specific tables,
views, and columns. These commands will appear automatically in the appropriate menu when the
code is highlighted. Full information on using these commands is found elsewhere in this
documentation, based on the task each executable performs.

« Explain Plan. An explain plan details the steps that occurin SELECT, UPDATE, INSERT, and DELETE
statements and is primarily used to determine the execution path followed by the database in its SQL
execution.

See also:

« Understanding Automatic Error Detection
« Understanding Code Assist

« Understanding Hyperlinks

« Understanding Code Formatting

« Understanding Code Folding

« Understanding Code Quality Checks

« Understanding SQL Templates

Understanding Automatic Error Detection

SQL Editor orders and classifies SQL statements. This enables it to edit code as you work within SQL Editor and
highlight errors and typographical errors in "real time." As you work, SQL Editor examines each clausein a
statement and provides error reporting and other features as required.

SQL Editor identifies the following clauses and elements:

« SELECT. Specifies the field, constants, and expressions to display in the query results.

« FROM. Specifies one or more tables containing the data that the query retrieves from.

« WHERE. Specifies join and filter conditions that determine the rows that query returns. Join operationsin a
WHERE clause function in the same manner as JOIN operations in a FROM clause.

« GROUP BY. Specifies one or more columns used to group rows returned by the query.

Columns referenced in the SQL SELECT statement list, except for aggregate expressions, must be included in the
GROUP BY clause. You cannot group by Memo, General or Blob fields.

« HAVING. Specifies conditions that determine the groups included in the query. If the SQL statement does
not contain aggregate functions, you can use the SQL SELECT statement containing a HAVING clause
without the GROUP BY clause.

+ ORDER BY. Specifies one or more items used to sort the final query result set and the order for sorting the
results.

As you develop code in SQL Editor, it automatically detects semantic errors on a line-by-line basis. Whenever an
error is detected, the line is flagged by an icon located in the left-hand column of the editor.
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|5_“} benson [i"} *ADDRESS_ROLE E‘“} *Benson.sgl &5

“'CREATE TABLE dbo.ben=on
i
job CHAR (8) NOT NULL,
sal NUMERIC (38, 0) NOT NULL,
loc NUMERIC (38, 0) NOT NULL,
CONSTRAINT pjob PRIMARY EEY CLUSTERED (job)

gao
IF CBJECT ID('dbo.benscon')y IS5 HOT NULL
PRINT '<<< CREATED TABLE dbo.benson >>>'
ELSE
(] PRoNT '<«« FATLED CREATIMNG TAELE dbo.benson »>»>>!
gao
SSELECT *

| FROM tho.benson:

Additionally, all semantic errors detected in SQL Editor are displayed in the Problems view.

'[3_ Problems &3

3 errors, 0 warnings, 0 infos

Description Resource Path Location
= - Errors (3 items)
€ An unexpected token "< < < FAILED CR. Benson.sql SQL Project 1 line 14
& An unexpected token ™ was found. Ex; File.sql SQL Project 1 line &
&3 Table benson cannot be resolved on 'da Benson.sal SQL Project 1 line 19

Right-click the error and select Go To in order to find the error. DB Optimizer opens and navigates to the specific
line of code containing the specified error.

() Automatic error detection functions, such as syntax checking and semantic validation are suspended if
#define or #include directives are detected in an editor window. DB Optimizer does not perform #define/
#include substitutions on execution.

Understanding Code Assist

When SQL Editor has finished analyzing a partial piece of code, it displays a list of data source objects for you to
select from.
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SQL Editor takes the following into consideration when analyzing code for a list of possible data source objects for
insertion:

+ Text to be inserted

+ Original text to be replaced

+ Content assist request location in original text

« The database object represented by the insertion text

Generally, insertion suggestions use the following format:
<insertion_text > - <qualification_information >

Code assist is available for SELECT, UPDATE, INSERT, and DELETE statements (and MERGE statements on SQL
Server 2008 and above), as well as stored procedures, and functions (built-in and user defined.)

Additionally, code suggestions can be made for DML statements nested within DDL statements. This functions in
the same manner as code assist for statements that are not nestled, and applies to CREATE PROCEDURE,
FUNCTION, TRIGGER, TABLE, and VIEW statements.

When the code assist window is open, you can filter out singular object suggestions by pressing (Ctrl + Spacebar).
This removes all objects from the assist window while retaining procedures and functions. To display objects again,
press (Ctrl + Spacebar) again.

The following table displays a list of all possible object suggestions, and the format in which SQL Editor inserts the
suggestions into a statement:

Object and Stored Procedure Suggestions
Object Suggestion Syntax/Example

Table (TABLE) [catalog].[schema]
EMPLOYEE - (TABLE)HR

Alias Table (TABLE ALIAS)
[catalog].[schema]tableName

EMPLOYEE - (TABLE ALIAS)HRJOBS

Column datatype - (Column)
[catalog].[schema].tableName

JOB_TITLE:varchar(20) - (Column)HRJOBS

Alias Column datatype - (COLUMN ALIAS)
[catalog].[schema].tableName.columnName

JOB_TITLE:int-(COLUMN ALIAS)HR.JOBS.JOB_ID

Schema (SCHEMA) [catalog]
dbo-(SCHEMA)NorthWind
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Object Suggestion Syntax/Example
Catalog (CATALOG)
Call Call HR.ADD_JOB_HISTORY

Function Suggestions

Function Suggestion Syntax/Example

Built-in SELECT A FROM HR.DEPARTMENTS WHERE HR.DEPARTMENTS
AVG

User-Defined SELECT + FROM HR.CLIENTS WHERE HR.F_PERSONAL

() Function suggestions are only available for Oracle and DB2 platforms.
SQL Editor detects incomplete or erroneous code, processes the code fragments, and then attempts to apply the
appropriate logic to populate the code.

As code is typed into SQL Editor, the application ‘reads’ the language and returns suggestions based on full or
partial syntax input.

Depending on the exact nature of the code, the automatic object suggestion feature behaves differently; this
enables SQL Editor to provide reasonable and ‘intelligent’ suggestions on coding.

Additionally, semantic validations can be made for DML statements nestled within DDL statements. This functions
in the same manner as validation for top-level statements, and applies to CREATE PROCEDURE, FUNCTION,
TRIGGER, TABLE, and VIEW statements.

The following chart displays the possible statement fragments that SQL Editor will attempt to suggest/populate
with objects:

Statement Fragment Elements Object Suggestion Behavior

SELECT Alist of tables, when selected automatically, prompts the user
to select a column.

UPDATE and DELETE Alist of tables appears in the FROM and/or WHERE clause.

INSERT A list of tables and views appears in the INSERT INTO and OPEN
BRACKET clause prior to values.

A list of columns based on the table or view name appears in
the OPEN BRACKET or VALUES clause.

In addition to DML statements, SQL Editor also suggests objects based on specific fragmented syntax per line of
code:
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Statement Syntax

A partial DML statement (for example SEL ...

indicates a fragment of the SELECT clause)

Without typing anything.

A period is typed.

To activate code suggestions

IDERA DB Optimizer 18.1.x

Object Suggestion Behavior

The keyword is completed automatically, assuming SQL
Editor can match it. Otherwise, a list of suggested
keywords is displayed.

If the preceding character is a period, and the word prior
is a table or view, a list of columns appears.

If the word being typed is a part of a table name (denoted
by a schema in front of it) the table name is
autocompleted.

If the word being typed has a part of a column name
(denoted by a table in front of it) the column name is
autocompleted.

A list of keywords appears.

If the word prior to the period is a name of a table or
view, a list of columns is displayed.

If the word prior to the period is a schema name, a list of
table names is displayed.

If the word prior to the period is either a table name ora
schema name, then both a list of columns and a list of
table names is displayed

By default, code suggestions are automatically offered if you stop typing in SQL Editor for one second. You can turn
off the automated suggestion feature on the Code Assist preferences page.

If automated code suggestion is disabled, you can still access the suggestion window using the following method:

1. Click the line that you want SQL Editor to suggest an object for.
2. Press (CTRL + Spacebar) on your keyboard. SQL Editor 'reads' the line and presents a list of tables, views or
columns as appropriate based on statement elements.

() Onaperplatform basis, auto-suggestion behavior may vary. (For example, the WITH statement on DB2

platforms.)

To modify object suggestion parameters, including setting it from automatic to manual, see Specify Code Assist

Preferences.

You can speed up the performance of the code assist functionality by enabling data source indexing either when
you connect to the data source, see Working with data sources or on the Preferences page, see Specify Data Source

Indexing Preferences.
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Understanding Hyperlinks

SQL Editor supports hyperlinks that are activated when a user hovers their mouse over a word and presses the CTRL
key. If a hyperlink can be created, it becomes underlined and changes color. When the hyperlink is selected, the
creation script for the hyperlink object is opened in a new editor.

Hyperlinks can be used to link to tables, columns, packages, and other reference objects in development code.
Additionally, hovering over a hyperlink on a procedure or function of a call statement will open it. You can also use
the hyperlink feature on function calls in DML statements.

Clicking a hyperlink performs an action. The text editor provides a default hyperlink capability. It allows a user to
click on a URL (for example, http://www.idera.com) and database object links.

Hyperlink options (look and feel) can be modified via the Hyperlinking subnode in the Editors > Text Editors node
of the Preferences panel.

() Hyperlink functionality relies on certain objects being captured in the Object Index. If the index is turned
off, or has been restricted in what information it captures, users will be unable to link them (as they are
non-existent within the Index.) To specify object index types, see Specify Data Source Indexing
Preferences.

Understanding Code Formatting
Code formatting provides automatic code formatting in SQL Editor while you are developing code.

To access the code formatter, select the open editor you want to format and select Ctrl+Shift+F. The code is
formatted automatically based on formatting parameters specified in the Code Formatter subnode of the SQL
Editor node in the Preferences panel.

You can also format an entire group of files from Project Explorer. To do so, select the directory or file and execute
the Format command via the shortcut menu. The files will be formatted automatically based on your formatting
preferences. See Specify Code Formatter Preferences for more information.

The following examples display a list of code formatting parameters and the resultant output in SQL Editor, based
on the same set of SQL statements.
Custom Code Formatting Example 1

The following chart indicates a list of custom code formatting parameters and their corresponding values. The chart
is followed by the actual syntax as it would appear in SQL Editor, based on the formatting parameter values.

Compare the parameters and formatted code in Example 2 with this example for a concept of how custom
formatting works.

Custom Code Formatting Parameter Value (if applicable)
Stack commas separated by lists? Yes

Stack Lists with __ or more items. 3

Indent Size? 2
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Custom Code Formatting Parameter Value (if applicable)
Preceding commas? Yes
Spaces after comma? 1

Trailing commas? -

Spaces before comma? -

Right align FROM and WHERE clauses with SELECT statement? Yes

Align initial values for FROM and Yes
WHERE clauses with SELECT list?

Place SQL keywords on their own line? No
Indent size? -
Indent batch blocks? Yes
Number of new lines to insert 1
Indent Size 5
Right Margin? 80
Stacked parentheses when they contain multiple items? No

Stacked parentheses when the list contains __ or more items.

Indent size? 5
New line after first parentheses? No
Indent content of conditional and looping constructs? Yes
Number of new lines to insert? 1
Indent size? 5
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(510, File,sql £
Eegin
If ==L
SELECT apple
] . pear

' arange “Big OCrange”
' strawberry
' orchard name
' oWwner
FROM fruit F, orchard O
WHERE fruit_region in ('latin america’
' ‘france”
' ‘russia”
‘' ‘canada”
' ‘hawaii’)
and orchard not in (=select region
from bad growers bg, (Select orchard
from hybrid growers
where us_approved in

Custom Code Formatting Example 2

The following chart indicates a list of custom code formatting parameters and corresponding values. The chart is
followed by the actual syntax as it would appear in SQL Editor based on the formatting parameter values. Compare
the parameters and formatted code in Example 1 with this example for a concept of how custom formatting works.

Custom Code Formatting Parameter Value (if applicable)
Stack commas separated by lists? Yes

Stack Lists with __ or more items. 2

Indent Size? 0

Preceding commas? -

Spaces after comma? Yes
Trailing commas? Yes
Spaces before comma? 2

Right align FROM and WHERE clauses with SELECT statement? No
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Custom Code Formatting Parameter Value (if applicable)

Align initial values for FROM and -
WHERE clauses with SELECT list?

Place SQL keywords on their own line? Yes
Indent size? 4
Indent batch blocks? No
Number of new lines to insert 1
Indent Size 5
Right Margin? 80
Stacked parentheses when they contain multiple items? Yes
Stacked parentheses when the list contains __ or more items. 2
Indent size? 2
New line after first parentheses? Yes

Indent content of conditional and looping constructs? -

Number of new lines to insert? 1
Indent size? 5
B'l=1ile.sql
Begin
If x=S
SELECT
apple ,
pear ,

orange Big Orange' ,
strawberry ,

orchard name |,

owner
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FROM

fruit F ,
orchard 0

WHERE
fruit_region 1in

'latin america' ,

'france' ,
'russia’' ,
'canada' ,

Understanding Code Folding

SQL Editor features code folding that automatically sorts code into an outline-like structure within the editor

window for easy navigation and clarity while developing code.

|

59, *ADDRESS_ROLE #2 . [5 *Benson.sql

CREATE DEFAULT ET FALSE AS O
oo

'th CEJECT ID('PERFCNTR KS5.ET FALSE') IS NOT NULL]]

go

~CREATE TAELE PERFCHTR KS5.ADDRESS ROLE

{

ADDRESS ROLE ID numeric (10,0} IDENTITY (20000,1),

HAME varchar (128) HOT HULL,

DESCRIPTICH varchar (2553) NUOLL,

LIST ORDER int NCT NULL,

IS5 DEFAULT bit HCOT NULL,

IS5 SYSTEM REQUTRED bit HNOT NULL,

ROWTIMESTAMP datetime CONSTRATNT DF ADDRESS R ROWIT 1EF

CONSTEAINT ADDRESSROLEPK
PRIMARY KEY CLUSTERED (ADDRESS ROLE TD)
)
go
EXEC =p bindefault 'PERFCHNTR KS.ET FALSE', 'ADDEESS ROLE.IS DEFAULT'
Jo
EX sp bindrule 'PERFCNTR ES.TRUECRFALSE', 'ADDRESS ROLE.IS DEFAULT'

{{ ! 1] |

- v

The editor window automatically inserts collapsible nodes in the appropriate lines of code for organizational
purposes. This enables you to expand and collapse statements, as needed, while developing code in particularly
large or complicated files.

Understanding Code Quality Checks

Code quality markers provide annotations that prevent and fix common mistakes in the code.

These notes appear in a window on any line of code where the editor detects an error, and are activated by clicking
the light bulb icon in the margin or by pressing Ctrl + L.
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For example, if a statement reads select * from SCOTT.EMP, SCOTT.DEPT, when you click the light bulb icon or press
Ctrl+ 1, a window appears beneath the line of code that suggests Add join criteria.

When you click on a proposed fix, the statement is automatically updated to reflect your change.

The following common errors are detected by the code quality check function in the editor:

Code Quality Check Type

Statement is missing valid JOIN criteria

Definition

If a SELECT statement contains missing join criteria, when it is
executed, it can produce a Cartesian product between the rows
in the referenced tables. This can be problematic because the
statement will return a large number of rows without returning
the proper results.

The code quality check detects missing join criteria between
tables in a statement and suggests join conditions based on
existing foreign keys, indexes, and column name/type
compatibility.

Example:
The following statement is missing a valid JOIN criteria:

SELECT*FROM employeee,customerc,sales_orders
WHERE e.employee_id = c.salesperson_id

The code quality check fixes the above statement by adding an
AND clause:

SELECT*FROM employeee,customerc,sales_orders
WHERE e.employee_id = c.salesperson_id AND s.customer_id =
c.customer_id

() This code quality check is valid for Oracle, DB2, and
Sybase-specific join conditions.
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Code Quality Check Type Definition

Invalid or missing outer join operator When an invalid outer join operator exists in a SELECT
statement, (or the outer join operator is missing altogether), the
statement can return incorrect results.

The code quality check detects invalid or missing join operators
in the code and suggests fixes with regards to using the proper
join operators.

Example:
The following statement is missing an outer join operator:

SELECT * FROM employee e, customer ¢
WHERE e.employee_id=c.salesperson_id(+)ANDc.state=‘CA’

The code quality check fixes the above statement by providing
the missing outer join operator to the statement:

SELECT * FROM employee e,customer c
WHERE e.employee_id = c.salesperson_id(+) AND c.state(+) =
‘CA)

Transitivity issues The performance of statements can sometimes be improved by
adding join criteria, even if a join is fully defined. If this alternate
join criterion is missing in a statement, it can restrict the
selection of an index in Oracle’s optimizer and cause
performance problems.

The code quality check detects possible join conditions by
analyzing the existing conditions in a statement and calculating
the missing, alternative join criteria.

Example:

The following statement contains a transitivity issue with an
index problem:

SELECT * FROM item i, product p, price pr
WHERE i.product_id = p.product_id AND p.product_id =
pr.product_id

The code quality check fixes the above statement with a
transitivity issue by adding the missing join condition:

SELECT * FROM item i, product p, price pr
WHERE i.product_id = p.product_id AND p.product_id =
pr.product_id AND i.product_id = pr.product_id\
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Code Quality Check Type Definition

Nested query in WHERE clause Itis considered bad format to place sub-queries in the WHERE
clause of a statement, and such clauses can typically be
corrected by moving the sub- query to the FROM clause instead,
which preserves the meaning of the statement while providing
more efficient code.

The code quality check fixes the placement of sub-queriesin a
statement, which can affect performance. It detects the
possibility of moving sub- queries from the FROM clause of the
statement.

Example:

The following statement contains a sub-query that contains an
incorrect placement of a WHERE statement:

SELECT*FROM employee
WHERE employee_id=(SELECT MAX(salary) FROM employee)

The code quality check fixes the above statement by correcting
the sub- query issue:

SELECT employee.* FROM employee (SELECT DISTINCT
MAX(salary) coll FROM employee) t1
WHERE employee_id =tl.coll

Wrong place for conditions in a HAVING When utilizing the HAVING clause in a statement:

clause . . . .
Itis recommended to include as few conditions as possible

while utilizing the HAVING clause in a statement. DB Optimizer
detects all conditions in a given HAVING statement and suggests
equivalent expressions that can benefit from existing indexes.

Example:

The following statement contains a HAVING clause that is in the
wrong place:

SELECT col_a, SUM(col_b) FROM table_a GROUP BY col_a
HAVING col_a > 100

The code check fixes the above statement by replacing the
HAVING clause with equivalent expressions:

SELECT col_a, SUM(col_b) FROM table_a
WHERE col_a > 100 GROUP BY col_a
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Code Quality Check Type

Index suppressed by a function or an
arithmetic operator

Mismatched or incompatible column types
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Definition

In a SELECT statement, if an arithmetic operator is used on an
indexed column in the WHERE clause, the operator can suppress
the index and resultin a FULL TABLE SCAN that can hinder
performance.

The code quality check detects these conditions and suggests
equivalent expressions that benefit from existing indexes.

Example:

The following statement includes an indexed column as part of
an arithmetic operator:

SELECT * FROM employee
WHERE 1 =employee_id - 5

The code quality check fixes the above statement by
reconstructing the WHERE clause:

SELECT * FROM employee
WHERE 6 = employee_id

When the data types of join or parameter declaration columns
are mismatched, the optimizer is limited in its ability to consider
all indexes. This can cause a query to be less efficient as the
system might select the wrong index or perform a table scan,
which affects performance.

The code quality check flags mismatched or incompatible
column types and warns that it is not valid code.

Example:

Consider the following statement if Table A contains the column
colint and Table B contains the column col 2 varchar(3):

SELECT *FROM a, b
WHERE a.col =b.col;

In the above scenario, the code quality check flags the ‘a.col =
b.col’ part of the statement and warns that it is not valid code.
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Code Quality Check Type Definition

Null column comparison When comparing a column with NULL, the I=NULL condition
may return a result that is different from the intended
command, because col=NULL will always return a result of false.
Instead, the NULL/IS NOT NULL operators should be used in its
place.

The code quality check flags occurrences of the I=NULL
condition and replaces them with the IS NULL operator.

Example:

The following statement includes an incorrect col = NULL
expression:

SELECT * FROM employee
WHERE manager_id = NULL

The code quality check replaces the incorrect expression with
an IS NULL clause:

SELECT * FROM employee
WHERE manager_id IS NULL

Understanding SQL Templates

DB Optimizer provides code templates for DML and DDL statements that can be applied to the Editor via the (Ctrl +
Spacebar) command. When you choose a template from the menu that appears, SQL Editor automatically inserts a
block of code with placeholder symbols that you can modify to customize the code for your own purposes.

EJ¥ CREATE_TABLE - creates a bable with 3 columns  [CREATE TABLE schemahiame. tablefame

i} CREATE_TABLE - creates and populates atablewl (o dataTypel PRIMARY KEY,
£} CREATE_TRIGGER - creates a database trigger columniame? dataType? ,
columnhame3 dataTyped

~-define other columns

%

Code templates are available for DML, ALTER, DROP, CREATE, and platform specific commands.

A comprehensive set of DDL/DML templates are available, with statement alternatives varying by DBMS and specific
DBMS versions. You can modify and create new templates via the SQL Templates panel on the Preferences dialog.
See for more information on how to create and alter SQL code templates.
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View change history

Each time an SQL file is saved, the local history of that file is recorded (changes made). Using the Local History
command, you can view all changes made to the file. Local History is accessed via the shortcut menu of SQL Editor
and selecting Compare With > Local History.

=
Benson.sgl ( test.sqgl I/ED Compare Benson.sgl Current and Current Revision &3 =
Text Compare ERe A ik AEE T
Local: Benson.sgl
k:REELTE TABLE dbo.ben=son CREATE TABLE dbo.ben=on
i |
iob char (8) HOT NULL job char(8) NOT 1
=z=al numeric(38,0) HOT HULL zal numeric({38,0) NOT ]
loc numeric (38,0} HOT NULL loc numeric(38,0) NOT ]
CONSTRAINT pick CONSTRAINT pijob
PRIMARY EEY CLUSTERED (job PRIMARY EEY CLUSTEERED
) )
go go
IF OBJECT ID|('dbo.benson') IS IF CBJECT ID('dbo.benson')
PRINT '«<<« CREATED TABLE d PRINT '<<«< CREATED TAB
ELSE ELSE
PRoNT '«<<« FAILED CREATING PRoNT '<«<< FAILED CRER]
go ga
(] i | ] (%] i | ]
B o ol
SQL Log FEEL SQL Erro (& Problem FE; Tasks (EH] Bookmar E: Cutline (@ History &3 = O
: = ) = [2H
Benson.sgl -:éh <~}==E> | 2 ﬂg = |E_|
Revision Time
E 05/02/08 11:45 AM
E 04/02/08 11:43 AM
[il 1M | [ﬂ
« The History view displays all recorded times the file was changed since its inception/introduction into the
workspace.

« Double-click a time in the History view to access the Text Compare panel. It displays the text of the file after
the change occurred at the time indicated in the History view.
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Revert to an old version of a file

IDERA DB Optimizer 18.1.x

The Replace With > Local History command provides you with the ability to revert a SQL file back to a previously

recorded local history.

To replace the contents of a file with the contents of a previously saved version via local history

1. Right-click the SQL Editor and select Replace With > Local History from the shortcut menu.

The Replace from Local History dialog appears.

54 Warkspace Fie
CONSTRAINT pjcb
PRIMARY KEY CLUSTERED (job)
)
go
IF QBJECT_ID("deo.kBensan') IS WOT WUL
PRINT ‘*<<< CREATED TABLE dbo.bena
ELSE

£ Compare - (Q;
f5QL Project 1/Benson.gql el B
Revigion Time
£ 04/02/08 11:43 AM
£ B
63 Text Compare it WLE NN

B Local Hstory (04/02/08 11:43 AM)
COMSTRAINT pjck )
PRIMARY KEY CLUSTERED (3job)

}

go :

IF QBJECT_ID|('dbo.bensea") IS NOT
PRINT '<<< CREATED TABLE gdko.

| PRONT "<<< FAILED CREATING TABLE [—

go

<] ! |

ELSE 4
PRINT '"<<< FAILED CREATING TA
oo O
-
[£] >

[ Replacs ” Cancel I

2. Inthe Local History of ... panel, select a previously recorded version of the file by clicking the appropriate

timestamp.
3. Click Replace.

The contents of the currently-opened file revert to the contents of the file at the history point you selected in the

dialog.

Alternatively, from the shortcut menu, select Replace With > Previous from Local History to replace the contents

of the file with DB Optimizer's last recorded history point.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

97


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

Delete an SQL file
To delete an SQL file

1. Right-clickitsicon in the SQL Project Explorer.
2. Select Delete. This action removes the file from both the SQL project and the file system.
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Executing SQL files

DB Optimizer can execute SQL code directly on registered data sources. Files are executed via the Execute SQL
command in the Run menu, or by clicking the green arrow button on the toolbar.

When an SQL file is open in the Workspace, select it and choose a database and an associated catalog on which you
want to execute the file via the lists in the Toolbar. You can click the execute icon to execute code on the specified
database and catalog, start a transaction or commit a transaction, or modify SQL session options prior to
execution.

To execute a file

Open the SQL file you want to run, ensure it is associated with the correct database, and click Execute. DB
Optimizer executes the code on the data source you specified. Results are displayed in the Results view and can be
exported into a file via the Data Export wizard, or displayed in multiple file formats (HTML, XML, and TXT formats).

To execute a transaction

1. Ensure that the auto commit feature is turned off. See Specify SQL Execution preferences for more
information on how to turn off auto commit.

2. Open the transaction file you want to run.

3. Ensure that file is associated with the correct database, and then click Start Transaction.
DB Optimizer executes the transaction on the data source you specified. Once the transaction runs, you can
execute the file as normal.

() Click Commit or Rollback to finish or cancel a transaction.

To commit a transaction

1. Open the transaction file you want to commit.
2. Ensure that file is associated with the correct database, and then click Commit Transaction.
DB Optimizer commits the transaction on the data source you specified.

() Youcan set transactions to auto-commit prior to execution on the SQL Execution node of
the Preferences panel.

See Also:

« Associate an SQL file with a data source
« Configure an SQL session

« Execute SQL code

« View and save results
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Associate an SQL file with a data source

When working with files, SQL Editor enables developers to view and change the data source to which they are
connected.

The bread crumb line in SQL Editor is used to display and specify a data source in relation to the specified SQL
Editor file. The menu contains a list of all registered data sources. Additionally, on platforms that support catalogs,
these are displayed as well.

(5% HLintithed SOL 5 £ B
b il Microsoft SOL Server b S ROMLABSOLO0S 1 (9.0.3054.0) » [ master B .4

select * from dbo.Customers:

Changing a catalog via the drop down lists is the equivalent of issuing a USE DATABASE command on SQL Server,
Sybase, and MySQL platforms. Any change will not affect the current connection, and the list automatically updates
to display the name of the newly selected data source.

If no registered database is associated with a SQL file (as would be the case if a user started a new, unsaved file), the
list is empty. This indicates that the file is not connected to a registered data source.

To change or associate a registered data source with a SQL file

1. Click the database list.
2. Select the name of a registered database from the list provided. Depending on the state of the code in SQL
Editor, DB Optimizer's behavior differs when the connection is made.

() Ifyou are receiving multiple syntax errors, always check that the file is associated with the correct data
source and corresponding database/catalog before troubleshooting further.
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Configure an SQL session

IDERA DB Optimizer 18.1.x

The SQL Session Options dialog provides configuration parameters that indicate to DB Optimizer how to execute

code in the development environment.

-

& SQL Session Options

- 1o/

SQL Session Options

Specify the SQL session options for the current editor,

v

Property
[=| Ansi Defaults
Set ansi_nulls
Set ansi_padding
Set quoted_jdentifier
Set ansi_warnings
Set ansi_null_dfit_on
[=] Arithmetic
Ignore Arithmetic Overflow
Abort On Arithmetic Overflow
[=|Transactions
Isolation Level
Set implicit_transactions
Set cursor_close_on_commit
[=|Result Set
Maximum Fows in Result Set
Maximum Mumber of Bytes in a ...
Query Timeaout {seconds)

Value

false
false
frue
false
false

false
false

Read Committed
false
false

]
2043
]

Finish

] [ Cancel

To modify SQL session options

1. Click the SQL Session Options icon in the Toolbar. The SQL Session Options dialog appears.
2. Click on individual parameters in the Value column to change the configuration of each property, as

specified.

3. Click Finish. The session options will be changed and DB Optimizer will execute the code as specified when

you execute it.

Session options only apply to the corresponding editor and are not retained when executing multiple SQL files.
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Execute SQL code

Files can be launched from within the DB Optimizer development environment for execution on a registered data
source Files are executed via the commands in the Run menu.

When a SQL file is open in the Workspace, select it and choose a database and an associated catalog on which you
want to execute file using the drop down menus in the Toolbar. You can click the execute icon to execute the code
on the specified database and catalog, start a transaction or commit a transaction, or modify the SQL session
options prior to execution.

To execute code

1. Open the SQL file you want to run.

2. Ensureitis associated with the correct database.

3. Click the Execute icon. DB Optimizer executes the code on the data source you specified. Results are
displayed in the same tab or in a new tab.

To execute a transaction

1. Open the transaction file you want to run.
2. Ensureitis associated with the correct database.
3. Click the Start Transaction icon. DB Optimizer executes the transaction on the data source you specified.

To commit a transaction

1. Open the transaction file you want to commit.
2. Ensureitis associated with the correct database.
3. Click the Commit Transaction icon. DB Optimizer commits the transaction on the data source you specified.

() You can set transactions to auto-commit prior to execution on the SQL Execution node of the Preferences
panelin DB Optimizer.
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View and save results

IDERA DB Optimizer 18.1.x

Once you execute a file, the results are displayed in the Results view. Here, you can examine the outcome of the

execution process, as well as save the results in other file formats, as needed.

You can view results in the following formats:

« HTML
« XML
o TXT

To save results

1. Right-click on the Results view and select Save Data. The Save Data dialog appears.

*T Save Data

Save data to a file
Save data ko a specified file type,

Enter or seleck the parent Folder:

MyProject

=,

@ % MyProject

File name: [ result

File type: |Delimited text files (*.csv, *.ppe, *.tab, *.txt)

Delimited bext files (*, csv
Exccel Files (*,xls)
2L Files (.ol
HTML Files (*. Kl

Include
Field delimi

@ |_Einish H Cancel

2. Select the project name to which you want to save the results, enter a file name, choose the file parameters,
and then choose a file format from the drop down menu. You can select delimited text file, Excel, XML, or

HTML file formats.

3. Click Finish. The results are saved in the directory location and format that you specified.
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Troubleshooting

DB Optimizer contains a number of views used exclusively to log and monitor the SQL development process.

« The SQL Log captures all SQL commands executed by SQL Editor and the system. SQL Log entries are listed

by SQL Statement name, Date issued, Host/Server, Service, User, Source, and the Time (in milliseconds) it
took to execute the command.

il sQLLog 32 . %' SQLEmars | (5 Problems | v Tasks| [l Bookmarks | 5 cutiine | (=) History =0
S8 Bk RET
SQL Statement Date Host/Server DEMS
+ € ALTER TABLE dbo.testapps  ADD COMSTRAINT 0X_123  CHECk 2008-02-04 11:06:12.656  datotbid SQLServer
# @ CREATE TASLE dbo.benson ( jobchar(d) NOTNULL, salne 2008-02-04 11:05:53.00  datoth19 SQLServer ¢
| IF OBIECT_ID(dbo.benson’) IS MOT NULL  PRINT '<<< CREATEL 2008-02-04 11:06:53.171  datoth19 S0LServer ¢
£ | m

> |

+ The SQL Errors log automatically logs all SQL errors encountered when SQL commands are executed

through DB Optimizer. Errors are listed by Error Code, SQL State, error Details, Resource, and the Location of
the errorin the SQL file..

[ [s¥1) SQL Log | 3 sQUEmors 53 . [2. Problems | &) Tasks | Ll Bookmarks | g Qutine | ! Hstory

= .
Error Code 5QL State Detais Resource Lacaton
170 37000 Line 4: Incorrect syntax near PRONT. Benson,sal ine 13
170 37000 Line 8: Incorrect syntax near sdasd’. Berson.sgl ine 8

» The Problems view captures syntactic and semantic errors and warnings in the files of the workspace. These
entries typically take the form of error messages or warnings issued by the system over the course of a
procedure execution. Problems are organized by Description (which indicates the type of problem logged),
Resource, file Path, and Location. Using the Problems view, you can apply quick fixes to issues that DB
Optimizer detects, as well as locate other problems that have similar attributes.

=] 501 Log | 42 sQu Errors [ Problems 53 . & Tasks Ul sockmarks OF Qutine| I History ¥ =0
0 errors, 0 warnings, 0infos
Descripbion = Resource Path Location

See Also
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+ View log details

+ Maintain logs

+ Filter logs

» Import and export error logs
« Find and fix SQL code errors
« Find and fix other problems
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View log details

The SQL Error Log and Problems views contain functionality that enable you to view details regarding individual log
entries, and in some cases, locate or fix those issues automatically.

To view details about SQL Errors entries

Right-click the error whose details you want to view, and then select SQL Error Details.

-,

&1 SQL Error Details

@ Line 4: Incorrect syntax near 'PRoNT',

Reason:
Batch: 2

Line: 12

Position: 0

Error Code: 170
S0L State: 37000

Details: Line 4: Incorrect syntax near 'PRaNT',

The SQL Error Details dialog provides information about the specified SQL error. Additionally, you can double-click
the error to view the problem code in SQL Editor.

To view details about Problems

Right-click the entry whose details you want to view, and then select Properties. The Properties dialog appears,
summarizing the issue.
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Maintain logs

The SQL Log and SQL Errors views both contain commands that enable you to save, restore, or otherwise move log
entries into files outside of DB Optimizer. Additionally, both views also contain commands that enable the clearing
of the view.

The current editor option displays user statements only as generated by the active editor.
To maintain log entries

All entries automatically captured by the Error Log are written to a file (.log suffix) that resides in the
Workspace .metadata folder.

To remove all messages
Right-click in the SQL Log view and select Clear Log Viewer.
To delete the .log file

In the shortcut menu, select Delete Log. If entries are created after the Delete Log command is issued, DB Optimizer
automatically generates a new .log file in the .metadata subfolder.

() You cannot recover old error log entries once you delete the .log file. To prevent data loss, archive the .log
file via the Export command prior to deletion.
To clear the Error Log view without deleting the .log file

Select Clear Log Viewer from the shortcut menu. The View is cleared of entries, but these entries still exist in
the .log file.

To restore the Error Low view based on the entries in the .log file

Select Restore Log from the shortcut menu. The View is restored based on the entries in the .log file.
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Filter logs

You can apply filters to Problems, SQL Log, and the SQL Errors views to limit searches when troubleshooting and
pinpointing specific processes within the system.

To filter the SQL Log

1. Onthe SQL Log view, select the Toolbar Menuicon ™ (the downward-pointing arrow in the right-hand
corner of the view), and then choose Filters. The SQL Log Filters dialog appears.

=y

&4 SOL Log Filters

S0L statement types
Successul

Failed

Limit display statements to: | 100

<

[ ] Show statements with host:

Filter by source

User

[ By current editor
[ System generated
Unavailable source

Ik, l [ Cancel

2. Inthe SQL Statement Types frame, select Successful or Failed to filter by the type of Error Log entries.

3. Select Limit display statements to indicate a maximum limit of the number of entries displayed in the Error
Log, and enter the maximum entry value in the corresponding field.

4. Select Show statements with host to indicate that only entries from a specific data source are to be
displayed, then type the name of the data source (as it appears in the Database Explorer) in the

corresponding field.
5. Inthe Filter by Source pane, specify User, System Generated, or Unavailable Source to filter statements

by the type of source from where they originated.

To view and filter the Problems log

1. Onthe Main Toolbar, click Window > Show View > Other > General > Problems.

2. On the Problems view, select the optionsicon =" , and then choose Configure Contents. The Configure
Contents dialog appears.
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& Configure Contents

Configurations:

all Errors

Warnings on Selection
[] Ervors/Warnings on Selec
[] Ervorsiwarnings on Proje

< >

(") Match all configurations
(%) Match any configuration

~ Scope
(%) On any element
(O on any element in same project
() Cn selected element anly
O On selected element and its children
O onworking set: Window \Warking Set

* Description

o
Text: |contains bl

where severity is: [¥]Error [Jwarning []Info

~ Types
[ [ EMF Problem
| -—Select All
rablem
SOL Error Matker Dieselect Al
Transformation Marker

’ K ] ’ Cancel

]

IDERA DB Optimizer 18.1.x

The Configure Contents dialog enables you to create multiple filter profiles that you can apply to the log by
clicking the options icon [ ], clicking Show, and then choosing the filter to apply. The Configurations panel on
the left-hand side of the dialog displays all existing filter profiles stored in the Workspace. Selecting a
configuration displays its filter parameters, and selecting the check box associated with its name enables
the filter in the Problems view (only problems that match the criteria defined in the Filters dialog will appear

in the view).

The ability to define different profiles enables the selection of multiple filter profiles. For each profile selected, the
profile criterion is applied to the View, concurrently. You can filter problems by:

« Working Set

« Character String
+ Problem Severity
+ Problem Type

« A combination of the above four filter options
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Profile Criteria Description

Working Set The options located in the Scope area of the dialog enable you to filter
problems based on defined Working Sets. A Working Set is a collection of
user-defined Project files that you can organize, as needed, in DB
Optimizer. Select an option, and then click Select to define a Working Set
to which the parameters apply. If no Working Sets exist, you need to define
one or more via the New button on the Select Working Set dialog.

Select one or more Working Sets to which you want the criteria to apply. If
no Working Sets exist, or none suitably match the current filter criteria,
click New or Edit to define a new Working Set, or edit an exist Working Set,
respectively.

Character String Use the Description list to select contains or doesn't contain, as needed,
and type the character string in the field below the list. The Problems view
is filtered to only contain, or omit, problem descriptions that fully or
partially match the string value.

Problem Severity In the Where severity is area, choose Error, Warning, Info or some
combination of the three check boxes. Only entries whose severity
matches the check boxes you have selected remain visible in the Problems
view.

Problem Type The options in the Types list on the right-hand side of the dialog enable
you to filter problems by type. For example, deselect Problem to remove
any system entries from the view, or deselect SQL Error Marker to remove
any SQL code entries from the view.

Once you have defined and/or selected the appropriate filter profiles, the profiles will appear in the Show submenu
in the Toolbar Menu of the Problems view. Select or deselect the profiles from the submenu, as needed.
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Import and export error logs

Error messages are written to a file named .log located in the Workspace directory .metadata folder. This file can
(and should) be cleared periodically via the Delete Log command to prevent performance issues with regards to
system memory and file size. However, the Export command enables you to archive log files prior to deletion. The
files created by the Export command can then be imported back into the Error Log as needed at a later point in
time.

To export the SQL Log

Right-click the SQL Log view, and then choose Export Log. The log is saved in the specified directory path with
a.log extension.

To import the Error Log

Right-click the SQL Log view, and then choose Import Log. Select the previously exported .log file. The Error Log
view is restored with the entries from the specified export file.
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Find and fix SQL code errors

The SQL Errors view contains an option that enables you to navigate directly to the resource associated with an
error entry.

f Benson.sgl E@\ sgllog.log ]

CONSTRAINT pjob
PRIMARY KEY CLUSTERED (job)

)
go
IF OBJECT ID{'dbo.benson') IS5 NHOT NULL
PRINT '<<< CREATED TABLE dbo.benson >>>'
ELSE
b PRoNT '<<< FATLED CREATING TABLE dbo.benson >>>'
a

To navigate to the source of a SQL error entry

Right-click the entry to which you want to navigate, and then select Go To. The file to which the error applies
automatically opens in a new instance of SQL Editor, and the line is highlighted in the window.
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Find and fix other problems

By default, the Problems view organizes problems by severity. You can also group problems by type, or leave them
ungrouped.

The first column of the Problems view displays an icon that denotes the type of line item, the category, and the
description. Click the problem and DB Optimizer will open the SQL file and automatically highlight the line that
triggered the issue.

You can filter Problems to view only warnings and errors associated with a particular resource or group of
resources. You can add multiple filters to the view, as well as enable/disable them as required. Filters are additive,
so any problem that satisfies at least one of the filters will appear.

Problems can sometimes be fixed via the Quick Fix command in the shortcut menu. The Quick Fix dialog enables
you to apply a fix to a problem detected by the view. The dialog also provides a list of similar problems to the one
you selected, and enables you to apply a fix to multiple problems at the same time.

[ &1 Ouick Fix X

Select a fix

Sebect he Fix For “Using the TRUNCE
furection suppresses index usage". =

Select & fix:

: 'Replace TRUNCE) Function with equivalent conditions

5, 33 warnings, 0 nfos

mplion & Resource
& Using the CONVERT() Function suppresses index usage  Sybase.sql
& Using the LENC) Function suppresses index usage Svbase,sql
) Using the LEM() function suppresses index usage Sybase.sql
& Using the LEM() Function supprésses index usage Sybase., sql :
& Using the ROUND{) Function suppresses index usage Svbase.sql
i Using the ROUND() function suppresses index usage  Sybasesql || | Pesource Location [
# Lising the SUBSTRING() function suppresses index usage Sybase.sgl | & DB2.sgl line 151
 Using the SUBSTRING() function suppresses index usage Sybase.sql | & Sybasesgl  fne 181 Pesclect A8
{# Using the SUBSTRING() function suppresses index usage Syhase. sql & sybase.sgl  line 185 :]
@ Using the TRUNC() function suppresses index usage  DB2.sql o Sybase.sgl  line 187
& Using the TRUNC( function suppresses inde:x ussge DEzZ.5q] {8 DE2. 5qf line S0
) Using the TRUNC() function suppresses index usage  DB2.sql i Dez2.sql fne 103
1) Lsing the TRUNC() function suppresses index ussge DB2.50] & DE2.5q) line 146 =
i Using the TRUNC() function suppresses index usage MyFile.sg || LT R et ot a0
8 Usineg the TRUNCO Funchion suppresses inde: ussge MyFile.sql & [ ok | [ Cancel

To apply a quick fix to an issue in the Problem view

1. Right-click on a problem in the list, and then select Quick Fix from the menu. The Quick Fix dialog appears.
2. Select a fix from the list provided, and then click OK. DB Optimizer attempts to resolve the issue.

To find similar issues

1. Inthe Quick Fix dialog, click Find Similar Problems. The Problems list populates with all of the issues that
are similar to your initial selection.
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2. Use the check boxes beside the problems to select them, and then choose a fix and click OK. DB Optimizer
attempts to resolve all of the specified issues.
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Using profiling
For details on working with profiling, see the following topics:

« Understanding profiling

« Understanding the interface
» Running a profiling session
«» Configuring profiling
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Understanding profiling

Profiling continuously samples the data source to build a statistical model of the load on the database. Profiling can
be used to locate and diagnose problematic SQL code and event-based bottlenecks. Additionally, profiling enables
you to investigate execution and wait time event details for individual stored routines. Results are presented in the
SQL Profiling Editor, which enables users to identify problem areas and subsequently drill down to individual,
problematic SQL statements.

() DB Optimizer supports the Oracle Real Application Cluster (RAC). When you want to profile a RAC you can
profile the entire cluster in one profiling session. For more information, see Building profiling
configurations.

Profiling filters out well performing, light weight SQL and collects information on heavy weight SQL. SQL that is
heavy weight is either long running queries or queries that are short but run so often that they put load on the
database

Profiler takes snapshots of user and session activity once a second and builds up a statistical model of the load on
the database. The sampled data is displayed in three ways:

+ Load on the database measured in average number of sessions active
« Top Activity - Top SQL, Event, and Sessions, Object I/O, and Procedures
« Details - Detail on a SQL statement, Session, Event, Object I/O or Procedure

The graph on the top of the screen shows the load on the database and can quickly indicate visually how the
database is functioning. The database could be

« Idle

+ Lightly loaded
« Heavily loaded
« Bottlenecked

Problems can come from any one or more of four areas

+ Machine CPU or Engine, slow disks (network)
+ Application locks, invalid SQL

«+ Database cache sizes, log files, etc

« Inefficient SQL

Details of profiling sessions can be saved to an .oar file, which you can access through the SQL Project Explorer, or if
you are profiling to an Oracle 9i, 10g, or 11g data source, you can see the profiling sessions in the Profiling
Repository node of the data source in the Data Source Explorer, or in the Profiling Repositories node. Profiling direct
to a repository means the session details are sent directly to the hard disk of the data source. If you have enough
free disk space, you can collect data for a longer time than if you were profiling to a file which accumulates in
memory until you save the session to disk.
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Understanding the interface

The profiling interface is divided into three major parts: Load graph, Top Activity, and Profiling Details view.
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+ The Load Graph is located on the top section of the editor and provides a display of the overall load on the
system. The bars represent individual aspects of the enterprise, and the view can be used to find
bottlenecks.

« Top Activity is located on the middle section of the editor and displays where the load originates.
Specifically, the top SQL statements, top events that the database spends time in, as well as the top activity
sessions.

« The Profiling Details View is located on the bottom section of the editor and displays detailed information
on any item selected in the middle section. For example, an SQL statement, an Event, or a Session.

The graphical portion of the profiling editor presents the distribution of sessions executed over the length of the
profiling process, and those that were waiting in DBMS-specific events. It provides a first and most important step in
identifying problem areas. Results can be viewed in real-time.

The Load Graph and Top Activity Section compose one view in the editor, while the Profiling Details view is a
separate interface component that only activates when an item in the Top Activity Section is specified.
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() Usea 1280 x 1024 monitor resolution when viewing profiling information. Smaller resolution sizes can
obscure details in the view.
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Running a profiling session

Profiling provides the continuous monitoring of a data source and builds a statistical model based of database load
based on the user's state every second. The created profile can then be saved to file, and the data can be saved,
analyzed, and optimized by importing statements into the tuning component and running a tuning job.

The following list provides the general workflow and overhead tasks, when attempting to monitor data sources and
store query information.

1. Execute a profiling session
2. Work with Session Results
3. Creating profiling reports

4. Saving profiling sessions

5. Import statements to tuning

In addition to the workflow tasks outlined above, the profiling interface also enables a number of important
functions to help in statement analysis and diagnosis. This additional, or extra, functionality can be found in Other
profiling commands.

Furthermore, in some cases you will need to configure system variables and parameters in order to get the results
you need from the application. See Configuring DBMS properties and permissions for more information on how to
configure profiling and your registered data sources prior to running a session.
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Execute a profiling session

Profiling is monitored and managed via profiling's three major interface components: the Load Chart, Top Activity
Section, and Profiling Details view.
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To execute a profiling session

1. In Data Source Explorer, right click on the data source you want to profile and select Profile As from the

menu, and then choose Data Source 1.
2. Inthe Profile Configurations dialog, select the configuration to use for this profiling session. If you haven’t
already created a profile, see Building profiling configurations for a description of the profiling configuration

options you can choose.
The profiling session begins. Alternatively, clicking the Profiling icon on the Toolbar automatically runs a

profiling session for the last data source you selected.
Once a profiling session launches, it runs until you stop it. When a session has run for a length of time, you
can then interpret and analyze the results. See Working with session results.

To stop a profiling session

You can stop a profiling session at any time by clicking the Stop button [ ] in the upper left-hand side of the
Profile Session screen of by clicking the Stop button in the Progress Window.

Executing a session from the Command Line

() Thisis not supported when using DB Optimizer InstantOn.
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You can launch a profiling session from the command line using the following syntax:
dboptimizer.exe profile ds:ROMxL*ABORCL10G_1 duration:20 tofile:c:\testprofile.oar

In the above command, the user has specified ROMxLxABORCL10G_1 as the data source, and indicates a profiling
session of 20 minutes. The tof1ile variable specifies the directory and name of the file to which the profiling
session will be saved.
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Working with session results

Results are displayed in the Profiling Session editor whenever a profiling session is executed. Results can appear in
real time (if real time profiling is enabled) or once a session as finished its execution.

Results are displayed in the three major interface components of the editor, which you can use to analyze the
overall efficiency and capacity of queries running on the data source, to various levels of detail:

The Profiling Ul has three correlated sections:

«+ Selection in Chart fills the top activity section data, distributed in Overview/SQL/Events/ Sessions/Object I/
0.
+ Selection in any tab of Top Activity fills the Profiling Details with top selection type related data.

For more information, see:

» Opening an existing profiling session
« Filtering results

+ Analyze the load chart

+ Analyze the Top Activity section

+ Analyze profiling details
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Opening an existing profiling session

Saved profiling session data is stored in either an SQL Project or in a Profiling Repository on an Oracle data source.
You can find profiling sessions saved as .oar files in the SQL Project Explorer. You can find profiling sessions saved to
a profiling repository in the Data Source Explorer, either in the Profiling Repository node of the data source or in the
Profiling Repositories.

To view a saved profiling session, locate it in either the SQL Project Explorer or in the Data Source Explorer and
double-click the icon to open it in the Profiling Session window.
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Filtering results

You can display filtered subsets of the original profiling results set for each section of profiling based on DBMS
platform type:

- IBM DB/2 for Windows, UNIX, and Linux: Application, Creator ID, Cursor Name, Package Name, Statement

Type, and User Name.
« Microsoft SQL Server: Application, Command, Database, Hostname, NT domain, Net Address, and User

Name.
+ Oracle: Processes (Background or User), Action, Application, Hostname, Module, Schema Name, and User

Name. When profiling a RAC, there is also an instance filter that appears to let you limit the profiling results

shown to a specific instance.
« Sybase: Application, Database, Host, IP Address, KPSID, SPID, and User Name.

You filter results using the filter controls in the upper, right-hand part of the profiling editor.

Processes: |User % | Filter by: |Hostname % | TORLABSCORCL % | t:ﬁh E I:EI

-Mane-
Action F
] Soplication q
in B Configuration @ Commit B Metwo|madule ¢ M Concurrency O Scheduler

Schema Mame
User Name

To filter profile editor results

1. Use the Filter by menu to select a filter type. The second menu becomes active based on your selection in

the first menu.
2. Use the second menu to specify a value.

3. Click Refresh ( i ) to update the profiling details.
The profiling editor is updated to show only results associated with your choice.

() Select-None- from the Filter by list to restore the unfiltered results.
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Analyze the load chart

The Load Chart is located on the top section of the Profile Session editor and provides a display of the overall load
on the system. The bars represent individual aspects of the enterprise, and the view is used to discover bottlenecks.
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The most important part of the previous screenshot is the Average Active Sessions (AAS) graph. AAS shows the
performance of the database measured in the single powerful unified metric AAS. AAS easily and quickly shows any
performance bottlenecks on the database when compared to the Max Engines (for Sybase) or Max CPU (for Oracle)
line. The Max Engines line is a yardstick for performance on the database. When AAS is larger than the Max CPU line,
there is a bottleneck on the database. Bottleneck identification is that easy.

AAS or the average number or sessions active, shows how many sessions are active on average (over a 5 second
range in DB Optimizer) and what the breakdown of their activity was. If all the users were running on CPU then the
AAS bar is all green. If some users were running on CPU and some were doing I/O, represented by blue, then the AAS
bar will be partly green and partly blue.

The line Max Engines or Max CPU represents the number of CPU processors on the machine. If we have one CPU/
Engine then only one user can be running on the CPU/Engine at a time. If we have two CPUs/Engines then only two
users can be on CPU at any instant in time. Of course users can go on and off the CPU/Engine extremely rapidly.
When we talk about sessions on the Engines we are talking about the average number of sessions on CPU/Engine. A
load of one session on the Engine thus would be an average which could represent one uses who is consistently on
the CPU/Engine or many users who are on the CPU for short time slices. When the number of Engines becomes a
resource bottleneck on the database we will the average active sessions in CPU/Engine state go over the Max
Engine/Max CPU line. The number of sessions above the Max Engine line is the average number of sessions waiting
for CPU/Engine.

The Max CPU is a yardstick for performance on the database. The number of CPUs or Engine on the data source is
information DB Optimizer obtains during the profiling process. However, sometimes the number of CPUs or Engines
is not reported. In these cases, it might be desirable to change the default number of CPUs/Engines from one to a
number more closely matching the actual system running the data source. You might also want to change the Max
CPU/Engine line to reflect the performance impact of adding or removing a CPU or Engine from the system.

To change the Max CPU or Max Engine count in the Load Graph

1. From the Profile Session window, right-click anywhere on the AAS graph and select Edit Engine Count or
Edit CPU Count.

2. Inthe EngineCount dialog that appears select Useacustomvalue, enter a new value, and then click OK.
The AAS or Load Chart MaxCPU or MaxEngine line is updated immediately to reflect the change.

The Load Chart is designed as a high level entry point to profile session results. Subsequently, you can use the Top
Activity and Profiling Details views to examine more detailed information on waiting and executing sessions over
the length of the session. Alternatively, you can select one or more bars on the graph to populate the Top Activity
section (and subsequently, the Details View) with information on a specific subset of the graph.

The Load Chart displays the distribution of waiting and executing sessions over the length of a profiling session.
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+ Timeis displayed on the X axis. You can zoom in and zoom out on the graph via the icons in the upper right
hand corner of the graph, once a profiling session is stopped.

+ TheY axis shows the average number of sessions waiting or executing. Each supported platform has a
specific set of wait event times.

DBMS Wait Event Category
IBM DB2 Fetch, Cursor, Execution, Operation, Transaction, Connectivity, Lock, Other
Oracle On CPU, System /0, User I/0, Cluster, Application, Configuration, Commit, Other

SQL Server CPU, Lock, Memory, Buffer, /0, Other

Sybase CPU, Lock, Memory, I/O, Network, Other

* A chart legend displays a color and code scheme for executing and waiting session categories, in the upper right-
hand corner of the view.
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Analyze the Top Activity section

The Top Activity section is located in the middle section of the editor and displays where the load originates.
Specifically, the top SQL statements, top events that the database spends time in, as well as the top activity
sessions.

The Top Activity section is composed of a series of tabs that provide detailed statistics on individual SQL statements
and sessions that were waiting or executing over the length of a profiling session.
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+ The top SQL tab provides more detailed information than provided on the Overview tab, in terms of
executing SQL statements and procedures. For more information, see Top SQL Tab.

« The top ExecutionActivity (DB 2 Specific) tab provides details about the statements and procedures that
ran. This is DB 2 specific. For more information, see Top Execution Activity Tab (DB2 Specific).

» Thetop Events tab displays information about wait events profiled by the execution process. For more
information, see Top Events Tab.

« The top Sessions tab displays information about sessions profiled by the execution process. For more
information, see Top Sessions Tab.

+ The top Blockers tab (Oracle) displays information about blocking sessions. For more information, see Top
Blockers Tab (Oracle Specific).

« The top Objectl/O tab (Oracle-Specific) tab does not appear in the Top Activity Section unless the data
source being profiled is an Oracle platform. This tab displays information about the I/O profiled by the
execution process. For more information, see Top Object |/O Tab (Oracle-Specific).

« The top Procedures tab (Oracle, SQL Server, and Sybase-specific) displays information about procedures
observed during profiling. For more information, see Top Procedures Tab (Oracle, SQL Server, and Sybase
Specific).

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

127


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

When you select any item from the Top Activity tabs, details are displayed in the Profiling Details view. The tabs that
appear in Profiling Details will be different depending on the database platform and whether you selected a
statement, session, or an event. This is to accommodate the parameter specifics of the item you selected.

Top SQL tab
The Profile editor's SQL tab shows a representation of all SQL statements that are executing or waiting to execute
over the length of the profiling session or within the currently selected graph bars.

() Theimage below depicts results achieved for a Sybase database. The columns displayed on this tab differ
depending on the database platform.
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Statements

Statements can be grouped by type by right-clicking the view and selecting Organize > By Type.

() Statements are grouped when they differ only by their clause values. This enables the roll-up of SQL
statements that only differ by a variable value. For example: select * from emp where empno=1; and select
* from emp where empno=2. A '+' symbol appears beside rollup statements. You can click the symbol to
expand and view the different statement predicates.

Additionally, the SQL tab displays two other groupings of statements:

Group Description

OTHER Includes all recognized statements other than INSERT, SELECT, UPDATE, DELETE,
and MERGE statements.
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Group Description

UNKNOWN Statements that are not recognized by the application. SQL Query Tuner has been
improved to query the caching more often and more intelligently so that UNKNOWN
appears less frequently in the Top SQL tab. The system queries the data source for
SQL text in 15 second intervals. Unknown may still appear infrequently as the SQL
text may have been removed by the database.

All statements are displayed in a tree structure with the following statement components:

Statement Component Description

Subject The DML statement type (and FROM clause, as appropriate).
Predicate The WHERE clause.

Remainder Any statement component following the WHERE clause.

For example, all statements with common subjects are shown as a single entry with multiple children; one child for
each unique predicate. Predicates are similarly broken down by remainders.

() Right-clicking the SQL tab and selecting Organize By lets you choose between Statement Type grouping
and None. The None option disables grouping by statement.

Statistics

Statistics are provided for statements and statement components. The statistics let you evaluate costs and spot
wait event problems not just at the level of entire SQL statements, but also at the level of statement components.
For each subject, predicate or remainder entry, the following statistics are provided:

(@ Columnsdisplayed on the top SQL tab differ depending on the data source platform.
Statistic Shown for Platform Notes

Exeutions SQL Server, Oracle, Sybase, DB2 = The number of active executions for the
statement or statement component over the
length of the profiling session or the selected
graph bars.

Avg. Elapsed (sec) Oracle, DB2 The average amount of time that elapsed while
executing the statement during the profiling
period. This column appears for only SQL
Server, DB2 and Oracle data sources.
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Statistic

DB Activity (%)

SQLID

Child Number

Parsing User ID

Plan Hash Value

Shown for Platform

SQL Server, Oracle, Sybase, DB2

Oracle

Oracle

Oracle

Oracle

Top Execution Activity tab (DB2 specific)

IDERA DB Optimizer 18.1.x

Notes

A graphical representation of the distribution of
execution and wait time for the statement or
statement component.

The ID value of the SQL statement. This statistic
only appears on Oracle data sources.

The child number in the database. This statistic
only appears on Oracle data sources.

The ID of the user who parsed the statement.
This statist only appears on Oracle data
sources.

The execution value of the statement. This
statistic only appears on Oracle data sources.

In addition to the statistics displayed on the Top SQL tab, DB2 platforms have an additional tab in the Profile
Session editor named Execution Activity, which contains the following statistical rows: Rows Read, Rows Written,
Fetch Count, Statement Sorts, Sort Time, and Sort Overflows.

Top Events tab

The Top Events tab displays information about wait events on the resources involved in the profiling process. This
display is used to tune at the application or database configuration level. For example, if the top events are locks,
then application logic needs to be examined. If top events are related to database configuration, then database

setup should be investigated.
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() Thecolumns thatdisplay are data source-dependent. For example, the Wait Count and Avg. Per Wait (sec)
columns display only for an Oracle data source.

Top Sessions tab

The Sessions tab provides information about individual sessions. This tab provides information about sessions that
are very active or bottlenecked.
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Top Blockers tab (Oracle Specific)

The Blockers tab provides details on sessions holding blocking locks.

= Gyren.riew| 5 sqL |@ Events|£ﬂ Sessions [ﬂ Elockersl & Object /O

User Mame | Program SID | Serial# | Blocking (%) = | Machine | Session Type | Client Info

SYSTEM IDBC T...lient B 7210 rowch...iu02
ORA..WER) 166 1l 1567 ROML...R503 BACK..UND
SYSTEM JDBC T..lient 124 26549 4 48 rowch...iu02 USER
ORA...ON) 161 1 0.75 ROML...R503 BACK..UND

The following parameters are displayed on the Blockers tab:

Value Description

User Name The user name under which the session was run.

Program The name of the executable under which the session was run.
SID The SID value of the session.
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Value Description
Serial The serial number of the machine from which the session executed.
Blocking (%) A graphical representation of the percentage of total blocked sessions

being blocked by a blocking session.

Machine The machine name and network location of the machine from which
the session executed.

Session Type The type of session.

Client Info The name/type of the client from which the session initiated.

() Formore detailed information, see Viewing Details on the Blockers Tab (Oracle).

Top Object I/0 tab (Oracle specific)

The Object 1/0 Tab is specific to the Oracle data source platform, and displays information about Oracle I/O loads
on the profiled data source.
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The following parameters are displayed on the I/0 tab:

Value Description

Object The name of the data source object affecting the Oracle /0.

Type The object type. For example, table, partition, or index.

DB Activity (%) Use the color chart on the right-hand side of the I/O tab to view the I/0

load on the data source during the profiling session.

Tablespace The name of the tablespace where the object resides.
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Value Description

File ID The unique ID value of the file from where specified object resides.

Top Procedures tab (Oracle, SQL Server, and Sybase specific)

The Procedures tab is specific to Oracle, SQL Server, and Sybase data source platforms. It displays information
about Procedure loads on the profiled data source.

'E' Overview EEL SO {19 Events __'-‘-"‘j Sessions _;'ﬁ Procedures

Procedure MName Database MName Pracedure ID Executions DB Ackiviky (%%
- TEST_PROCZ codruta F50099035 1 I 50,00
TEST_PROCH codruta 1542102572 1 I 50,00

The following parameters are displayed on the Procedures tab:

Value Description

Procedure Name The name of the procedure affecting the database
performance.

Database Name (SQL Server, Sybase only) The name of the database where the procedure resides.

Oracle (Oracle only) The owner of the schema in which the procedure resides.

Procedure ID A unique ID created when the procedure is created.

Executions (SQL Server, Sybase only) The number of times the procedure was executed during
the session.
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Analyze profiling details

The Profiling Details view displays detailed information on any item selected in the Top Section View, such as an
SQL statement, an Event, a Session or a Procedure.
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Depending on the data source platform you have specified, the tabs that appear in the view will be different, in
order to accommodate the parameter specifics of the statement you have selected.

Depending on the top activity selected and the profiled platform types, some tabs may not be available.

Statement selected

When a Statement is selected, the following Profile Detail tabs are available.

Tab Name Description Supported Platform

Oracle Sybas DB2 SQL

e Server

SQL Text Displays the full code of the selected SQL Yes Yes Yes Yes
statement.

SQL Details Provides details on statement, like Yes No Yes No
execution statistics.

Events Provides database activity details about Yes Yes Yes Yes
events the statement is associated with.

Sessions Shows which sessions executed this Yes Yes Yes Yes

statement.
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Tab Name

Blockers

Children Details

Object /O

Procedures

Bind Variable Details

Event selected

Tab Name

SQL

Sessions

Oracle Sybas DB2
e
Shows which sessions held blocking locks  Yes No No
against the session associated with this
statement.
Lists all copies of the cursor or SQL query, Yes No No
if Oracle has cached multiple copies of the
same statement.
If the SQL query has done physical I/0, Yes No No
then these are the objects, such as tables,
and indexes that were read to satisfy the
query.
Temporary objects with not have values in
Object and Type columns.
Shows which procedures contain the No Yes No
selected statement.
Shows bind variable information for SQL Yes No No
captured during the Profiling session.
When an Event is selected, the following Profile Detail tabs are available.
Description Supported Platform
Oracle Sybase DB2
Shows which SQL statements waited on Yes Yes Yes
this event.
Provides information about the sessions Yes Yes Yes
associated with the event.
Shows which sessions held blocking locks  Yes No No

Blockers

Description

against the session associated with this
event.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

IDERA DB Optimizer 18.1.x

Supported Platform

SQL
Server

No
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No

SQL

Server

Yes

Yes

No
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Tab Name Description

Procedures Shows which procedures contain the
selected event.

Raw Data Raw data that was sampled from the
database, specifically the following:

« Sample time
« SID

+ Serial #

« User name
« Program

+ SqlID

« P1

« P2

« P3

Analysis Displays for "buffer busy waits" and
"cache buffer chains latch" waits.

The analysis shows data and
documentation to assist in solving these
bottlenecks.

Session selected

IDERA DB Optimizer 18.1.x

Supported Platform

Oracle Sybase DB2

No Yes No
Yes No No
Yes No No

When a Session is selected, the following Profile Detail tabs are available.

Tab Name Description

Sessions Provides parameters regarding the session.

For example, database server connection
information, and data regarding the client
tool and application.

Blockers Shows which sessions held blocking locks
while this session was active.
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Tab Name Description Supported Platforms

Oracle Sybase

SQL Shows which SQL statements this session Yes Yes
ran.

Events Shows which events this session waited on.  Yes Yes

Procedures Shows which procedures ran the selected No Yes
session.

DB2

Yes

Yes

No

SQL
Server

Yes

Yes

Yes

() Whenright-clicking on a SQL statement in the Top Activity Section in Profiling, if the SQL statement is run
by a different user than the user who is running DBO, than the User Mismatch dialog appears, with an
example of the following message: "This query was executed by [SOE] and you are currently connected as
[system]. We recommend you reconnect as [SOE] to tune the SQL. Would you like to continue anyway?"
This message indicates that the statement is being tuned by a user other than the user who originally ran
the query, and tables may be missing based on the different schemas. Click OK to run the query, or click

Cancel and run tuning under the original user.

Blocking Session selected

When a Blocking Session is selected, the following Profiling Detail tabs are available.

Tab Name Description Supported Platform
Oracle Syb DB

ase 2
Blocked Sessions Provides identifier and VSSESSION session Yes No No

information on the sessions being locked by the
blocking session.

Session Details Provides parameters regarding the session. Yes

For example, database server connection
information, and data regarding the client tool
and application.

SQL Shows the SQL statements associated with the Yes
lock.
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Tab Name Description
Events Shows which events the blocking session waited
on.

Procedure selected

When a Procedure is selected, the following Profile Detail tabs are available.

Tab Name Description

SQL Text Shows the SQL text of the selected procedure.

SQL Shows which SQL statements this procedure ran.

Events Shows which events the selected procedure
waited on.

Sessions Provides parameters regarding the session.

For example, database server connection
information, and data regarding the client tool
and application.

This section also addresses the following topics:

+ Viewing Details on the SQL Tab

+ Viewing Details on the Sessions Tab

« Viewing Details on the Events Tab

+ Viewing Details on the Procedures Tab

Viewing details on the SQL tab

IDERA DB Optimizer 18.1.x

Supported Platform

Oracle

Yes

No

Supported Platform

Ora
cle

No

No

No

No

Sybase

Yes

Yes

Yes

Yes

DB
2

No

No

No

No

Syb DB SQ
ase

Ser
ver

No No

SQL
Server

Yes

Yes

Yes

Yes

In the Top Activity Session, selecting a statement entry on the SQL tab displays information in the Profiling
Details view. The graph portion and details on the event category tabs on the new editor pertain only to the

selected statement. Additionally, new tabs become available:

« SQL Text tab: Shows the full code of the SQL statement. For more information, see SQL Text.
« SQL Details tab: Displays execution details. This tab is only displayed for Oracle data sources. For more

information, see SQL Details.

« Events tab: Displays information about the events the selected statement is associated with.
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For more information, see Events.

IDERA DB Optimizer 18.1.x

+ Sessions tab: Displays information about the sessions that the selected statement is associated with. This
tab is displayed only for Oracle data sources. For more information, see Sessions.

+ Procedures tab: Displays information about the procedures that contain

the selected statement. This tab is

displayed only for SQL Server and Sybase data sources. For more information, see Procedures.

To select a SQL tab statement entry

« Onthe SQL tab, click on a statement with no child nodes or on a leaf node in the statement structure.

The new profiling editor page opens, as reflected by the bread crumb trail at the
continue to drill down into the statement, as needed.

SQL Text
The SQL Text tab displays the full code of the SQL statement.

top left of the editor. You can

£ New SQL Text |.

Add Tuning Statement
Add a 5QL statement.

First,
Last
FROM
Enplovyee
WHERE
Gender

m Frl

SELECT

Apply

oK

||

Cancel

SQL Details

The SQL Details tab provides information and the execution of the statement and other information related to how

itis running. It is only applicable to Oracle data sources:
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501 Address S999CE50 Parsing User 10 5 Exscutions 1 100 1.00
Child & =5 GEEAASA0 Cubbre Cab=gory Sorts O .00 0,00

Chidren 1 Quting &I0 0 Cisk B=ars 1004 1L.C0A.0 1,004,080

Flan Hash value 38582253503 Suffer Gels 13281 13,2600 13,2500

Parsing Skatistics

Modie Execataraxe Rows Processed 1 1.00 Lia
Achian Memary 162433 P Time 23, 750.00 &3, 750,00 83,750,060
0L Operabon Code 2 Loads 134 Eapged Time 70,275.020,00  70,275:320.00 A0,273.820,00
Program 1D 10 1644 Irvaidabiorns 132
Frogram Line= 158
SQL Details include:
Parameters Description
SQL Identification Values The SQL ID value of the statement.
Optimizer and Outline Values Optimizer-specific values pertaining to the parsing user ID value
and outline SID.
Parsing Statistics Information regarding memory, loads, and invalidation values.
Execution Statistics The execution statistics of the statement.
This category includes disk reads, buffer gets, rows, and values
that represent CPU and elapsed time.
Events

The Events tab provides details about the events that the statement is associated with.
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SOL: INSERT INTO PERFCHTR_DATA_1(QUERYID, VALUEL) SELECT 951, COUNT(®) FROM SYS.V_$LOCK L.5YS.DBA_OBIECT...

D 50 Text | o 5Qu Detels | @ Events| 7 sessions| 0 cricrenetais.

o cEwnt s ] ey ()
do file s=quental read 1 322
db fite scattered read 0.50

Sessions

The Sessions tab provides information about any sessions the statement is associated with:

@ Profing Detsie £ i Ol

-

500 THSERT INTO PERFCNTR_DATA_1{QUERYID, VALUEL) SELECT 951, COUNT[*] FROM S5VSN_SLOCK L,5YS.08A_DRIECT..

Bt 50 Tet | o 50L Detals (5 Bvents | 47 sessions| B Ckden Detaiks

| dsertiame | Pragam | sD | Ses | smwiy (W) | Manz | SeasonType |
SYETEM Executar.exs 145 000 BN 31f EVBARCADERQACWSNDVATDL =
SYSTEM Executar.Ee W5 e 085 EVBARCADERS ROWSHOVACOL usER,

L= —————————————————————— e

Session details include information on different parameters, depending on the platform. For example, on Oracle
platforms, the following parameters are displayed: User Name, Program, SID, Serial #, Activity (%), Network
Machine Name, and Session Type.

Procedures

The Procedures tab provides information about any procedures containing the selected statement.
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@ Profiing Detais 13 =B
SOL: WHILE {SELECT COUNT{*) FROM codrutatl) > 1 BEGIN DELETE FROM codrutat ] WHERE §jj = (select mar(jj..
%t SO text |§ E" Events _;T-I Sessions J'.!l'Il Procedures

Frocedure Name Database Name Frocedure 1D Executions DB Activity (%)
TEST_PROCE codruts ASO0IA0GE 1 I 1619

The following parameters are displayed on the Procedures tab:

Value Description

Procedure Name The name of the procedure that contains the selected statement.
Database Name The name of the database where the procedure resides.

Procedure ID The unique ID value of the file where the specified procedure resides.
Executions The number of times the procedure was executed.

DB Activity (%) Use the color chart on the right-hand side of the Procedures tab to view

the procedures load on the data source during the profiling session.

Viewing details on the Sessions tab

In the Top Activities Section, selecting a statement entry on the Sessions tab displays information in the Profiling
Details view. The graph portion and details on the event category tabs on the new editor pertain only to the
selected statement. Additionally, new tabs become available.

Selecting an event type entry on an event category tab opens a new profiling editor page. The graph portion and
details on the Sessions tab and event category tabs on the new editor page pertain only to the selected wait event
and to SQL statements that waited in that event.

+ Session Details tab: Shows system details about the selected session. For more information, see Session
Details.

« SQL tab: Displays information about the SQL files that the selected session is associated with. This tab only
appears on Oracle platforms. For more information, see SQL.

+ Events tab: Displays the time and parameter information about the selected session. For more information,
see Events.

+ Procedures tab: Displays the details of any procedures run in the selected session. For SQL Server and
Sybase data sources only. For more information, see Procedures.

Session Details

The Session tab provides further information about the selected session. The following are examples of the session
details provided for different platforms.
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() Thefields that display vary depending on the database platform.

Oracle profiling details

i

Session: 145, 9180

EE session Detals| B 59 () Events|

Lkar Name SYSTO
Sroc=ss 05 PID 142532
Logged On Time 2005-12-19 17:25:06.0

Logged On For D3:01:27.0 Client ID
Connacton Type DEDICATED Client Infa
Session Type USER,

Rasguroe Consumer Group

Microsoft SQL Server

05 Process ID TEF2:76 76
Hast EMBARCADERCROWSHNOVACDT
Termingl ROWSHOVACZDL

Database Server Connection Chient Tool Application
S0 145 Frogram Exeostor.axe S0 ID 1543343752
Serislx DIRD 05 User NT AUTHORITTANCHYMOUS LOGOM S0L Operstion Code 3

Lask Cal Bapsed Time 36

Modue Exsputor,sxs
Action
SCL Trace DISABLED

=

2 session Detais | 5 50L | €5 Everss

Session: 55_2009-09-30 0%:40:34.940 (sa / Executor Module)

Database Server Connection

SPIC 55
KPID 4,048
Databasz= 10 105
Uger I 0
Login bimne 20009-09=30 02403494

Client Application

Apclication name
WT domain

NT wsername
Hask pracess 10
Hostname

Met address

et kbrary

Executor Madule

3552
TORLABOEMOO1
000C29592138
TCRIP

SQL

The SQL tab displays information about the statements associated with the session.
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@ Profing Detsis 1 i =R
Session: 145, 9160
EE Gmempn Dateils H o ‘:—:! Evenes

Stasement Execubiors |  debvity (%) =] SO | chidbumber | ParsrgleerID | Planbashivsoe | |
_FPUSHRTINICPERSCNIA L. ADLDISOCEICT D e— s 0 8 dseasises g
MNZERT INTO FERFCHTA_D.. . USER= FROM 575 . USERS LN 0. 20 530301544 o 5 <00753557L |
a SELECT COUNTY™) FROM 5Y. ..HERE STATLS = {TRLTHE Ll 0.05 IS45343752 a 5 510734404
PR Lh 0,05 34404rE1el n N

SQL statements are listed by the following parameters:

Value Notes

Statement The name of the statement.

Executions The number of times the statement was executed during the session.
Activity (%) A graphical representation of the distribution of execution and wait

time for the statement or statement component.

SQLID The SQL ID value of the statement.
Child Number The child number in the database.
Parsing User ID The ID of the user who parsed the statement. Plan Hash ValueThe

execution value of the statement.

Plan Hash Value The execution value of the statement.

Events

The Events tab provides details about the events that the session is associated with.
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@ Profing Detais 27 =g

Session: 145, 9180

£Z Session Details | B saL [EE} E'-fentsl

Event | Actvity (o8) |
idb file sequential read | 2,78
db file scattered read 0,60
local write wait Q.05

Events are listed by the following values:

Value Notes
Event Name The name of the event.
Activity (%) A graphical representation of the distribution of execution and wait time

for the statement or statement component.

Procedures

For SQL Server and Sybase data sources only, the Procedures tab provides details about the procedures that the
session is associated with

| | -

Session: 112, 5505108 (sa)

E2 sessionpetsis | B sou (D) events | ] Procedures |

Frocedure Nams | DotabsscMame | ProcedusID | Executions | DB Actky (%) T
TEST_PROCE codruts AE00IC03E 1 IR 100.00

The following parameters are displayed on the Procedures tab:
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Value

Procedure Name

Database Name

Procedure ID

Executions

DB Activity (%)

Bind Variable details

IDERA DB Optimizer 18.1.x

Description

The name of the procedure that ran during the selected session.

The name of the database where the procedure resides.

The unique ID value of the file where the specified procedure resides.

The number of times the procedure was executed during the session.

Use the color chart on the right-hand side of the Procedures tab to view
the procedures load on the data source during the profiling session.

For Oracle data sources, profiling captures the bind variables and their attributes. Select an SQL statement in the
Profiling Session and the details of the captured bind variables for that statement are displayed here.

@ Profiing Details

SOQL: SELECT COUNT{DISTINCT A.TITLE) FRDM MOVIETITLE A, MOVIECOPY B, RENTALITEM C WHERE

3 SQL Text | @' SQL Details | () Events | &7 Sessions | [87 Children Detalls | 03 Object 1/0 | Jy Bind Variable Details

SULID
dexhauihrpft

Position Variable Name Yariable Type Yariable Yalue
1 MUMBER. 625

The following parameters are displayed on the Bind Variable Details tab:

Value

SQLID

Child Number

Position

Variable Name

Variable Type

Description

SQL identifier used by the data source.

A new child number is generated for the SQL ID of the query whenever
the plan changes, for example the value of a bind variable is changed,
and the query is executed again.

The position of the variable within the SQL text. For example, given the
query, select * from T1 where C1=:aand C2=:band C3=:cand C4=d,
the positionofais1,bis2,cis3and dis 4.

The name of the variable.

The data type of the variable.
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Value Description

Variable Value The value of the variable.

Viewing details on the Blockers tab (Oracle)

In the Top Activities Section, selecting an entry on the Blocked Sessions tab displays information on sessions
holding blocking locks in the Profiling Details view.

Blocked Sessions

The Blocked Sessions tab provides general information on blocked sessions and the details identifying the specific
row locked.

@ Profiling Details 2 ™. s

Session: 124, 26549 (SYSTEM/JDBC Thin Client)

Blocked Sessions | = Session Details: 5:“." SqQL {P} E\.rents.

User Name | SID = | ROW_WAIT_OBJ# | ROW_WAIT_FILE# | ROW_WAIT_B..K= NUMBER | ROW.... ROW=

SYSTEM 137 -1 a ] 0
SYSTEM 136 -1 a 0 0
SYSTEM 110 -1 ] 0 0
SYSTEM 107 -1 ] 0 0
SYSTEM 100 -1 a 0 0
SYSTEM 95 -1 a ] 0
This tab provides the following columns for each blocked session:
Value Notes
User Name The user name under which the blocking session was run.
SID The SID value of the blocking session.
ROW_WAIT_OBJ# Object ID of the table containing the row specified in
ROW_WAIT_ROW#.
ROW_WAIT_FILE# Identifier of the datafile containing the row specified in
ROW_WAIT_ROW#.
ROW_WAIT_BLOCK# Identifier of the block containing the row specified in

ROW_WAIT_ROW#.

ROW_WAIT_ROW# The current row being locked.
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Session Details
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The Session Details tab provides information on the server connection, client, and application associated with the

blocking session.

-

4 { e |
@ Profiling Details &2 B
Session: 124, 26549 (SYSTEM/JDEC Thin Client)
ﬁ Blocked Sessions |E Session Detailsl ESL 5QL|{:9 Events|
Database Server Connection Client Tool Application =
S50 124 Application JDBC Thin Client SQLID cupeduuungesk
Serial 26549 05 User Catalinb SQL Operation Code 3
User Mame SYSTEM 05 Process 1D 1234 Last Call Elapsed Time 00:16:13.0 3
Process O35 PID 5780 Hostname rowcbulgariul2 Medule JDBC Thin Clieni|
Logged On Time 2012-10-31 05:54:54 Terminal unknown Action
Logged On For 00:17:03.359 Client ID S0L Trace DISABLED
Connection Type DEDICATED Client Info e
Session Type USER -
SQL
The SQL tab displays information about the statements associated with the blocking session.
i = By’
@ Profiling Details &3 B
Session: 124, 26549 (SYSTEM/JDEC Thin Client)
ﬁ Blocked Sessicns |§§ Session Details I 5 SQLI @ Events|
Statement | Executions | Avg. Elapsed (sec) | DB Activity (%) ~| SQLID | Child Number

- o SELECT CO...TIME_ID

52 490.335 (NN 100.00 cuj..csb

0

SQL statements are listed by the following parameters:

Value

Statement

Notes

The name of the statement.
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Value Notes
Executions The number of times the statement was executed during the session.
Activity (%) A graphical representation of the distribution of execution and wait time

for the statement or statement component.

SQLID The SQL ID value of the statement.
Child Number The child number in the database.
Events

The Events tab provides details about the events that the blocking session is associated with.

@ Profiling Details 53 =
Session: 124, 26549 (SYSTEM/JDEC Thin Client)

E Blocked Sessions -E.-E' Session Details. EE;L SQL {E‘ Events
Event Wait Count | Awvg. Per Wait (sec) Class . DE Activity (%
direct path read temp T89 0179 User[/O D o
OM CPU OM CPU E=H 1958
read by other session 2 0.205 UserI/O 051

Events are listed by the following values:

Value Notes

Event The name of the event.

DB Activity (%) A graphical representation of the distribution of execution and wait

time for the statement or statement com ponent.

Viewing details on the Events tab

In the Top Activities Section, selecting a statement entry on the Event tab displays information in the Profiling
Details view. The graph portion and details on the event category tabs on the new editor pertain only to the

selected statement. Additionally, new tabs become available.

Selecting an event type entry on an event category tab opens a new profiling editor page. The graph portion and
details on the Events tab and event category tabs on the new editor page pertain only to the selected wait event

and to SQL statements that waited in that event.
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« SQL tab: Shows the statements involved in the selected event. For more information, see SQL.

+ Sessions tab: Displays information about the sessions that the selected event is associated with. For more
information, see Sessions.

+ Procedures tab: Displays information about the procedures that ran during the selected event. For more
information, see Procedures.

SQL
The SQL tab displays information about the SQL statements involved in the selected event.
@ Frafing Detais 13 =B
Event: wait for someone else to finish reading in mass

S 9L | 7 Sessions | o Procedures

Skatements R Physical 10 Memary Usage Exeru

?t CELETE FROM codruta bl WHERE jii = (sefect macd i) from codruta,k1) I 3036 8

sop WHILE (SELECT COUNT(™) FROM codruta k) » 1 BE, . E jii = {select ma=(iii) from codruza.tl) END: 0 1625 8
Value Notes
Statement The name of the statement.
SQLID The ID value of the SQL statement.
Child Number The child number in the database.
Parsing User ID The ID of the user who parsed the statement.
Plan Hash Value The execution value of the statement.
CPU Cumulative CPU time for the process. (measured in "ticks", an arbitrary

unit of time)

Physical 10 Cumulative disk reads and writes for the process. (total count)
Memory Usage Number of pages in the procedure cache that are currently allocated to

this process. A negative number indicates that the process is freeing
memory allocated by another process.

Executions The number of times the statement was executed.

Activity (%) A graphical representation of the distribution of execution and wait time
for the statement or statement component.
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The Sessions tab displays the sessions and related information regarding those that were associated with the
selected event.

3 Profiing Detals. B3 0 B =
Event: O CFU
B 5oy | 27 sessions | ) Raw Data
| User Mame Program cErml= Aty (%) v acere Sammon Typs
[SOSTEM  Bweoocese 035 I3 MM 319 EMBWRCADEROROWERITAD:  USR
QRACLE-EXE {CTWR) 3 — 29,43 TORLATORCL10G_] BACKEACUND
GRANE EXE :El!' 'I 1E7 1 9,78 ToaLAatRCL WG _1 BACEGASUNHD |
ORACLEEXE (M4OM) 161 1 0,45 TOALASCRELI0E 3 EACKEA0UND
IGNITE ORACLE ZE 002} iy zeE3 0,10 TOALAICACL 106_t LISER:
QRACLE.EXE :‘EI-I:h:I 1E4 L 0.10 TORLABDRCL 105 _] BACKGRCLUND
ORACLE EXE (PSP} 162 1 0.10 TOALAACACLI0E 2 BACKEACUND
TENITE RACLE XE {2015) 138 1 0,05 TOALASCRCLI0E_ USER I
b3 ORACLE EXE 007 124 3590 0,05 TOALARCRCL 105_] LISER: |
SYSTEM Exmrutor moe 148 o242 .05 EMIARCADEROROVSRIVACE 1 USER
TENITE ORACLEZXE (2000} 58 5 0.05 TORLASCRELI0E_1 LISER
|

The following parameters are displayed on the Sessions tab:

Value Notes

User Name The user name under which the session was run.

Program The name of the executable under which the session was run.
SID The SID value of the session.

Serial Number The serial number of the machine from which the session executed.

Activity (%) A graphical representation of the distribution of execution and wait time
for the statement or statement component.
Machine The machine name and network location of the machine from which the
session executed.
Session Type The type of session.
Procedures

The Procedures tab displays the procedures and related information regarding those that were associated with the
selected event.
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@ Profiing Detsis £ =B
Ewent: waiting for disk write to complete
B 50l | 27 Sessions | M) Procedures

Procedure Nama Database Name Procedura 1D Executions DB Actrviy (%60
TEST_PRiC1 codruta 1842102572 1 [ | ). (1)

The following parameters are displayed on the Procedures tab:

Value Notes

Procedure Name The name of the procedure that ran during the event.

Database Name The name of the database where the procedure resides.

Procedure ID The unique ID of the procedure.

Executions The number of times the procedure ran during the event.

DB Activity (%) A graphical representation of the distribution of execution and wait

time for the procedure.

Viewing details on the Procedures tab

In the Top Activities Section, selecting a procedure entry on the Procedure tab displays information in the
Profiling Details view. The graph portion and details on the procedure category tabs on the new editor pertain only
to the selected procedure. Additionally, new tabs become available.

Selecting a procedure type entry on a procedure category tab opens a new profiling editor page. The graph portion
and details on the Procedure tab and procedure category tabs on the new editor page pertain only to the selected
procedure and to SQL statements that waited in that procedure.

« The SQL Text tab shows the SQL of the procedure. For more information, see SQL Text.

« The SQL shows the statements involved in the procedure. For more information, see SQL.

« The Events displays the time and parameter information about the selected procedure. For more
information, see Events.

« The Sessions displays information about the sessions that the selected procedure is associated with. For
more information, see Sessions.

SQL Text
The SQL Text tab displays the full code of the procedure.
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@ Profing Details 3

2 son Tet | B 5o | (Db Everks | 27 Sessions
CREATE PROCEDURE dbo.TEST PROC1 AS
DECLARE Bi INT
BEGIN
SET Bi = 1
WAILE
#i <= 1000000
BEGIN

sQL

IDERA DB Optimizer 18.1.x

Procedure: TEST_PROC1

The SQL tab displays information about the SQL statements involved in the selected procedure.

i@ Frofiing Detais 53

SB oo Texk | B sow | (5N Evanes | 87 sessions

Procedure: TEST_PROCI

Statements CPU Physical IO | Memary Usage Execu
+% TMSERT INTO codrata 10 i, 1, 1, u) WALUES { @i, &, @i, &) z 3 B
;,:t WHILE @i <= 1000000 BEGIM INSERT TMTO codrut,, LLES { (@i, i, @i, @i ) SET @i = @i+ 1 END ] 0 8
] 1] 8

2% SET @i = @i + 1

The SQL tab displays the following parameters about the statement:

Value

Statement

SQLID

Child Number

Parsing User ID

Plan Hash Value

CPU

Physical 10

Memory Usage

Notes

The name of the statement.

The ID value of the SQL statement.

The child number in the database.

The ID of the user who parsed the statement.

The execution value of the statement.

Cumulative CPU time for the process. (measured in "ticks", an
arbitrary unit of time)

Cumulative disk reads and writes for the process. (total count)

Number of pages in the procedure cache that are currently allocated
to this process.

A negative number indicates that the process is freeing memory
allocated by another process.
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Value Notes
Executions The number of times the statement was executed.
Activity (%) A graphical representation of the distribution of execution and wait

time for the statement or statement component.

Events

The Events tab provides details about the events that the session is associated with.

i@ Profling Detsis & =5
Procedure: TEST_PROC1
%t SOL Text | B 50U ."::‘!' Everks| g7 'SI:S-"H'D!'IS.
Event = Clasz D8 Adiivity (%) | o e ”
woting for dskwiits locomplete . I
wisiting for network sand ta complate METWOREK — 19.89
waiting for s=maphore Lok 0.83
wiziting on run gueus after skeep R [ | 4,46
wiziting on run gueue after yisld CRU i} 10,92
Events are listed by the following values:
Value Notes
Event Name The name of the event.
Class The wait group the event in the selected procedure belongs to.
Activity (%) A graphical representation of the distribution of execution and wait

time for the event.

Sessions

The Sessions tab displays the sessions and related information regarding those that were associated with the

selected procedure.
@ Profiing Detais 1
Procedure: TEST_PROC1

23 son Tet | B sy | (Db Everks | 37 Sessions

User Name Applic atan SPID KPID Active (%) v Hast ame IP Address
%8 40 st 186 [N 10000 TORTYEGHD] 10.40,30,135

The following parameters are displayed on the Sessions tab:
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Value Notes

User Name The user name under which the session was run.

Program The name of the executable under which the session was run.

SID The SID value of the session.

Serial Number The serial number of the machine from which the session executed.
Activity (%) A graphical representation of the distribution of execution and wait time

for the statement or statement component.

Machine The machine name and network location of the machine from which the
session executed.

Session Type The type of session.
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Creating profiling reports

IDERA DB Optimizer 18.1.x

After profiling a data source, you can create an HTML or PDF Report of the profiling session. You can choose the

details to include in the report.

1. Atthetop right corner of the Profiling tab, click the Export Report button.

| Unkitled Tuning Job 4 Eun

| £ ROMLABORCLI_2 ~ Processes: [l v Fiberby:[one: v
Export Report —

Profile Session

it ROMLABORCLS 2 [

=0

+®°

Ed BoncPL B system 10 B User VO OCwster BApplication B Configuration B Commit B Other
N s

e 1

=

(=1

W

o

i

L]

go & & X o a6 @ U
Z e s o = o o s i3

= "t e " " " N " "

The Export a Profile Report dialog appears.

Export a Profile Report

Export a Profile Report

Configure and export a profiling report in various formats.

Report Description:

Profile Report Options
- SQL
SQL
Report only the top 25

General Report Options
Format Layout

Use default export location

@ PDF (@) PORTRAIT
@) HTML (©) LANDSCAPE

Report Title: bata Source Profile Report

-
~ | FTOWs

[# Tnrlida Aatail infarmatinn fartan 75 2| renare

Paper Size

@) Letter (8.5 x 11, 216 x 279)
Legal (8.5 x 14, 216 x 356)
A4 (83x 117, 210x297T)

Export location: | C\Users\npollard\AppData\Roaming\ldera\dboptimizer\workspace

1

13

|

Browse...

©)

[_Bpon ||

Cancel

|

L

2. Enter a Report Title and Description.

3. Inthe Profile Report Options area, click the triangles to expand the options.
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4, Select your options, enter the location for the report, and then click Export.
A report in PDF format will resemble the following:

Raokmarks

[ 1-0sts Source d \
[ 2 - Profie Load Chart
El] 3-Top S50
Stataments

b

| Data Source Profile Report
Jarmiany 27, 2011 1143 AM

1- Data Sowce

Fawwe: 040130
Flatiorm  Cracie 8530 1

Start Sy 3T 0L 110 A
End  Jarwasry 27, 2011 1121 Al
Dusrstian: o Zla

# - Profile Load Chart

Activg B osEknng [l

BN SR I Epsiem T B Us o WD B Ciustor MAppEcaten B Consgusation B Commi § Hstward B ninisiaten B Canoinarey 08 hesular [ Ofher
-
A a0

¥ . I I
]
L » b & * & 3 - r r ] 3 - & &
= o " - o W A r. A g o o o "
W § e - oF % a1 s ot T 1 o &

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

157


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

Saving profiling sessions

The profiling session is saved automatically or when you try to close it according to the choices made in the Profile
Configuration dialog. For information on configuring profiling sessions, see Building profiling configurations.
Profiling sessions can be saved in the current workspace in an archive file with a .oar suffix or for Oracle users, into
a Profiling Repository.

The .oar archive file is named with a default file name of:

« The name of the data source if the session was not initiated from a named launch configuration
« The name of the launch configuration if the session was initiated from a named launch configuration.

If you are using an Oracle data source and have configured DB Optimizer to automatically save profiling sessions in
a Profiling Repository within an Oracle data source, then the profiling session is saved in the Profiling Repository
under the name of the data source. Each profiling session for that data source is named using a date and time
stamp. As you can see below, the duration of the profiling session is also saved with the session data.

Y pata Source £ 53 |.§:E::f SOl Project Ex = .
TR

BRESYManaged Data Sources (4)
=-E8 TORLABORCLIOg 2 (Oracle 10,2,0,5)
[+ l__l:j Database Objects
|l[_l:| Profiling Repository
=58 TORLABORCLI1g_2 (Oracle 11,1.0,6)
[+ l__l:j Database Objects
= |l[_l:| Profiling Repository
=-Hi TORLABORCL11g_2
(4, 2012-03-05 18:43:05 {33m)
+-E8 TORLABORCLY_ 2 (Orace 2.2.0.1)
5| TORLABSQLOS_1 (50U Server 10.0,160,0)
= Profiling Repositories
il ToRLABORCLIOG 2
=il TORLABORCL11g_2
=-Hi TORLABORCL11g_2
[q 2012-03-05 18:43:05 (33m)
[+ M TORLABORCLSI_Z

For information on working with the Profiling Repository, see Work with the Profiling Repository. The time period of
the saved session is the amount of data on the chart. The maximum amount of data on the chart is determined
when profiling is started (1-hour default). You can specify the amount of time to profile the data source in the Profile
Configurations dialog and you can also stop the profiling at any time.

Saving the profile lets you open the archive at a later time for subsequent analysis by yourself or by other DB
Optimizer users. Use standard DB Optimizer file techniques to save, open, or close SQL Profiling archives. If you
open a profiling archive on a machine on which the associated data source is not registered, a Data source not
available warning appears in the profiling editor header. Use the associated control to specify a data source
already defined on the machine or to register a new data source.
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Ly EXTDUMHHBDE b RN W T P T SR o o
Akkach Existing Daka Source ...

Profile Session Akkach Mew Daka Source ..,

Work with the Profiling Repository

() Saving wait-time statistics to the Profiling Repository is not supported in Developer Editions of DB
Optimizer.

The Profiling Repository is only available when profile session data is saved to an Oracle data source. You can
specify a profiling repository on any supported version of Oracle data source. For information configuring profiling
repositories, see Specify Profile Repositories Preferences. You can specify which profiling to save a session to using
the Profile Configurations dialog. For more information, see Building profiling configurations. When the system is
configured to automatically save profiling information to a Profiling Repository, DB Optimizer can profile 24 hours a
day 7 days a week, thus providing much more statistical data for analysis. Also, since a Profiling Repository resides
on a data source and not on the local disk, other DB Optimizer users can also view and analyze the profiles.

To start saving profile sessions to the Profiling Repository

1. From the Data Source Explorer right-click the data source you want to profile for and select Profile As from
the menu, then choose Profile Configurations.
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GEX| B3 Mane: | TORLABORCLIDG 2
|lifs) Profle . [] Common
-1l Datasaurce Profiling Target
i Test Datasmrcl:::TORLAEiORCL‘Bi_E{Druth} v:

-l TORLABORCLIDG 2
LT ToMMIFIREYDE
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2. Inthe Name field of the Profile tab, enter a name for the profile session for this data source.

In the Profiling Target Data source field, select a data source from the list.

4. Inthe Profiling Repository area of the Profile tab, click Save to data source and then from the list of
registered profiling repositories, choose the Oracle data source to which you want to store the profiling
session information.

5. Click Apply and then click Profile to start a profiling session immediately.

Any new profiling session that you start continue until you manually stop it. The profile session can be for as
long as you like, days or weeks even. When the profiling session is stopped, a profile file is stored in the
profile group for this data source. The name of the profile file is the date and time when the profile finished.

w

To delete profile sessions saved in the Profiling Repository

1. Inthe Data Source Explorer, locate and then click the Profiling Repository.

() You access the profile repositories either in the Managed Data Sources node or in the Profiling
Repositories.
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[=1+T=F Managed Data Sources (5)
T== IBM DEZ For LUW (1)
[=-1=F Oracle (5}
8 TORLABORCLIOg_2 (Oracle 10.2,0,3.0
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If the data source is not already connected, DB Optimizer connects to the Profiling Repository data source.
2. Todelete all sessions in the Profiling Repository, right-click Profiling Repository and then select Delete All.
To delete a specific profiling session, expand the Profiling Repository and the data source containing the

profiling session, and right-click the name of the profiling session, and then select Delete.
The profiling session data is deleted, however, some information about the data source is retained in order
to expedite future profiling on this data source. If you are certain you will not want to retain this information,

right-click the Profiling Repository and then select Clean.

() You can also delete the profiling sessions saved to a repository by unregistering the repository. For
more information see Specify Profile Repositories Preferences.
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Import statements to tuning

The profiling feature lets you submit one or more SQL tab statements for tuning by the tuning feature. This lets you
take advantage of tuning's hint-based and transformation-based suggestions, detailed execution statistics, and
explain plan costing, in tuning a statement.

SOL

£E Overview o 50L {B Events g*':'SEssinns #0 Chject Ij0

S50QL statements
Statement DB Activity (%)
%{ Mo OrganizeBy ¥ 1 g 26,67
T .
st BEG -0 Explain Plan I 333
& SEL I 1.67
J‘,— Tune

To open a tuning job on a statement appearing on the SQL tab of the profiling editor

Select one or more statements, right-click and select Tune from the context menu. Tuning opens on the selected
statement.

For more information, see Tuning SQL statements.
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Other profiling commands

In addition to the default viewing options provided by the views, profiling also provides the following features and
functionality:

« Zooming In and Out. For more information, see Zooming In and Out.
« Filtering Results. For more information, see Filtering Results.

Zoomingin and out
To zoom in or out on the Load Graph

In the upper right-hand corner of the Load graph, click the Zoom In or Zoom Out icons, respectively.

() TheZoom Inand Zoom Out commands are only available when a session has been stopped.

By default, the information contained on the Load Chart spans the entire length of the profiling session. You can
select one or more bars of the graph to have the tabbed view populated with statistics for only the selected subset
of the graph.

To display statistics for one or more bars on the graph, use the following method

Click-drag across one or more bars.
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Configuring profiling

This section addresses the following topics:

« Configuring DBMS properties and permissions

« Building profiling configurations

« Specify profile alerts preferences during configuration

« Specify profile repositories preferences during configuration
+ Using SQL Load Editor/Tester
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Configuring DBMS properties and permissions
Profiling supports the following DBMS platforms:

« IBM DB/2 for Windows, UNIX, and Linux
» Microsoft SQL Server

« Oracle

+ Sybase

The following describe how to set up a platform to utilize Optimizer on supported database platforms:

» Configuring IBM DB/2 for Windows, UNIX, and Linux
« Configuring Microsoft SQL Server

+ Configuring Oracle

+ Configuring Sybase

Configuring IBM DB/2 for Windows, Unix, and Linux

() The connected profiling user should be a member of the DB2 SYSMON group.

By default, DB2 Monitor flags are set to OFF. As a result, when attempting to launch a Profile job on a DB2 data
source, users may encounter the following message: "One or more errors have occurred that prevent session
profiling against this data source." Examine the details below and consult your data source administrator and/or
the data source documentation to resolve the problem(s)."

You can resolve this error using one of two methods:

» Enabling DB2 Monitor Flags via IDERA DBArtisan
» Command Line Option

To resolve the error through DBArtisan

1. Ensure the following DB2 Monitor Flags are turned on in DB2:
« dft_mon_uow
+ dft_mon_stmt
« dft_mon_lock
« dft_mon_bufpool
« dft_mon_sort
« dft_mon_table
« dft_mon_timestamp

You can set view and set Monitor Flags via DBArtisan. Ensure that the New Value field for each variable is set to Yes,
as shown below.

Edit Configuration for TCP1ESE

Parameter: | dft_rian_bufpaal |

Current W alue: |EIFF |

Hew Y alue:

oK | |% Cancel | | r:. Help |
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+ Restart the DB2 data source to enable the changes, then launch SQL Query Tuner and begin profiling.
To resolve the error through the command line

This solution must be performed from DB2 CLP, on the DB2 server. If you attempt to perform these tasks through a
client, an error message results.

1. Navigate to Start > Programs > 1BM DB2/COMMAND LINE TOOLS > COMMAND LINE PROCESSOR.
2. Turn the monitor switches on using the following commands:
db2 update dbm cfg using dft_mon_lock on dft_mon_bufpool on dft_mon_sort on
dft_mon_stmt on dft_mon_table on timestamp on dft_mon_uow on db2stop db2start
3. Ensure that the switches are turned on by connecting to the server with the following command:
Db2 connect to database username password password

The following screenshot provides an example of the input and output from the server:
dbZ =»> connect to gim user dbZadmin
Enter current password for dbladmin
db2 => get monitor switches

Monitor Recording Switches

Switch li=st for db partition number 0

Buffer Pool Activity Information (BUFFERPCOOL) = ON 03/05/2009 19:14:06.61:
Lock Information (LOCK) = ON 03/05/2009 19:14:06&.61:
Sorting Information (SORT) = ON 0O3/05/2009 19:14:06&.61:
SQL Statement Information (STATEMENT) = OH 03/05/2009 19:14:06.61:
Table Activity Information (TARBLE) = ON 03/05/2009 19:14:06.61:
Take Timestamp Information (TIMESTAMP) = ON 0O3/05/2009 18:50:44.00¢
Unit of Work Information (UOW) = ON 03/05/2009 19:14:06.61:

Configuring Microsoft SQL Server
Perform the following tasks to ensure that SQL Server is compatible with Optimizer:

« The current user must meet one of the following requirements:
« Be a member of sysadmin, or have the VIEW SERVER STATE permission enabled.
+ Be amember of sysadmin, or have the SELECT permission enabled.

Configuring Oracle
Oracle users need access to VS views. In order to configure Oracle to provide users with these privileges:

« If you are setting up Oracle 10 or later, ensure you are logged in as sys or system with the sysdba role, or the
SELECT_CATALOG_ROLE has been granted to user_name.

« If you are setting up an earlier version of Oracle, ensure you are logged in as sys or system with the sysdba
role.

Configuring Sybase
Perform the following tasks to ensure that Sybase is compatible with DB Optimizer:

+ Ensure the following system configuration properties are activated:
« Enabling Monitoring (sp_configure "enable monitoring", 1)
« Wait Event Timing (sp_configure "wait event timing", 1)
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+ SQL Batch Capture (sp_configure "SQL batch capture”, 1)
» Max SQL Text Monitored (sp_configure "max SQL text monitored", 2048) 2048 is the suggested value, must
be greater than 0. This defines the maximum size a SQL statement that can be captured.

The following options are specific to Sybase 15.0.2 and higher.

+ SQL Text Pipe Active (sp_configure "sqltext pipe active", 1)

+ SQL Text Pipe Max Messages (sp_configure "sql text pipe max messages", 512) 512 is the suggested value,
must be greater than 0. This defines the maximum number of SQL statements that Sybase tracks at any
given time. You may want to increase this number if you observe a lot of UNKNOWN statements in the Profile
Editor.

+ Statement Statistics Active (sp_configure "statement statistics active", 1)

« Per Object Statistics Active (sp_configure "per object statistics active", 1)

Additionally, perform the following tasks, as necessary:

« If a user does not have mon_role enabled, the user will not be able to access Adaptive Server's monitoring
tables.

« If the monProcess table is missing, the user will not be able to view currently connected sessions.

« If the sysprocesses table is missing, the user will not be able to view information about Adaptive Server
processes.

« If the monWaitEventinfo table is missing, the user will not be able to view information about wait events.

+ If the monProcessSQLText table is missing, the user will not be able to view currently executing SQL
statements.

() These packages should only be installed by the DBA.
Profiling enables you to create a set of launch configurations to store the basic properties for each profiling session

that you run on a regular basis. A launch configuration enables you to start profiling sessions from a single menu
command, rather than re-define configuration parameters each time you want to run one.
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Building profiling configurations

Profiling enables you to store parameters related to specific profiling sessions, in a profile configuration for stored
routines. Multiple configurations can be created for each data source in your enterprise and saved with unique
names that identify them in the application.

() Onall supported platforms, support for stored routines includes functions and procedures. On Oracle,
stored routine support also includes package functions and package procedures.

To create a profile configuration

1. Right-click the data source you want to build a configuration for and select Profile As from the menu, then
choose Profile Configurations. The Profile Configurations dialog appears.
& Profile Configurations

Create, manage, and run configurations

GEX B3 Mame; | TORLARORCLL 102

[trpe Fter test [bts) Profile - T Comman
= [h]i Data Source Profiling Tanget

% i TorLABORCLILG 2 Diaka source: | TORLABORCLIDG_Z (Oracle) w
[l = ered Reutive

[ real application Cluster (RAC) mode

Profile Repositories
) Sawe to disk (L OAR file)

%) Sawe to daka saurce: [ToRLABORCLL g & (Orack) b

Configure data source repositonss from the Profile Reposkories preference page.,

Realtime prafiing

[#] show data while profiling session i in progress

Refrash ntarval: [5 % seconds
l Apply ] l Renvart ]

Filter matched 3 of 3 kamrs
'i?:' [ Profie | [ Tose |

2. Select the name of the data source and modify the parameters on the Profile tab, as needed.

3. Inthe Name field, provide a name for the launch configuration. Select a name that makes the launch
configuration unique and easily identified once it is saved in the application.

4. Inthe Profiling Target area, click Real Application Cluster (RAC) mode if the target database is an Oracle
RAC. This enables you to profile the entire cluster in one profiling session. (In general, profiling a RAC entails
querying the GVS views.)
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(@ When profiling a RAC, you can also filter the profiling details to show only the details for a selected
instance. At the top of the Profiling view, click the Instances list and choose the instance you want
to examine.

5. Inthe Profiling Repository area, choose to save the profile session to disk or if you are profiling an Oracle
data source then you can choose to save the profile session to a data source registered as a Profiling
Repository.

If you choose to save the session to disk, in the Time interval length area specify the length of the profiling
session. When you try to close the Profile Session, you will be prompted to save the file and can then name
the file as desired.

A .oar file saved to disk opens very quickly from File > Open dialog and has a limit of just under 1000 hours of
profiling data. Profiling to a data source directly allows the system to capture more data for a longer period
of time, until you decide to stop the profiling session. The profiling session is automatically saved to the
Profiling Repository where other SQL Query Tuner users can also view the session for their own analysis.

6. Click Apply. The launch configuration is stored in the application.

7. Once alaunch configuration is defined, you can execute it in profiling. For more information, see Running a
profiling session.

() The parameters provided when you select the data source name in the left pane control session
parameters for the specified data source. To set these controls, see Configuring DBMS properties and
permissions.

The following describes fields and options of the Profile tab that require further explanation.

+ Name indicates the name of the profile configuration.

« Data source indicates the name of the data source to which the profile applies.

+ Save to disk/Save to data source gives you the option to save your profiling session to a .oar file which you
can access from within SQL Query Tuner or you can save the profiling session to a data source of your choice
if you are using an Oracle data source. SQL Query Tuner will create a Profiling Repository, similar to the
following on the selected Oracle data source. The structure of the Profiling Repository is created from the
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name of the data source and the date and time of each specific profiling session.
E'EI Diaka Source Explorer &3 |.‘5:E.,*I-' SCL Project Explarer =0

TN

=I-l=F Managed Data Sources (5)
1= IBM DBZ For LUW (1)
=I-l=F Oracle (5]
+- il TORLABORCL1OG_2 (Oracle 10,2,0,3.0)
= TORLABORCL11g_2 (Cracle 11,1.0.6.0)
+ [__f:j Database Objects
= M Profiling Repository
= TORLABORCL1g 2
4, 2012-03-05 15:43:05 (33m)
+- il TORLABORCLII_Z (Oracle 2,2.0,1.0
+ j_ﬁ TORLABSCORCL (Oracle 10.2.0,1.0)
* | TORLAESGLOG_1 (501 Server 10,00, 1600
H-T=F S0L Server (1)
+-1=F Svbase (1)
= Profiling Repositaries

=S| TORLABORCL11g_2
4 2012-03-05 15:43:05 (33m)
+-{il TORLABORCLYI 2

Saving your profiling sessions to a live data source enables you to better organize your profile session data for later
review.

« Time Interval Length indicates how many hours of the session to save to disk. Since the profile session
continues until you manually stop it the session length may exceed the time interval length. For example,
the time interval length is set to four hours but the profiling session continues for 10 hours. In this case only
the last four hours of data is retained. This parameter also indicates the total width of the time load graph.
The longer a profile is, the larger the saved file will be. For heavily loaded databases, the time interval length
value should not exceed eight hours.

The Show Data While Profile Session is in Progress check box enables "real time" profiling, which
refreshes the data of the session as profiling runs. The Refresh Interval specifies how often in seconds
profiling updates this data.

Profiling can run sessions based on ad hoc parameters you designate before executing the profiling
process. However, by building profile launch profiles, it is a much more efficient method of managing
standard, frequent, or common profiling sessions.
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Specify profile alerts preferences during configuration

You can configure DB Optimizer to send you an alert via email if during a profiling session it detects that database
activity has met or exceeded the threshold that you specified.

1. Select Preferences> Profile Alerts.
¥ Preferences (Filtered) @@

Profile Alerts v

= 5QL Development
=8 Profile Alerts
Email Contacts

Ermnail Settings

Mame Conkext Description Mew. ..

Alerts reset after | 5 3 minutes
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2. Tocreate a profile alert, click New.

& Create Profiling Alert

€3 Alert name must be specified.

Marme: | | |

Data source: |TORLAESQLDD_1 (S0L Server 3,0,2039,00 w |

Fire alert when {3_} Ackive sessions meet or excesd '@'
() Sessions in wait! |:| I:I

{:} Sessions in wait class:

{3 8l active sessions not on CPU

Send email when alert Fires
Display system natification when alert fires

Cancel

To edit an existing profile alert, select the alert you want to modify and then click Edit. The Create Profiling
Alert or Edit Profiling Alert dialog appears.
Complete the create/edit profiling alert dialog as required and then click OK.
4. Inthe Preferences tree, click Email Contacts.
If you select Display system notification when alert fires, you will receive an alert notification in your
Windows system tray when the alert fires.
If you select Send email when alert fires, you must specify email contacts and email server settings.

w
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5. To create a new email contact, click New.
To edit an existing email contact, select the contact you want to modify and then click Edit.

% Create Email Contact

@ Specify the details of the contact to add.

Mame: | Jacquie |

Email address: | jacqueline@ermbarcadera. cam |

Data Sources

TORLABSOLOO 1 ¢50L Server 8.0.2039.0)

[] ToRLABSGLOD 1 #7 (SQL Server 5.0.2039.00
[] sfwpclhol.embarcadero.com {Oracle 10.2.0,15
[] TORLABORCLS 3 (Oracle)

[] TORLABORCLS 2 (Oracle 5.1.7.4)

[] ROMLABORCLE L (Orace 5.1.7.4)

[[] ROMLABORCLSI 2 (Oracle 9.2.0.1)

[] TORLABORCLS 1 (COracle)

[] DgUERY {S0L Server)

[] HOBO fsOL Server

[] local is0L Server)

Select all ] [ Deselect all ]

[ 2K ] [ Cancel

6. From the list of Data Sources, select the data sources for which this contact should receive an email
notification that. an alert has fired, and then click OK to save this contact.
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7. To configure your email settings, click SQL Development > Profile Alerts > Email Settings.

% Preferences (Filtered)

| | Email Settings o -

=l 5QL Development Email Configuration

[=)- Profile Alerts
Email Contacts | |

SMTP Hosk:

Email Settings SMTP Part: | a5 |

Sender Address: | |
Authorization Required

IUsernarne: | |

Password: | |

@ [ Ok, H Cancel ]

8. Complete the Email Settings as required and click Apply.

« Sender Address: This is an email user configured on your email server. SQL Query Tuner uses this address to
send alerts to the email contacts defined.
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Specify profile repositories preferences during configuration

Use the Profile Repositories preferences to register and unregister supported version of Oracle data sources as
profiling repositories. A data source must be added to the list of DB Optimizer Managed Data Sources before it can

be used as a repository.
To access the Profile Repositories Preferences

Select Preferences > Profile Repositories.

& Preferences (Filtered) |._”E|®
| | Profile Repositories -
= 5L Development
Profile Repositories Mame Tvpe Wersion | Register
TORLABORCL11g_2 Cracle 11.1.0.6
TORLABORCLS 2 Cracle 2.2.0.1

Apply

@:‘ I H Cancel ]

Register a profile repository

To register a new profile repository

1. Inthe Profile Repositories Preferences dialog, click Register. The Register a data source as a repository
dialog appears and displays the managed data sources that may be used.

& Register a data source as a repository rz|
Mame = Tvpe Version
TORLABORCLIOQ_Z Oracle 10.2.0.3.0
TORLABORCLI1G_Z Oracle 11.1.0.6.0
TORLABORCLS_2 Oracle 9.2.0.1.0
TORLABSCORCL Oracle 10.2.0.1.0

K Cancel

2. Select the data source you want to register as a profile repository, and then click OK.
3. Click OK again.

A data source registered as a profile repository appears in the Profiling Repositories node of the Data Source
Explorer and also has a Profile Repository child node in under its entry in the Managed Data Sources folder.
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Profiling sessions are saved in the repository under a name that is comprised of the date, time, and duration of the

profiling session.

85 Data Source Expl.. 2 = SQLProject Expl.. ~— O
FRefw B~ wd| 28] ~
type filter text
4 [ Managed Data Sources (1)
4 Ha DBPSSQLSerl6 (SQL Server 13.00.1601)
4 [[3 Database Objects
» = Backup Devices ()
- 'ty Databases (20)

| NV

When you next choose to profile a data source, using the Profile As > Profiling Configurations option, you can
specify the profile repository in which you want to save the profiling session data. You can also access the Profile
Repository Preferences from this dialog.

& Profile Co nfigurations El

Create, manage, and run configurations

(TEX 8- Naenie: | TORLABORCLIDG_?
|lif) Profle - [C1 Common
=il Dz Saurce Profiing Target
L Test Dd:asmrcc::TORL.ﬂ.EiORCL‘Bi_E‘{Dratlc} v:

-l TORLABORCLLDG 2
WL TOMIFIRNEYDZ

L] 50t stered Rautine L P s
i Sawe ko disk (MR File)

[ Ireal Apglization Cheter (RACH mode

() Save bo data source: | TORLABOROLS_Z {Oracke) v

Configure dat e TORLABORCLLOg_2 { Orack)
e A S e ¢ GRLABORCLL 1g_2 {Oracke)

TORLABORCLS 2 (Oracle)

Rezal-time profilng
Showe data while profiing s=ssion is in prograss

Refrashinterval; | 5 5  seconds

Unregister a profiling repository
To unregister a profiling repository

In the Profile Repositories Preferences dialog, select a profile repository from the list, and then click Unregister.
Unregistering a data source prompts you to optionally delete all sessions on the repository.
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Unregister repository E'

\:y Do you wank ko delete all sessions on the repaositary?

[ Yes l [ Mo ] [ Cancel

If you choose not to delete the profiling sessions, they will still be available from either the Profiling Repository
node in the data source entry in Managed Data Sources or from the Profiling Repositories node. You will not be able

to save profiling sessions to the unregistered repository until you register it.
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Using SQL Load Editor/Tester

File Edit Search Preferences Window Help

Hee g @ B ES BB 0

IDERA DB Optimizer 18.1.x

Run the load editor by using either File > New > SQL Load or with the New SQL Load icon shown above in the red

square.

The icon depicts an RPM meter on a car with a red line. The idea behind the icon is that we canrunaload on a

database and stress the database with the load similar to red lining.

M TORLABSCORCL M TORLABDEZSY _1 A *Untitled SGL Load &3 10

il TORLABORCL11g_2 change data source

®adhoc sQL () SOL file

begin Mumber of parallel sessions:
for o in (select id from outel
for i in (select id from [+] Execution end condition:
null; lC‘B‘Til‘l‘u&: 0 : hours
end loap;
end loop: 10 2% | minutes
end; .
,.-’| " Mumber of executions:

Sleep between executions
(%) Fixed delay: 250

(") Random inkerval;

= 0

15

4

< » >

The load editor page has space on the left to show the SQL to be run. The SQL can be typed in or pasted in or read

from a file if the SQL File option at the top right-hand side of the window is selected.
On the right are options on how to run the SQL:

« Number of parallel sessions
+ Length of test
« Number of executions
+ Sleep between executions
+ Nosleep
+ Fixed sleep
« Random sleep between a max and min
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Methodology

Write SQL with Editor

Set up Load with Load Editor

Kick off profiling the database

Run the load in the Load Editor

5. Verify the database load profile to see if there are any major issues

b N =

The SQL Load Editor/Tester enables you to configure and execute SQL code against a data source.

This feature enables you to specify a data source against which the code will be executed, and then provides
options that enable you to choose a period of time that you want the script to execute for, and at what intervals the
execution "loop" occurs.

On execution, SQL Load Editor/Tester runs in the background. It can therefore be run in conjunction with a profiling
session in order to analyze the effects of the executing load against the specified data source. Once you run a SQL
script via Load Editor, you can start the SQL Profiling function and analyze the results of the load.

The SQL Load Editor/Tester is accessed via the New SQL Load icon on the Toolbar:
File Edit Search Preferences ‘Window Help

O (g B e EE 0 i

When you open SQL Load Editor/Tester, click Select Data Source to specify the data source against which you want
the SQL script to run.

Choose Ad hoc SQL and manually type (or copy/paste) the SQL code into the window provided, or select SQL file
and navigate to the SQL file you want to run. The window populates with the code from the selected file.

The following configuration parameters are set with SQL Load Tester/Editor prior to executing the SQL script:

Configuration Parameter Description

Number of Parallel Sessions Specifies the number of jobs that the execution script will operate
on.

Execution End Condition Specifies if the script execution process runs for a set amount of

time or script executions.

Choose Time if you want the script to execute over a specific
period of time, or Number of Executions if you want the script to
execute a specific number of times.

Sleep Between Executions Specifies if Load Editor will wait before running the execution
script again. Select the check box and choose Fixed Delay or
Random Interval, depending on whether you want the script to
execute at a specific time, or at random intervals within a
specified range of time.

To run Load Editor

1. Access SQL Load Editor/Tester by selecting the icon on the Toolbar. The SQL Load Editor/ Tester opens.
2. Click Change Data Source and choose a data source you want to run the SQL code against.
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3. Choose Ad hoc SQL or SQL file, and then copy/paste or manually type the code you want to execute in the
window provided, or navigate to the location of the file, respectively.

4. Intheright-hand panel, choose the execution configuration parameters to specify how you want SQL Load
Editor/Tester to handle the script.

5. Click the Execute icon in the lower right-hand corner of the screen. The script starts to execute against the
specified data source, using the configuration parameters you selected.

6. If you are profiling a data source, start and run a new profiling session on the data source you specified in
Load Editor. The session will reflect how your SQL script executes against the specified data source.
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Using tuning

This section provides information on tuning, its functionality, and is structured so a user can follow the information
provided to fully tune their enterprise in terms of more efficient query paths at the SQL statement level of individual
data sources.

Tuner has three parts:

+ Query rewrites and quick fixes
+ Alternative execution plans generated via optimizer directives
+ Analysis of Query showing:

+ Indexes used, not used, missing (suggested to create)

«+ Graphic display of query

The SQL tuner takes a query and adds database optimizer directives to change the execution path of the query. A
list of all the unique execution paths is generated with all duplicates eliminated from the list. The final list of
alternative paths can be executed. Any path that takes more than 150% of the base case will be canceled because
we are only interested on paths that could be faster than the base case so no need to waste time and resources
continuing to run cases that are slower than the original. After the cases have been executed they can be sorted in
order of elapsed time. If a better path is found then those optimizer directives can be included in the original query
to achieve optimal response time.

You can save the entire content of a tuning job for later analysis or for sharing with other users. This section
contains the following topics:

» Understanding the tuner interface

« Tuning SQL statements

« Using platform-specific features

« Additional tuning commands

+ Configuring tuning

» Examples of transformations and SQL query rewrites
« DBMS hints
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Understanding the tuner interface

In the application interface, tuning is composed of two tabs:

« Overview
+ Analysis

() When using tuning on Oracle sources, several additional tabs appear on the Analysis and Outlines tabs. For
more information on utilizing these extra features, see Using platform-specific features.
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Understanding the Overview tab

Inputting SQL to tune
Click the SQL button on the Overview tab to specify the source of SQL statements you want to tune.

ek Tunrg 6 5 Psckers) | =g

b ey drscle b SR TORLABOACLLLG 2(LL.1.0.6.0]

| B Drverview | b Analyses I

== Duverview T

_ Tj Mews S0L Terst . -

Tuning Slatements [+#] Geree st asas [Crerfoem delal anckysis []iosase each g [0 Estract from Dekabase Ohgect tﬂ {!j

|"'3 Tropoet From Fle: (tetorksance)
[s2 Tt From: Fiks (Suskam)

Fy Soan Qradle 5G4 R

Stabement Tirre
Hame Schema Ta=t Tables Wi Elepma] (=] I ceeed [4)

+ New SQL Text: From the SQL button menu, select New SQL Text, and then copy/paste SQL statements to
the SQL Text dialog or write queries by hand. Click OK.

& sl Text =13

SELECT »
L.COMPANTY,
.PAYGROUFP,
.OFF_CY¥CLE,
.SEPCHK_FLAG,
. TA¥ METHOD,
.TAX PERIODS,
.RETROPLY ERNCD,
SUM (C.AMOUNT DIFF) SUM_ AMOUNT
FROM
PS_FPLY CLLENDAR A,
WE_JOB B,
WE_RETROPAY EARNS C,
PS_RETROPAY RQST D,
PS_RETROPAYPGM TEL E

LT oo I o I = I I

WHERE
L.RUN_ID = 'PDZ' AND
L.PAY CONFIRM RUN = 'H' AND
BE.COMPANY = A.COMPANY AND
E.PAYGROUP = A.PATGROUP AND
E.OFF CYCLE = A.PAY OFF CYCLE CAL IND
B.EFFDT = (SELECT /#+ gb nams(wbh ki) */

£

[ K, l [ Canicel

() Youcan also input SQL by clicking anywhere in the Tuning Statements area and pressing Ctrl-V.
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Once you have input the SQL and click OK, you can later edit the text by right-clicking an entry in the Tuning
Statements area and selecting Edit.

+ Extract from Database Objects: Search for and then select (Ctrl-click) data base objects containing SQL
that you want to tune from the selected data source. SQL Query Tuner will search through the database to
find objects matching your input and presents matches for you to choose. In order for this option to work,
you must enable Data Source Indexing in the properties for the database. If the data source has not already
been indexed you will receive a message indexing that no indexing information is available. You can
configure the database Properties dialog from the Data Source Objects Selection dialog by clicking
Configure data source indexing.

& Data Source Ohjects Selection i:.@

Enter object name prefix or pattern {7 = anw character, * = any string): -

E |

Matching objects:

& COUNT_TIME_INTERYAL (Package) - SYSTEM A
~“DEMS_REPCAT AUTH (Package) - SYSTEM
% DRG (Package) 3
~2 DRGS (Package) - SYSTEM
352 (Package) - SYSTEM
% DRGSS (Package)
L SEMP_ACTIONS (Package) - SYSTEM
L CRAN MEAT CATA Ml mms 1

Configure data source indexing. ..

@ [ Ok ] [ Cancel

For information on setting data source indexing properties, see Specify Data Source Indexing Preferences.
« Import from File (Workspace) and Import from File (System): Browse the workspace or file system and
select an SQL file from which to extract statements to tune.
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« Scan Oracle SGA: For the Oracle platform only, you can also scan the System Global Area (SGA) for
statements to tune. Bind variables are extracted automatically.

& Scan SGA

SGA filters
Specify the filtering criteria For active SGL in the 5G4,

Filker Criteria

Maximum retrieved queries:f‘| =
Sark by CPU Time v|
Advanced Filters

User: | e |
Parsing Schema:

Maodule: | b |
Action: | b |

Service:

+ You can also drag and drop Materialized Views, Procedures, and Views from the Data Source Explorer to the
Tuning Statements grid and they will be added to the list of statements to tune.

Running a tuning job

Once you click the Run Job icon on the top right-hand side of the Overview tab, the Overview tab provides the list of
statements that were analyzed by the Tuner, as well as the cases suggested by the execution process to improve
them. Additional information may include statement Name, Text, Source, Cost, and Elapsed Time values,
depending on the platform.

Only the Elapsed Time statistic appears on all supported platforms. On Oracle and DB2 LUW platforms, Execution
Statistics and Other Execution Statistics columns will appear. When determining the best possible path using the
Overview tab, it is best to use the Elapsed Time value as the guideline. The faster the path, the more optimized the
query will become.
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There are three tuning options to choose from before clicking Run Job:

« To analyze the SQL statement, click Generate cases.

« To perform the analysis that populates the Analysis tab now, click Perform detail analysis. Otherwise, the

analysis tab is populated when you click the Analysis tab.

To have the system generate execution statistics, click Execute each generate case and then select the

number of time the system should execute each generated case. Multiple executions can verify that the case
results are not skewed by caching. For example, the first time a query is run, data might be read off of disk,
which is slow, and the second time the data might be in cache and run faster. Thus, one case might seem
faster than another but it could be just benefiting from the effects of caching. Generally, you only need to
execute the cases once, but it may be beneficial to execute the cases multiple times to see if the response

times and statistics stay the same.

Creating tuning reports

After tuning SQL you can create an HTML or PDF Report of the tuning session. You can choose the details to include

in the report.

1. Atthetop right corner of the Tuning tab, click the Export Report button.

[1t] TORLABORCLIDG 2(1)  |BL] TORLABORCLIOG 2.0ar L] *Unkitled Tuning Job £3 [ Select.sql i
P o} Oracle ¢ i TORLABORCL11g 2 (11.1.0.6.0) L-]'
I =N
» Overview P Analysis
EE Overview R f— ®
Tuning Staten [¥] Generate cases [ pesform detai ac [(] Execute each generated case | 1 =

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

186


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

The Export a Tuning Report dialog appears.

¥ Export a Tuning Report

Export a Tuning Report

Configure and export a tuning report in various formats, Q

Report Title: | Data Source Tuning Report

Report Descripkion: '

Turing Cases . Configuration | )
Generated Cases Exec... | Anal.,

Mame

= © 10j26 (16 fil. .
[ NO_INDEX &) 0f3 (3 fikered)
[¥] INDE¥_S55 ©) 0f2 (2 fikered)

IMDEX_FFS
FIRST_ROWS
=[] [Missing a valid join ¢ £
[JUSE_ML
] ORDERED &

Sf16 (11 Filker... =

01 {1 filkered)

I 0 O 1 W 0de F@ Filkavedy I_
General Report Options

Farmat Layout Paper Size

() POF (*) PORTRAIT (&) Letter (8.5 x 11, 216 x 279)

I HTML () LANDSCAPE () Legal (8.5 14, 216 = 356)

() a4(8.3x11.7, 210 x 297)
Use default export location
- B i S DASE

@, [ Export ;] [ Cancel

2. Enter a Report Title and Description.
3. Onthe Tuning Cases tab, choose the cases you want to report on. Click the + to expand the cases.
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4. Onthe Configuration tab, choose the content you want to include in the report.

¥ Export a Tuning Report

Export a Tuning Report l!-"

Configure and export a tuning report in various Formats, A\ ?
Report Title: Dal:g Sga..tce.Tunin_g Rgpurt_ -
Repork Descripkion:

| Tuning Cases | Configuration |

>

|:| Furn full job prior to generating report
Cwverview Information
Execution Details

Cost

Execution Statistics

[ ] Other Execution Statistics

SQL Text =

5. Select the General Report options, enter the location for the report, and then click Export.
You will see the progress of the report generation in the Progress pane.

3 Progress 5 % ~ — O
' Generating tuning report...
| O Sewew )

Skreaming data to report cache...

When complete, the report is stored at the top level of your workspace.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

188


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

Areport in PDF format will resemble the following:

IDERA DB Optimizer 18.1.x

Bookmarks [

E- B —

[F 2 - Data source:

.
\\_. Data Source Tuning Repart

| 5 | D

[F 2- cherview
B{F - cass SELECT 1 Teest mport

1 - Data source:

4 March & 2012 10T AM

Harms: TORLABORCLING 2
Flaiform: e 111000
Tusing Job Haa: Uriged Tuning kol
2 - Cwerview

Hare Souroe Schwra  Tast

3 - Case SELECT 1

ZEIECT 1 ComiomCms ZSYSTEM  asdectrom MR EWPLOTEES HM DEFARTHE

sbb Ve Elaned  bprowsd Camn InZazen
Timswx) Tessjy)  Anaigmed  Amsbhoed

3.1 - Generaled Cases

Mars Tart

FIAST_FOWE
Tramizenatan
MOEX_FFS
MDEE 88

32 - 800 Text

FELECTH 2ot from HA EMPLOYESS, HA DEFRATMENTS

Cowt  Flagsed  Aowe
Rt T {51 Rtamid
g
an
Ean

HELECT"

FROM
FRSMPLOYEES.
HRUDEPARTHENTS

3.3 - Case FIRST_ROWS

3.1 - Genarated Cases

Hars (=

FIRET_ROWG

3.3.2 - 8OL Text

Caet Swsed  Rows
Rt Tonefs)  Retersed

51 BT s FIRST_ROWS{ 1037

"
Lo o s
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Understanding the Analysis tab

Index analysis is started when you either generate cases with Perform detail analysis selected on the Overview
tab, or when you click the Analysis tab. If any columns referenced in the WHERE clause of the tuning candidate are
not the first column of an index, tuning will recommend that you create an index on that column.

The color-coded Index Analysis feature highlights missing indexes as well as shows which indexes are used and
which are not used in the default execution path. The Index Analysis feature highlights issues where the database
optimizer might not be using the preferred indexes. DB Optimizer also lists indexes on the tables that do not have
fields in the WHERE clause helping the designer to see if adding an additional predicate in the WHERE clause might
make use of an existing index.

| by orack b S TORLAESCORAL (10.2.0.1)

> Overview | & Analysis |

B SOL Analysis Selsct stabameed of inbarest: | SILECT | 1 w || > ROOT ¥ el B ®

ra
|SELECT a

£* ML o o | g
e.employee 14,

]
on_id, |_Eh-IFL ES{E

g
e.wanazer id,
e.deparcmentid,
d.locst il:lr._id,
1.l:|:|u.r.\ut.l::r-_.'i.n:'lIl 2
e.fir=t_nams, 3 DERARTIENTS (D)
e.last n=me,
e.=alary, :
= comel ss:i.nn_pct . {}- hL
d.departwent name,
J.Jnh_r.'.ttle,_ IEL':'CET[D"'-E L] 3
l.eity,
l.otote_provinoe, Ll
CLEOURTEY_homme,
r.reglon nage
.TR‘:‘H - r 3 C IES |:|::| g
! 2
oA
Index dnztysis | [ Table Sketistics| 52 Column Satistics Ard Fistograms | ] Outines
Collect ard orest= ndex=s .1.'{« [ E'_',
i Ik Kame Teble Cwner Tatle Hams Calumn Mlams Indes | Thisindas 15 dafined on a colurn
| v Doountry_c_o_pe HF. COUNTALES COLKTRY 1D Uicus presin 'E;Ef&‘;?dﬁéﬁfm?ﬂj
| o [CICEsT Location o HE: 4 DERARTMENTS LOCATECH_ID Hormal when you i bhe statemerk,
o [ o P HE JoES I8 10 Unigus — i
| o [JLoC_couTry 1 HR Lo ATIONS COUNTRY _ID Tuermal 1
I o [REG_ID_FE HR REEICHE REGICN_ID Lrigue 5
|_ DEPARTHERTS CEFARTMENT [0
| W Mess meoaoTaasmy 1w ERAE SiE RS FEAAETIMERT 1 Flrarnal
%

The layout of the Analysis tab shows the SQL text and Visual SQL Tuning (VST) diagram on the top and the indexes
on the tables in the query below.

The Analysis tab has five important components as depicted in the previous illustration:

1. Statement selector, if there are multiple statements in the tuning set. Here you can select the statement
and the generated case you want to analyze.

2. Statement text for selected statement.

Graphical diagram of the SQL statement.

4. Index analysis, statistics, and settings relating to the SQL statement and referenced elements.

w
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5. Description of the selected index, including the reasoning behind DB Optimizer recommendations.

() Tabs are platform-specific. For example, against Oracle data sources, Table Statistics, Column Statistics
And Histograms, and Outlines tabs are available. For more information, see Using platform-specific

features.

() Thetext, diagram, and analysis sections can be resized or expanded to take up the whole page.

The Analysis tab suggests missing indexes, indicates which indexes are used in the execution path and lists all
indexes that exist on all the tables in the query. Indexes on the table are listed on the Analysis tab and color coded

as follows:

Text Color Interpretation
- Index is used in the query
I Index is usable but not used in the current execution path.

This index is missing. DB Optimizer recommends that you create this
index.

e This index exists on the table but not usable in this query as it is
written.

In the Collect and Create Indexes table, orange-highlighted entries indicate missing indexes that DB Optimizer
recommends be created to improve performance. Clicking on that index, displays text to the right outlining the
rationale behind this recommendation.

For more information on using the Analysis tab, see Using the Analysis tab.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal
191


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

Tuning SQL statements

Atuning job enables you to view the cost details of SQL statements on a registered data source and then select the
best, or most efficient, array of execution path directives in order to make query execution faster, therefore
improving the entire enterprise, overall.

Atuning job consists of a set of SQL statements and any analysis results you generate against a data source using
tuning. The SQL statements and analysis results that compose a tuning job can be saved in a tuning file (.tun). This
enables you to open a tuning job at a later time for inspection and analysis, to add, delete, or modify the SQL
statements, or generate new execution statistics.

The following topics provide a high-level overview of the tuning process:

1.

ouhswN

©

Create a new tuning job
Specify a data source
Add SQL statements
Run a tuning job
Analyze tuning results
Modify tuning results

For additional commands that fall outside the general tuning workflow, but may still be helpful,
see Additional tuning commands.

For information on working with data sources such as adding and browsing them, see Working with data
sources.
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Create a new tuning job

You can create a new tuning job via the File > New > Tuning Job command, or by importing statements directly
from profiling. The New Tuning Job icon is also available on the Toolbar.

To create a new tuning job via the Menu or Icon command

Select File > New > Tuning Job, or click the New Tuning Job icon on the Toolbar. Tuning opens.
You can now proceed to set up the parameters of the new job.

To create a new tuning job from profiling

After you have run a profiling session, in profiling's Profiling Details tab, select one or more statements, right-click,
and select Tune from the context menu. Tuning opens, pre- populated with parameters based on the statements
you selected.

To open an existing tuning job
Navigate to the SQL Project tab and double-click the name of the existing tuning job.
To name a job, save it

Ensure you specify a meaningful name that identifies the job in other views and dialogs. You can save the job by
selecting File > Save or File > Save All from the Menu bar. Once a job is saved, it is added to the SQL Project view.
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Specify a data source

The bread crumbs at the top of the tuning job window identify the data source where the SQL statements to be
tuned reside. The default data source is the one that was selected when the new tuning job was initiated. For
example, in the following image, we see that the data source is TORLACSCORCL, which is part of the Oracle data
source group. The color of the bar at the top of the tuning window shows the category of the data source as defined
in the data source configuration properties.

b ot} Oracle b i) TORLABSCORCL (10.2.0.1)
= Overview F-" Analysis
= Overview
You can change the data source of a tuning job by clicking a bread crumb triangle and then navigating to the data

source or using the filter to locate and then select a data source. In the following screenshot, Microsoft SQL Server
was clicked and T was entered in the filter text area, which resulted in several matches.

= =F Data Source Group
=I-1=F Microsoft SQL Server
=l-1=F Microsoft SQL Server

SO} TORLABSOLOD_1
&l TORLABSQLOD_1_#+'™)

Click the name of the desired data source to affect the change.

() Multiple tuning jobs can be saved against the same data source. You can therefore set up your tuning jobs
organizationally. You might for example, set up a tuning job to tune only SQL associated with procedures
or a set of SQL sources that are functionally related. Alternatively, your tuning jobs may be organized by
application.
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Add SQL statements

Once you have created a tuning job and named it, using File > Save As, you need to add SQL statements to the job
that are to be tuned. All standard DML statements can be tuned (SELECT, INSERT, DELETE, and UPDATE as well as
MERGE on SQL Server 2008 and higher).

Statements are added to tuning via the Overview pane.

5 Hekbed Tuning Job B3 7% Seket el ]
b orfydracle b SH TORLABORCLLIG Z{11.1.0.6.0]

b Dverview ] P analyss 1
== Dverview FifE: .[h‘ | @

) e *

Tuning Slatenenls &utr:b:sl.,d}:u DO\:ﬂ'.I'IIIIH.didld’_".\b [Climoie earhg E Estract fram Database Ohect ':j *-_l__l
e Trpeet From Pl (Rorksaoce)
[se Treoet From Pl (Sustamy
F SCan Oracle 5G4  EE—

Sabsment Tirre
Hasis Scheina i Ta=t ________'I'_e_ll_lgb;_ e Elama] {2 _El_l,;rl.r.-ed_lg:l_

There are several different methods for adding SQL statements to a job, as reflected by the option in the New SQL
text menu.

+ New SQL Text enables tuning via manual entry, or cutting and pasting into the tuning window.

« Extract from Database Objects enables you to select stored SQL from the data source to which you are
connected. You can either drag and drop objects from the Data Source Explorer or you can add database
objects matching specified filers. For example, entering t in the filter area of the Data Source Objects
Selection dialog, can match functions, materialized views, procedures, and views, whose name begins with
t. You can then drag and drop the matches from the Data Source Explorer to the Tuning Statements grid.

« The Import from File (Workspace) and Import from File (System) options enables you to choose an SQL
file saved in your workspace or elsewhere on your computer or network.

« The Scan Oracle SGA option is available for the Oracle platform only. It enables you to scan for and select
active SQL in the System Global Area (SGA). For more information, see Tuning SQL statements in the System
Global Area (Oracle).

To add an ad hoc SQL statement:

Select the New SQL Text option and manually type an SQL statement in the window, or copy/paste the statement
from another source.

To add a database object:

1. Select the Extract from Database Objects option.

The Data Source Object Selection dialog appears where you can search for and then select the object you
want to tune.

2. Type an object name prefix or pattern in the field provided. The Matching objects window automatically
populates with all statements residing on the specified data source that match your criteria. Database
objects include functions, materialized views, packages, package bodies, procedures, stored outlines,
triggers, and views.

(@ Inorderto find matching objects, data source indexing must be enabled. To enable data source
indexing, click Configure data source indexing, select Enable indexing, and then click OK.

3. Click the object you want to add. Ctrl-click to add more than one object to the job.
Click OK.
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() Alternatively, after clicking the Database Objects tab, you can drag and drop objects from Data
Source Explorer into the Database Objects window. As long as the dragged object is a valid object
type, it will be added to the Database Objects tab.

To add an SQL *file*

1. From the New SQL Text menu, select either Import from File (Workspace) or Import from File (System),
depending on where the file you want to add is stored:
» Workspace files are files that reside in the application, meaning project files or other objects
generated or stored in the system.
« File System files are files that reside on your machine or the network.
2. Select afile from the dialog that appears. It is automatically added to the job.

To add SQL from the Oracle SGA

1. From the New SQL Text menu, select Scan Oracle SGA.
2. The system scans for SQL text which you can filter on the Scan SGA dialog that appears.
3. Choose the statement to be tuned and then click Finish.
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Managing bind variable errors

When you try to tune a statement containing a bind variable you will be warned that either the type is not set or the
value is not set. Mouse over the error to learn what problems were detected.

L& *Moview Tuning Job.t 2] *Untitled Tuning Job i) TORLABDEZ97_1 L8] *Untitled Tuning Job |21
b £F} IBM DBZ for LU [J§] TORLAEDE297_1 (09,07.0003)

P> P

'@ Overview 30 erors detected

SELECT 1: The value is nok sek for DECHAR
Tuning Statements [«/3ELECT 1: The value is not set for DEDATETIME )
SELECT 1: The value is nok set For DEDECIMAL
SELECT 1: The walue is nok set for DEINTEGER
SELECT 1: The walue is not set for DBMUMERIC
SELECT 1: The walue is nok set For DEREAL 1

Marne Sch

SELECT 1: The value is nok sek for DESMALLIMT i
E N S I T SELECT 1: The value is nat set For DEYARCHAR |
5['553 SELECT 2 SELECT 1: The vwalus is not sef for dbchar ;
5.;53 SELECT 3 SELECT 1: The value is nok set for dbdatn_atlme
5!: SELECT 1: The value is not set For dbdecimal
ﬁ!] SELECT 4 SELECT 1: The value is not set for dbinkeger
561 FAccicerc SELECT 1: The walue is not sek for dbnumeric

SELECT 1: The value is nok sek Far dbreal
SELECT 1: The value is nok set For dbsmalling
SELECT 1: The value is not set For dbwvarchar
SELECT 2: The walue is nok set for DEREAL
SOL[SELECT 2: The walue is nat set For dbreal
SELECT 3: The walue is not set for dbdouble

Generated Cases

L

You can use the Bind Variable Editor to set the types or variables.
1. Click the Edit Bind Variable icon as shown below.
ala- 1B @

The Edit Bind Variables dialog appears.

IDERA|Products|Purchase|Support|Community|Resources|About Us|Legal

197


http://www.idera.com/
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
https://idera.secure.force.com/
http://community.idera.com/
http://www.idera.com/resourcecentral
http://www.idera.com/about/aboutus
https://www.idera.com/legal/termsofuse

IDERA DB Optimizer 18.1.x

& Edit Bind Variables

Edit Bind Variables SAL
Manage bind variable data types and vahies. D_J
All Tuning Statements
hlame | ML Data Type Yalue

DECHAR a character
DEDATETIME O  timestamg
DBOECIMAL a decimal
DEINTEGER O  wteger
DEMUMERIC a decimal
DEREAL O  smalint
DESMALLIMT a real
DEVARCHAR O varchar
dhbigint a biqird
dbchar a character
dbdatetime O  dae

= [ || dodecimal a decimal
dhdouble O  double
dbfloat O float
dhinteger a inkeger
dblongchar a long varchar
dbrumeric a ALMEric
dbreal O real
dbsmallint O smalink
Al Finna 1 Firna

g

You can either set the bind variables for all tuning statements at once or you can set the bind variables for
each select statement individually. If you set the bind variable in the All Tuning Statement section, you can
still override that setting for an individual select statement.

2. Set the bind variable by clicking the Null box, clicking in the Data Type column and selecting the data type
from the list, or by clicking in the Value column and entering the value.

3. If you want to set the bind variable for an individual select statement, click the expand button to see all the
select statements. The expand button is marked with a red box in the previous image.

SELECT 11 { select from MOVIES, CUSTOMER, MOVIES MOVIEREMTAL )

Mame MLILL Dakta Type Walue
CECHAR _ character " -
dbichar O date A
dtl h integer =
ongenar O bigirit
blob
boolean W

-
In this manner you can set the bind variables from all tuning statements and then override that setting by
setting the bind variable for a specific select statement.

You may find it easier to set the bind variables when you can see the tuning statement. In the Generated
Cases section, you can double click a statement and an editor appears where you can edit the SQL
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statement and set the variable data types and values.

e - SELECT 1
Edit Tuning Statement SAaL
ok e S0 shatement best a5 wel 25 manage vanzble data Dypesivalues, U']
fELECT -~

cE.customer id,
o Liracnane,
. Lastnsms .
i .rentalid,
i Auedate,
B Totaleharge,
1. 1oomnminst
FRON
AV IES . customer o=,
AOVIES . movierental mo,
HAOVIEZ.centalitem ©i,
|3ELECT
DISTINCT
AV (vocsloharge] COLI1O
FROM XOWIES .movierental) T3l
WHERE
oa FIRSTHAAE = dhohar ARD
oa.Eip > odbvarchar LND

rlh=mal lane ¥ o= oen=comesrac BRER t
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Run a tuning job

As you add SQL statements to the job on the Overview tab of the tuner, tuning-supported DML statements (SELECT,
INSERT, DELETE, and UPDATE as well as MERGE on SQL Server 2008 and above) are parsed from the statements and
added to the Overview tab in preparation for the tuning function execution.

Each tuning source statement is listed by Name, Schema, Text, Tables and Views. For SQL Server and Sybase
platforms, there is also a Catalog column. Additionally, each statement will have Time and Analysis values that
approximate how efficiently they execute on the specified data source.

In the Generated Cases area of the Overview tab of a tuning job, the Cost and Execution Statistics columns let you
compare the relative efficiency of SQL statements or statement cases. While the explain plan Cost for a statement
or case is calculated when you add SQL to a tuning job, the Elapsed Time and Execution Statistics (and Other
Execution Statistics columns, if available) columns are not populated until you execute that statement or case.

If the Tuning Status Indicator indicates that a statement or case is ready to execute, you can execute one or more
statements on the Overview tab. Alternatively, the Tuning Status Indicator may show that you have to correct the
SQL or set bind variables before you can execute.

Once the tuning job has run, the Overview tab provides a series of cases, per statement, that you can select and
modify based on your results.

In some cases, automatic case generation might be disabled (via the Preferences panel). If this is true, or if you have
otherwise modified the Generated Cases table and can no longer generate a specific case, you can instead explicitly
generate a case for specific statements.

Execute each generated case | 1 * | times b f/j )

To execute a tuning job

1. Ensure you have registered and selected a data source. For more information, see Register data sources and
Specify a data source.
2. Ensureyou are connected to the database by double clicking the database name in the Data Source
Explorer.
Click the tuning icon on the toolbar, or click File > New > Tuning Job.
4, Onthe Overview tab, specify the SQL you want to tune:
+ Modify the number of times to execute each statement in the Execute each generated case field at
the top right of the tuner, as needed.

w

5. Click the execution button ["'f) ] on the right side of the case generation field.
6. The tuning job runs, exacting and analyzing each statement and providing values in the appropriate
columns.

To explicitly generate a case for a specific statement

1. Ensure you are connected to the database by double clicking the database name in the Data Source
Explorer.

2. Click the Overview tab.

3. Inthe Generated Cases area, right-click in the Name field of a statement or transformation case and select
Generate Cases from the context menu, or click the Overview Run Job icon. The specified case is
generated.

To view the generated cases for a specific statement

1. Inthe Tuning Statements area, click the checkbox to the left of the tuning source statement name.
A check mark appears in the checkbox and the cases displayed in the Generated Cases area are filtered to
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Analyze tuning results

Once you have executed a tuning job, the Overview tab reflects tuning analysis of the specified statements. The
Analysis tab shows the resulting analysis of the query, including indexes used, not used, and missing (or suggested
to create). For more information on using the Analysis tab, see Understanding the Analysis tab.
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+ The Generated case Expand/Collapse control lets you hide or display the hint-based cases and
transformation-based case generated for a statement.

« The Perform detail analysis and Execute each generated case check boxes let you enable multiple
statements or cases for simultaneous execution while the Run/Cancel Job controls let you start and stop
simultaneous execution.

+ Use the Schema and Catalog Selectors to select a schema and catalog for the tuning job.

The catalog selector is available only for SQL Server and Sybase data sources. By specifying the schema and
catalog, the tuner can use the paths of the schema and catalog selected to find the tables queried in the job
rather that use the paths of the schema and catalog used to connect to the data source. If you change the
schema or catalog used in a tuning statement you will need to refresh the tuning statements in order for new
cases to be generated, which take into consideration the schema used. Right-click a tuning statement, and
then select Refresh Tuning Statements.

+ The Column set Expand/Collapse controls let you expand a column set to display more of the columns
within the table.
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« The Tuning Status Indicator indicates whether a statement or case is ready to execute or has successfully
executed. The following table provides information on the Tuning Status Indicator states:

Icon Description

Ei The case has not been executed. There are no errors or warnings and the case is
ready to be executed.

5= The case has been successfully executed.

[ =) Execution for this case failed or was cancelled due to execution time exceeding 1.5 of
original case time.

Hovering the mouse over the Tuning Status Indicator displays a tip that notes the nature of a warning or error.

® If a warning " indicates that one or more tables do not have statistics, you can right- click the statement
and select Analyze Tables to gather statistics. A warning may also indicate that the tuning statements are
out of sync, in which case you can right-click a tuning statement and select Refresh Tuning Statements.

A warning can indicate an object caching error. For example, a table may not exist or not be fully qualified. Cases
cannot be generated for the associated statement.

« The explain plan-based Cost field can be expended to display a graphical representation of the values for
statements or cases. Similarly, after executing a statement or case, the Elapsed Time field can be expanded
to display a graphical representation. The bar length and colors used in the representation are intended as
an aid in comparing values, particularly among cases. For example:

D.?B ——
1.843 I
0,655 EE
0,499 E
0,797 R

0.8z8

In the case of both Cost and Elapsed Time, the values for the original statement are considered the baseline
values. With respect to color-coding for individual case variants, values within a degradation threshold
(default 10%) and improvement threshold (default 10%) are represented with a neutral color (default light
blue). Values less than the improvement threshold are represented with a distinctive color (default green).
Values greater than the degradation threshold are shown with their own distinctive color (default red).

With respect to bar length, the baseline value of the original statement spans half the width of the column.
For child-cases of the original statement, if one or more cases show a degradation value, the largest
degradation value spans the width of the column. Bar length for all other children cases is a function of the
value for that case in comparison to the highest degradation value.

() Forinformation on specifying colors, and the improvement threshold and degradation threshold
values used in these graphical representations, see Specify Tuning Job Editor preferences.

Additionally, once results have been generated you can:

« Compare Cases. For more information, see Compare Cases.
« FilterandDeleteCases. For more information, see Filter and Delete Cases.
« VisualSQLTuning. For more information, see Visual SQL tuning.
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« CreateanOutline. For more information, see Create an Outline.

Compare cases

You can compare cases between an original statement and one of its tuning-generated statements, or another
statement case via the Compare to Parent and Compare Selected commands, respectively.

& Compare Statements g @E]
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To compare a case side-by-side with its parent
Right-click in the Name field of a case and select Compare to Parent from the context menu.
To compare two cases

Select the two cases, and then right-click in the Name field of either case. Select Compare Selected from the
context menu.

Filter and delete cases

You filter cases from the Generated Cases table via the Filter icons on the Generated Cases Toolbar of the Overview
tab.

+

e,
T

+

Filter the cases on the Overview tab so that hints that are not improvements on the original statement are not
displayed. You can filter:

+ Non-optimizable statements
« Optimized statements
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» Worst cost cases
+ Worst elapsed time cases

When filtering, the criteria remain in effect until you change the criteria. That is, as new cases are generated, only
those cases that do not satisfy the filtering criteria are displayed. To restore an unfiltered set of cases, open the
Filter dialog and deselect the filtering options.

When removing cases, the criteria you set has no effect on cases subsequently generated.
To filter cases from the Overview table

1. Click the Filter button, respectively. A Filters dialog opens.
2. Use the check boxes to select your filtering and then click OK.

To delete cases from the Overview table

1. Right-click on the row of the case you want to delete and select Delete. A Delete dialog opens.
2. Usethe check boxes to select your filtering and then click OK.

When removing cases, the criteria you set has no effect on cases subsequently generated.

Create an outline

If SQL is executed by an external application or If you cannot directly modify the SQL being executed but would like
to improve the execution performance, you can create an outline on the Oracle platform. An outline instructs the
Oracle database on the execution path that should be taken for a particular statement.

To create an outline for a change suggested by a case

1. Onthe Overview tab of a tuning job, right-click in the Name field of a case and select CreateOutline from
the context menu.
A NewOutline wizard opens.
2. On the first panel, provide an Outlinename, select an Outlinecategory, and then click Next.
A Preview Outline panel opens previewing the SQL code to create the outline.
3. Select an Actiontotake option of Execute or OpeninnewSQLeditor and then click Finish.
For more information, see Using the Outlines tab (Oracle).
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Modify tuning results

As you add SQL source to the Overview tab of a tuning job, the supported DML statements are automatically parsed
out and a numbered statement record for each statement is added to the Overview tab.

Cases generated from tuning candidates are alternative forms of the original statement that have been optimized
or otherwise "fixed" by the tuning function. Once you have executed a tuning job, tuning automatically generates
all SQL optimizer hint-based variations that can be applied to the statement: If you change the schema of a
statement

« All SQL Optimizer hint-based variations that can be applied to a statement.

+ Atransformation-based case, if any of the eight common quick fixes can be applied to an SQL statement.
This feature leverages the DB Optimizer Code Quality Check functionality. See Understanding Code Quality
Checks for more information on the eight quick fixes. A transformation case, in turn, has its own set of SQL
Optimizer hint cases. For information on query rewrites, see DB2, Oracle, SQL Server, Sybase Query
Rewrites. For information on other transformations, see Examples of transformations and SQL query
rewrites.

« SQL Query Rewrites may be suggested when tuning. For example, a recommended rewrite for EXISTS may
be IN. For information on query rewrites, see DB2, Oracle, SQL Server, Sybase Query Rewrites.
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Hint-based cases and the transformation-based cases are a special case of the statement records added to the
Overview tab as you add candidates to a tuning job. With the exception of the Text, Source, and Index Analysis
fields, cases are identical to the standard statement record. Similarly, execution, statistics collection, and other
options available for basic statement records are available for individual cases.

Once cases have been generated, if you have the required permissions on the specified data source, you can apply
the changes suggested by hint and transformation based cases in the Overview table.

DB2, Oracle, SQL Server, and Sybase query rewrites

The following query rewrites or transformations may be recommended during tuning. The examples below are for
Oracle data sources. The implementations for DB2, SQL Server, and Sybase data sources are slightly different.
These rewrites are available on all four platforms except for those noted for ORACLE and DB2 only.

Before

select * from t1 where EXISTS
(select null from t2 where t2.key=t1.key);

select * from t1 where NOT EXISTS
(select null from t2 where t2.key=t1.key);

select * from t1 where tl.key IN
(select t2.key from t2);

select * from t1 where t1.key NOT IN
(select t2.key from t2 where t2.key is not null);

select * from t1 where NOT EXISTS
(select null from t2 where t2.key = t1.key);

select * from t1 where t1.key
NOTIN
(select t2.key from t2 where t2.key is not null);

select column BETWEEN XAND Y

select column NOT BETWEEN XAND Y

select (column<=XAND column >=Y)

select (column <X AND column >Y)

After

select * from t1 where tl.key IN
(select t2.key from t2);

select * from t1 where t1.key NOT IN
(select t2.key from t2 where t2.key is not null);

select * from t1 where EXISTS
(select null from t2 where t2.key = t1.key);

select * from t1 where NOT EXISTS
(select null from t2 where t2.key = t1.key);

select t1.” from t1, t2 where tl.key = t2.key(+) and t2.key
is null

select t1.” from t1, t2 where tl.key = t2.key(+) and t2.key
is null;

select (column <= X AND column >=Y)

select (column <X AND column >Y)

select column BETWEEN XAND Y

select column NOT BETWEEN XAND Y
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Before

select t1.* from t1, t2 where t1.key = t2.key and
t2.col=10;

For DB2 and Oracle only

select t2.* from t1, t2 where t1.key = t2.key and
tl.colis null

IDERA DB Optimizer 18.1.x

After

select t1.* from t1,

(select * from t2 where t2.col = 10) inline_alias where
tl.key=inline_alias.key;

select * from t2 where t2.key IN

(select t1.key from t1 where tl.colis null)
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Using the Analysis tab

The Analysis tab provides detailed information about statements and cases selected from the Overview tab, after
atuning job has been executed. It also shows filter ratio, and table and join sizes.

The Analysis tab contains information about the statement or case, its full SQL code, a diagram of the SQL
statement, and Index Analysis.
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Additionally, for the Oracle and SQL Server platforms there are Table Statistics, Column Statistics and Histograms,
and Outlines/Plan Guides tabs. For more information, see Using platform-specific features.

Statement analysis is performed when you click Perform detail analysis on the Overview tab and then click Run
Job or when you click the Analysis tab. In order to view and analyze statement statistics, select the tab (Index
Analysis, Table Statistics, Column Statistics and Histograms, or Outline) and the statements whose statistics you
want to analyze.

Next to the Select statement of interest list at the top, you choose to see an analysis of the >ROOT statement, or
you can click the list and see an analysis of any one of the generated cases produced by running the tuning job from
the Overview tab.

For more information, see Visual SQL tuning.
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Implementing index analysis recommendations

Once you have added tuning candidates to a tuning job, DB Optimizer can analyze the effectiveness of the indexes
in the database and recommend the creation of new indexes where the new indexes can increase performance.

In the Collect and create indexes table, any indexes DB Optimizer recommends you create are marked in orange.
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To accept the suggestion and have tuning automatically generate an index

1. For any recommended index, click the checkbox to the left of the index.
Optionally, modify the Index type by clicking in the Index Type column and then selecting a type from the
list.

2. Click the Create Indexes button.
The Index Analysis dialog appears.

To view the index SQL in an editor for later implementation, click the statement and then click Open in a SQL editor.

To run the index SQL and create the index on the selected database, click Execute.
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Visual SQL tuning

() Visual SQL Tuning is not available in DB Optimizer Developer.

DB Optimizer can now parse an SQL query and analyze the indexes and constraints on the tables in the query and
display the query in graphical format on The Visual SQL Tuning (VST) diagram, which can be displayed in either
Summary Mode or Detail Mode. This helps developers, designers and DBAs see flaws in the schema design such as
Cartesians joins, implied Cartesians joins and many-to-many relationships. The VST diagram also helps the user to
more quickly understand the components of an SQL query, thus accelerating trouble- shooting and analysis.

This section is comprised of the following topics:

+ Changing diagram detail display
+ Interpreting the VST diagram graphics
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Changing diagram detail display
This section is composed of the following topics:

» Choosing the tuning statement and generated case to analyze
+ Viewing the VST diagram legend

«+ Viewing table counts and ratios

+ Viewing the Explain Plan

+ Viewing the VST diagram in Summary mode

+ Viewing the VST diagram in Detail mode

« Changing detail level for a specific table

+ Viewing all table fields

» Viewing diagram object SQL

« Expanding views in the VST diagram

+ Viewing the Oracle explain plan overlay

+ Expanding subqueries and nested subqueries

Choosing the tuning statement and generated case to analyze

If, from the Overview tab, you have run the tuning job using more than one tuning statement, from the Analysis tab,
you can choose to see the SQL analysis of any one of the tuning statements.

1. Onthe Analysis tab, click the Select statement of interest list and choose the tuning statement you want to
see analyzed here.
L7 *unittled Tuning Job [ =0
b Oracle ¢ S TORLAESCORCL

B Overview | B Analysis
El S0l Analysis Selech skabmment of inbarest: SELECT 1 % -3 ROQT - R
71 TET il [ TSELECT 2

Notice that next to the statement of interest box another list >ROOT. This shows that the statement being
analyzed is the original statement, without any of the generated cases. This is the default selection.

2. To choose the generated case to be analyzed, click the second Select statement of interest list and choose
a generated case.

% *Unittled Tuning Jcb -4 b =
» e Oracle b (5 ToRLABSCORCL
B> Overview ‘wﬂllllyu- |
B SQL Analysis Seloct statement of nterest; |SELECT 1 || -»rooT % $-8 R @
SROoT
SELICT - -[IN_T0_EKISTS] ScLRawrts

cz.customer
ce.izer;
ez, lascn

R SUBQUERY (1) %
{ - INDEX

-F

- INDEX_COMEIHE

e, - AL ROWS

charge, A ., L-MIOEX FF5 *

After you make your selections, a new analysis is performed taking into consideration the statement and
case you chose. A new diagram is displayed and the Index Analysis, Table Statistics, Column Statistics And
Histograms, and Outlines are recalculated and updated.

Viewing the VST diagram legend

Click the Diagram Legend toggle [ E ] to view the legend and then click it again to hide it. All the icons used in the
VST diagram are identified and in the Diagram Legend.
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Diagram Legend e
Table
A Miew
g Materialized View
s Sub-query
[ETEl  Common Table Expression
£2  Column
Index
B Primary Key
s Unique Key
[ Fikered object
Z+—== Many to Many (M:N)
—== Parent ko Child {1:M)
nique {1:1)
4o CUTER 101N
4= EXISTS | IM v

Viewing table counts and ratios
To view or hide table counts, two table join sizes and filtered result set ratios, click the Ratios and Counts icon [1’3 1.

o ' 0l @

1 L]

sall SUBQUERY (1) [ 3 renTALITEM (RI) |
'-# & o=
I
1591 10000
Efii .-'+ / o
| [0 MOVIERENTAL (MR) | & NOT IN (2)
S0

B
| (3] CusTOMER (CS)
1005

Green numbers at top left of table represent the total number of rows in that table. In the above the MOVIERENTAL
(MR) table has 5000 rows.

Blue percentage at the bottom right of the table represent the percentage of rows in that table that meet the
selection criteria. In the above example, 100 percent of the rows in the RENTALITEM (RI) table have met the
selection criteria.

The numbers on the table joins indicate the total number of rows that meet the selection criteria for both tables.

You can also view the SQL Query that created a relationship by hovering over the relationship. If the tool tip content
is larger than the size of the tool tip rectangle, you can hover the mouse on top of the tooltip for a second, and then
it will turn into a dialog you can re-size, scroll in, and select text from to copy into the Clipboard.
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1 10000
5000 REMTALITEM (RI)
7 MOVIERENTAL | |—E] /T 00
f591 10 Cardinality: Master-Detail
\R\ / Joined Row Count: 10000
C000 o
MOVIERENTAL (M e ations:
r.RENTALID = mr.RENTALID
Columns:
3000 MOVIERENTAL RENTALID
. ] RENTALTTEM.RENTALID

I_m CUSTOMER (C5: SQL Count Statement:

100) SEECT COUNT (%)
FROM
MOVIES.MOVIERENTAL MR,
MOVIES.RENTALITEM RI
WHERE ri.RENTALID = mr.,RENTALID

Viewing the Explain Plan

() TheExplain Planis available only for the Oracle 10g and later platforms.
Hover the mouse over the VST diagram to see the Explain Plan icon [ and then click it to view the Explain Plan
Overlay. Click the Explain Plan icon again to hide the overlay.

The additional nodes shown in the Explain Plan overlay provide details on the flow of the query plan, with
operations (such as nested loops, sorts, and joins) showing connecting tables and other operations.

P

[ {3 moviecopy (mO)|

Hover the mouse over the objects or relationships in the overlay to view additional details.
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Viewing the VST diagram in Summary mode

By default the diagram displays Summary mode, showing only table names and joins, as seen in the following
illustration

HLE|q
|_|3] RENTALITEM (RI) |
*

| [T MOVIERENTAL (MR) | saL MOT IN (2)
‘F—_
[F CUSTOMER (c5}| i SUBQUERY (1)

Viewing the VST diagram in D